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What’s new in MxMC 2.7.0?

What’s new in MxMC 2.7.0?

Camera Management in the Components view

Working with the Histogram Bar is much easier now. The histogram is connected to MxMCs event database

which results in a much faster performance.

See Components Settings, p. 267 and Camera Settings, p. 267.

Smart Data Search improvements

The Smart Data Search now has new improvements:

® |mproved Error handling

B Filter events by time periods within a time interval

See Smart Data Sources and Searching in the Smart Data Search View, p. 167.

IPv6 Support

MxMC now supports the IPv6 standard:
See Camera Settings, p. 267, Camera App Licensing, p. 319 and Softbuttons Settings, p. 288.

P7 Apps can be added as Smart Data Sources

P7 camera Apps can now easily be added as Smart Data Sources.

See Camera Settings, p. 267.
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Support

Support

If you need technical support, please contact your MOBOTIX dealer. If your dealer cannot help you, he will

contact the support channel to get an answer for you as quickly as possible.

If you have internet access, you can open the MOBOTIX help desk to find additional information and software

updates. Please visit:

www.mobotix.com > Support > Help Desk
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https://www.mobotix.com/support/help-desk

Basics/Introduction

This chapter provides an overview of the features in MxMC and provides guidance on using
the online help. You will also find explanations of the program structure and operating

concept of MxMC.

MxManagementCenter Function Overview

MxManagementCenter is a video management software for setting up and using a complete
video surveillance system that offers a variety of features for different tasks and user

groups:
Area Features

Camera Man- Unlimited number of cameras, definition of hierarchical camera groups,

agement different system environments (e.g., with different network addresses)
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Live Video Sur-

veillance

Alarm Pro-

cessing

Research, Ana-
lysis and
Recording
Playback

Smart Data
System, p.
167

Data Export

Door Station
Functions

Security Func-

tions

Special Pro-
gram Func-

tions

Program Oper-

ation

Display of individual cameras and freely definable grid views (with up to

80 cameras simultaneously), user-defined graphics and info views, auto-
matic camera switching (camera sequencer and group sequencer), multi-
monitor support (humber of available display devices can be further exten-
ded with MxThinClient devices), manual recording of live images (live
recorder)

Visual and audible alerting to new events, alarm filtering (specific alarms
for specific types of alarms), background monitoring of cameras

Search and playback for individual cameras in the Playback view, time-syn-
chronized search for several cameras simultaneously (grid playback), spe-
cial search view with the latest alarm images of selected cameras,

research and playback of data directly using the camera or via direct con-
nection to the file server, fast display of the latest alarm images during live
display (instant playback), subsequent distortion correction of hemi-
spheric camera images, special search functions (subsequent video

motion detection, histogram, Smart Data System)

Use the Smart Data Search View to search all recorded events and related

images.

Export of single or multiple time ranges in the recording at the same time,
export of the data by the camera or via direct connection to the file server,
export of individual image areas (subsequent PTZ), export at variable

frame rates, resolution with and without audio

Bell signaling and live two-way communication, open doors and switch

lights, play back mailbox messages

Definition of users and user rights, supervisor function (dual control), sys-

tem security check, health check

Softbuttons for executing special functions, action logs, remote control

Fast switching between different views with different functions, fast dis-
play of cameras via drag & drop, touchscreen operation supported, vari-
ous program behavior settings

8/ 346



Basics/Introduction
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Camera Feature Overview

MxMC allows MOBOTIX MOVE cameras and third-party cameras providing an ONVIF-S/G-compatible interface

to be integrated and operated. However, the full range of MxMC features is not available for all camera types.

The following table briefly lists the functions that be used with the different camera types.

Function

Camera Configuration
Alarm Processing
Recording Access
Recording Playback

Export

Smart Data Search

Special Search Functions
(post-VM, histogram,
Smart Data)

Check System Security

PTZ

Subsequent Equalization of

Hemispherical Images
Live Recorder

Camera Groups

Door Station Functions and

Switching Functions
MxThinClient Devices

Snapshots

MOBOTIX
Camera

yes
yes

unlimited
unlimited

unlimited

yes

yes

yes

Camera
PTZ

yes

yes
unlimited

yes

yes

yes

MOBOTIX MOVE Camera

no
no

only via MOBOTIX NAS
only forward playback

only as MJPEG and H.264 (H.264
with corresponding license)

no

no

no

mechanical PTZ

no

no
group functions

no

no

no

ONVIF-S/G Camera

no
no

only via MOBOTIX NAS
only forward playback

only as MJPEG and H.264 (H.264
with corresponding license)

no

no

no

mechanical PTZ

no

no
group functions

no

no

no

Working With The Live View

The Live view allows you to control the live images of individual cameras. This also includes switching various

functions, e.g. opening doors or switching lights.
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Showing Cameras
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Fig. 1: Showing cameras
To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera

from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed
camera is marked with a yellow bar in the Device bar as well as in the Camera bar.
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Customizing Image Settings
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Fig. 2: Customizing image settings

Use the Brightness@ and Contrast‘ controls to adjust the image display of the displayed camera to the
current environment.

Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

NOTE! Adjusting the image settings does not have any effect on the camera settings. These will not be
changed
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Performing PTZ Actions
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Fig. 3: Performing PTZ actions

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or
panned with the mouse button pressed down. PTZ controls are only available on the MxMC main screen or
on the secondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image

area around (PTZ). To facilitate quick loading of these image sections, several image positions are already
pre-configured for loading using the slider 0

The program also shows the @ slider on Dual cameras. Use this slider to show the live images of either the

right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can configure different display modes (slider @).

Zooming and Moving Image Sections

You can zoom using the slider 0 or the mouse wheel. Zooming with the slider takes place only on the com-
puter. This means that only the image section of the current live image is modified.

To see other image sections, you can move the live image using the mouse.

If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the

PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera

does not record the full image). To use this feature, click on the slider 0 and keep it pressed until it starts

12/ 346



Basics/Introduction

MxManagementCenter Function Overview

flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and keep

it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections

Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are

predefined in the camera.

" Preview (), detail €3, overview () and point of interest )
" Top @), bottom @), left @, right @)
The camera will then move to the selected position. Note that the PTZ actions are executed on the camera

and also influence the recordings (only if the camera does not record the full image). Move the @ slider to

the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as
needed. Keep the slider on this position until it flashes once. The new image section has been stored.

Choosing a Sensor

If you want to show the live images of only the right or the left image sensor, you can move the @ slider to

the right to O (left sensor) or further to the right to O (right sensor).

Correcting The Distortion Of Hemispherical Images

When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036,
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In
order to get naturally-looking images, the camera will automatically correct the distortion in these modes.
This distortion correction can be refined even further when using the panorama correction. The selection of a
display mode is always done locally and thus does not influence the camera settings. However, the selection
is also applied to the other program views. When selecting a display mode in the live view for a specific cam-
era, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in the
live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Smart Data

Search View are also shown in the selected display mode.

Selecting The Distortion Correction Mode

= @ Full image: Shows the entire (distorted) full image.

" @ Normal: Shows a distortion-corrected image and allows executing PTZ actions.
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u @ Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to
the right border. The aspect ratio (width to height) is 8:3.

" @ Surround: This option shows four image sections (one for each cardinal direction: N, E,; S, W) in
one joint view. Note that you can use PTZ actions to modify all four views independently from one

another.

" @ Double panorama: This mode shows a panorama view for the North half of the image and a
second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3.
This mode makes sense for a hemispheric camera that is mounted to the ceiling. It can be sub-
sequently customized to use local PTZ.

" @ Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider @ to the right until you reach the desired position. This slider position will
be stored automatically until you change it again.
Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction

allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do so,
move the @ slider to the right to and use the mouse to correct the image. To store the corrected setting,
click on the slider and hold it until the slider icon briefly appears in the center of the image.

Status Display

The Status bar displays different states by means of icons. The status displays always refer to the displayed
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed

again or is still open.
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Fig. 4: Status display

Icons in the Status Display

Door Status Dis- m door is closed.

piay door is open.

E.-‘ door is locked.
. door lock switch is locked, but the door is open!

Light Status Dis- light is off.

play icon is lit: Lights are on, needs to be switched off manually.
Microphone Status microphone is switched off, no announcement possible.
Display microphone is on, announcements are possible.

microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station.

Switching additional devices via Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.
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Fig. 5: Switching additional devices via Softbuttons

To execute a Softbutton, click on to open the Softbutton menu, then click a Softbutton accordingly.
To edit Softbuttons see Softbuttons Settings.

Manually recording live images

In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you
observe a suspicious situation that should be recorded. While you keep track of the situation in the live
image, the images are recorded and saved as a MXG file.

Users with administrator rights can specify where the clips are saved and how long the recordings can be in
the Program Settings (Mac: MxManagementCenter > Preferences > Live Recorder menu, Windows: File >
Settings > Live Recorder menu).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature
Overview.

Audio can only be recorded with the Live Recorder under these conditions:

B Audio transmission must be activated on the camera side.

® In the Live View of MxManagementCenter, the audio connection must be activated by clicking on .
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Fig. 6: Manually recording live images
Starting And Stopping Recordings

To start recording, click on Live Recorder E Recording will stop automatically after the recording time set
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop
the recording from within this message or extend the set period of time. To stop recording before the time

expires, click on E again.

NOTE! If you change the view, the recording is automatically stopped. However, a camera change within
the Live view does not stop the recording.

Play Clip
The live image data is stored in a MXG file at the location specified in Program Settings during recording. The
clip file is automatically imported into the current project when the recording stops and the Device bar shows

it alongside the @ icon in the Clips section. You can click on the clip name to playback the MXG clip file via

the Device bar.

Working With the Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups

according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera,

allowing you to quickly check the situation.

Temporarily showing the live image of a camera

To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addition,
the live image of another camera group can also be displayed in the Graphic view. Drag & drop the desired
camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group

To keep track of all live images in the current group, you can activate the camera sequencer or the group
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after

another in a small window. You can move this window to any location and enlarge it or make it smaller.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note

that the camera sequencer can also switch cameras automatically.

Instructions:

1. Click on the camera sequencer icon to activate the automatic switching.

2. Right-click on to change the following settings:

® Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

B Autostart: Once you switch to the Grid view, the sequencer starts automatically.

B Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate
the situation. To start again, click on .

B Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer

over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be
shown sequentially in the grids focus window for a defined time. You can automate this camera group change

with the group sequencer.
Instructions:

1. Click on the group sequencer icon to activate the group sequencer.

2. To change the sequencer settings right-click on :
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B Duration: set the duration to show each group. You can set a value between 1 sec and 60. The “Com-
bined Sequencer” activates the group sequencer together with the camera sequencer (“Autostart” on
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic
have been cycled before switching to the next group. When the “Combined Sequencer” is active then
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group
sequencer.

B Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions

At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or
open several doors.

In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that
is, they need to be connected to door openers/light contacts and have to be configured properly.

r. 0@ MxManagementCenter

Grafik - Parkplatz

grup
Alle Kameras

¥ [ Treppenhaus

§## Erdgeschoss

» i 1.0G

Fig. 7: Switching group functions
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Smart Data System

With the MOBOTIX Smart Data System, transactions in MxMC can be linked to the video recordings made at
the time of the transactions. Use the Smart Data Search to search all recorded events and related images. You
can filter the results by all kinds of events. You can reduce the results to the events you have marked as
"important". The search results are displayed as list and/or as preview images including camera name, time
stamp and type of event trigger. You can play back the recording to an event directly from the event image.
From the Smart Data Search View you can easily access the Playback View or the Export View (see Searching
in the Smart Data Search View, p. 167).

NOTE! In order to use the MOBOTIX Smart Data System for third party systems - e.g. cash point systems,
you must purchase a Smart Data License. No license is required for P7 loT App data. The MOBOTIX loT App
Interface is integrated into MxMC by default.

NOTE! The Smart Data Search View is not available for MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-

era Feature Overview, p. 9.

Exporting Recordings

Using the Playback view, you can export recorded video data from one camera, while the Grid Playback
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export.

You can save individual images with the Snapshot function.

Saving Snapshot Images

Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid

view and Grid Playback for all displayed cameras.
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Fig. 8: Saving Snapshot Images

To do so, click on the Snapshot button in the Command bar. By default, images are saved in the image
folder of the user account. The destination path and the image settings for saved images can be selected via
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images

(Windows) menu item.

Exporting Camera Recordings

The Playback view allows setting a time range for a recording (event recording or continuous recording) in

order to select it for exporting.

Open the Playback view.
Drag the desired camera from the Camera bar or the Device bar.
Find the start of the relevant recording.

H

Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

1. Mark the start of the clip by clicking on the gray flag on the left
2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip
by clicking on the gray flag on the right. Both flags are now green.

3. Click on Export and select the export profile.
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4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:

First, make sure that no export area has yet been set using the "export flag." If an export area has already
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

1. Click on Export . Then click on the desired export profile @ . The dialog box used for defining the

export range appears.
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2. Specify the export range @ .
3. Click on OK and then on Save.

NOTE! If you select the Automatically Import After Export checkbox in the Export dialog, the exported
clip will be automatically added to the Camera bar and in the Device bar to the Clips & Recordings sec-

tion.

Exporting Camera Group Recordings

The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to

select it for exporting from multiple cameras.

1. Open the Grid Playback.

2. Drag & drop the desired camera group from the Group bar or the Device bar.

3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is
extended to the other cameras in the group, and the recordings with the closest relevance to those in the
focus window recording will be displayed in the tiles.

4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

1. Mark the start of the clip by clicking on the gray flag on the left
2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip
by clicking on the gray flag on the right. Both flags are now green.
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3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To

do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the

desired cameras by clicking on the corresponding circles @ .

4. Then click on Export and select the export profile @ . The Export dialog box appears.
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Fig. 9: Select export range using visual markers

5. Select a target folder and enter a file name.

Manually capture export range:

||||||||||||||||||||||||||||||||||

26.02.15 08:26:53

Make sure that no export area has yet been set using the "export flag." If an export area has already been set,

you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

1. Before you define the export range, you can limit the selection if you do not want to export all of the

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the
top left corner. Select the desired cameras by clicking on the corresponding circles @ .

2. Click on Export and select the export profile @ . The dialog box used for defining the export range

appears.
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Fig. 10: Manually capture export range

3. Specify the export range ® .
4. Click on OK and then on Save.

NOTE! If you activate the Automatically Import After Export option, the exported clips are automatically
added to the Group bar.

Exporting Recordings From The Export Bar

The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback and in the Smart Data

Search View. After an export, the clips are not deleted automatically. It is deleted when the program is closed.

Adding Clips for Exporting in the Playback View

1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.

2. Find the recording you are interested in.
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Fig. 11: Adding Clips for Exporting in the Playback View

3.

Mark the start of the time range by clicking on the gray flag on the left [*. Play the recording until you

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the

gray flag on the right . Both flags are now green © .

You can set the end marker first (gray flag on the right), then play the recording from the beginning so
you can set the start marker (gray flag on the left) at the desired point.

Click on the image of the recording and maintain the position until you see a scaled-down image of the
recording @ .

Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback

The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

1.
2.

Drag the desired camera to the focus window in the grid and find the relevant recording.

Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you
have reached the end of the clip you want to export. Mark the end of the time range by clicking on the

gray flag on the right ™. Both flags are now green.
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3. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar
will open automatically, allowing you to save the image there.

4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to
show the same time. Drag the camera with the next recording in the sequence of events into the focus
window. Mark the start and the end of the clip as described above, then drag the recording into the
Export bar.

5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-
ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection
box for that camera.

4. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar
will open automatically, allowing you to save the image there. The selected clips will be copied to the
Export bar.

5. Repeat these steps until you have added all time ranges you want to export.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.
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NOTE! If the following image is shown in the player view, there is no video data saved for the selected
export period.

Fig. 12: No video data available for export

Editing Clips

If you have added a recording to the Export bar for which you previously used distortion correction or zoom
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three
icons appear:

MxManagementCenter

Playback - mx10-12-225

+

WK AOD> D @Rp & 140214 100553 &)
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- 0: Clip is exported with zoom.
Click on 0 to export the clip without zoom. The icon is disabled.

- @: By default, the clips are exported with audio (provided that audio had been recorded).
To export without audio, click on @ The icon is disabled.

- : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.
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Exporting Clips

Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AV,
MP4 or MKYV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.

Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import
After Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after

exporting.
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Operate Door Stations

Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-

tion-specific functions are provided in addition to the program functions for cameras.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that

provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see:

B Camera Feature Overview, p. 9.
® Door Station Settings, p. 209

Bell Signaling

If someone rings the doorbell, it can be indicated in different places of the application.
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Where?

Alarm bar
and Alarm

Info bar

Explanation

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar @ is located at the bottom of the MxManagementCenter and
the Alarm Info bar @ below the camera image of the corresponding door camera.
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Where? Explanation

Doorbell When the bell is rung, a ringing notification is displayed, no matter which view you are in. The

notification prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification E was not deactivated in the header.

[ ] [ ] MxManagementCenter

i O —— L O T O O L L LT T e e

.....................................................................................................................................

NOTE!
The notification can be temporarily disabled by an administrator by clicking on Notification

@ in the application header.
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Where? Explanation

Counteron  The counter next to the bell icon in the Live view is increased by one.
the bell icon

[ ] [ ] MxManagementCenter

Live - Foyer

O O E—— O T T L L LR N ey
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Setting Bell Signaling

Go to Door Station Settings, p. 209 to find out which signaling options can be combined and where they can
be configured.

Open Door and Switch Lights

If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To

do this, use the and keys in the Live view Command bar and in the Command bar of the Grid view
focus box.

Checking System Security

After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p.
291 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status
based on common best practices. If test criteria are not met, possible measures to protect the cameras are
provided.

NOTE!

The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see
Camera Feature Overview, p. 9.

33/346



Basics/Introduction

MxManagementCenter Function Overview

Verifying Settings for System Security

1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the
Wizards & Extras view.
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2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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3. Click Secure System. The following criteria are checked:
B Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is
easy for cyber attackers to guess the standard "meinsm" password.

® Enabled Public Access: If Public Access is enabled, a number of different camera functions can be
used without a password.

B Activated HTTP web server: It is possible for data, including user data such as passwords and images,
to be transmitted via the network without encryption when HTTP is used.

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in
which cameras were not checked due to a connection error, for example.

Status Explanation
® Notsecured  There was at least one criterion that was listed as not secure.

7 Softwaretoo  Please check the camera software and update it, if necessary.
old

© Connection Check your network connection to the camera and perform the security check again.
error

@ Not supported The camera (s) cannot be analyzed or secured using the wizard.

@ Secured Camera is secure; no further action is necessary.
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Secure System

4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed
together with whichever of the three criteria that were fulfilled as well as the measures that need to be

taken to properly secure the cameras:

Criterion

Password

SSL encryp-
tion

Public
Access

Explanation

Changes the password of all user accounts on the cameras that use the standard “meinsm”
password. It also include ONVIF users whose passwords have never been changed.

Enter a new password and confirm it. A suitable password has at least eight characters. It can
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a
password that does not meet these criteria, a red frame appears around the text field. The
frame turns green once you have entered a valid password.

The new password is automatically entered in the MxMC project data.

Disables camera connections via unencrypted HTTP and configures the cameras to accept

HTTPs connections only.
The TCP port and the SSL setting will be automatically updated in the MxMC project data, if

necessary.
The TCP port will not be updated for cameras that are connected via a remote URL. For

remote URL connections, you may need to change port forwarding in the router to the appro-

priate setting.
Please note that different services, such as network messaging etc., will no longer work when

you disable HTTP.

Disables access that does not require password entry to the web interface and the APIs of the

cameras.

5. Click on OK in the dialog box. The selected security measures will be performed. The security status for
the selected camera or camera group will be analyzed once again and the result for each camera is dis-

played.

Working With The Grid View

The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-

ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to

you onto the focus window. Use the controls at the bottom to operate the camera.
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Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the
desired group from the Device bar into the display area or click on the desired group in the Group bar. The

displayed group is indicated by a yellow bar in the Device bar as well as in the Group bar.
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Fig. 13: Showing a group

Working With The Focus Window

At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in

the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.
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Fig. 14: Camera in a focus window
Zooming And Moving Image Sections

Use the slider 9 to zoom. The zoomed image sections can then be moved with the mouse. These actions
take place in the application. This means that only the image section of the current live image is modified.
The camera will not move and therefore zooming will not affect the possible recording of the generated cam-

era image.

1. Drag the slider 0 to zoom in on or out of the live image.
2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are
predefined in the camera.

" overview ), point of interest ), preview () and detail view €}

" Top @, bottom @, left &), right @

Move the slider Standardo to the next position or until you have found a suitable position.
Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on =
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Opening Doors And Switching Lights

If a camera is connected to a door station and has been configured accordingly, you can open the door by
clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be
turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If an

ExtlO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient temperature
of the module or the box and view it by clicking on E

Executing Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.

To execute a Softbutton, click on to open the Softbutton menu, then click a Softbutton accordingly.

To edit Softbuttons see Softbuttons Settings.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note

that the camera sequencer can also switch cameras automatically.
Instructions:

1. Click on the camera sequencer icon to activate the automatic switching.

2. Right-click on to change the following settings:

® Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

B Autostart: Once you switch to the Grid view, the sequencer starts automatically.

B Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate
the situation. To start again, click on .

B Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be
shown sequentially in the grids focus window for a defined time. You can automate this camera group change
with the group sequencer.

Instructions:

1. Click on the group sequencer icon to activate the group sequencer.

2. To change the sequencer settings right-click on :

39 /346



Basics/Introduction

MxManagementCenter Function Overview

® Duration: set the duration to show each group. You can set a value between 1 sec and 60. The “Com-
bined Sequencer” activates the group sequencer together with the camera sequencer (“Autostart” on
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic
have been cycled before switching to the next group. When the “Combined Sequencer” is active then
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group
sequencer.

B Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions

At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or
open several doors.

In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that

is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 15: Switching group functions
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Manually recording live images

In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you
observe a suspicious situation that should be recorded. While you keep track of the situation in the live
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus window
is always recorded. For this reason, live recording can also only be used in the Grid view when there is a focus
window.

Users with administrator rights can specify where the clips are saved and how long the recordings can be in
the Preferences, p. 250 (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu:

File > Settings > Live Recorder).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview, p. 9.

‘a0 @ MxManagementCenter
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—

Fig. 16: Manually recording live images
Starting And Stopping Recordings

To start recording, click on Live Recorder E Recording will stop automatically after the recording time set
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop

the recording from within this message or extend the set period of time. To stop recording before the time

expires, click on E again.
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NOTE! The recording ends automatically when switching to another view. However, changing the group
within the Grid view will not result in an early termination of the recording, unless that group has no focus
window. In the latter case, the recording will end.

Play Clip
The live image data is stored in an MXG file at the location specified in Program Settings during recording.
The clip file is automatically imported into the current project when the recording stops and the Device bar

shows it alongside the@ icon in the Clips section. You can click on the clip name to playback the *MXG clip

file via the Device bar.

Program Structure and Operating Concept

Program Structure

MxManagementCenter provides functions for different user groups:

B System administrators (installers):
This user group uses MxMC to build and configure a monitoring system that consists of the application
itself, cameras, recorders and other components.

® End users:
These use the application for their monitoring tasks, such as live video surveillance, searches in and

playback of recordings, video exports etc.

Despite these different tasks performed by the two user groups, the program structure and operating concept
are largely the same.

Operating Concept

Program window

There are multiple views that allow the user groups to complete their tasks. These consist of a Menu bar, a
main area in which most of the task is executed, four bars that can be opened and closed, a Header bar at

the top and a Command bar at the bottom of the program window.

The following functional bars are available:

® The Device Bar, p. 45

B Camera Bar and Camera Group Bar, p. 49

® The Alarm Bar, p. 51 (contains Searching in the Smart Data Search View, p. 167)
® The Export Bar, p. 54 (contains The Histogram Bar, p. 172)
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The Configuring Basic Camera Settings, p. 92 provides functions for changing the settings of multiple cameras
in a group without having to change the camera or camera group.
The Command bar at the bottom contains the icons and buttons relevant to the current view. The contents of

the Header bar as well as the Menu bar are the same for all views.

NOTE! If the Menu bar is not visible under Windows, it can be displayed by pressing the Alt key.

Camera Bar/Camera Group Bar
Targeled selection of all comeras or comera

groups with sorfing funclion, switching oadar Bay
between comeras and groups

Menu Bar
with functional elements

Histogram and
Retail System
Graphicol analysis of

Daevice Bar

Hinzufigen und
Verwalten von Kameras,
Kameragruppen und Clips

event distribution and/
or connection of cash
register systems

i Alarm Bar
Control Bar Chronological lst of ll event
with butions and symbols records

Fig. 17: Program window

MxMC can be operated on Working With Multiple Monitors, p. 143. Double-click on a live image, for instance,
to display it on a second monitor. If several monitors are connected, they are recognized and can be selected

as required.

Controls and Buttons

Icons, sliders and buttons are available for working with the views.
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Elements Examples

Icons
‘A
Buttons
Slider
)

Explanation

Icons are mainly used in the Graphic view. They are either assigned predefined func-
tions or can be freely defined (hyperlinks). Icons can be freely placed in the Graphic
view. Clicking on these buttons directly performs a function, for example, open a
door. Icons used to control camera functions indicate their status, if available,

such as "Door is locked" at the door icon of a Door Station.

Buttons appear in many places in the application, including the Command bar or
Header bar. Similar to the icons, clicking on the button performs a function directly.
Buttons with a small white triangle at the bottom of the button indicate shortcut
menus that provide additional options. The shortcut menus can be opened by right-
clicking, long-clicking or clicking on the triangle.

Sliders are also used in many places for operation. Clicking & dragging a slider per-
forms actions, such as scrolling through the last records. Available setting options
can be listed and selected by clicking on the slider.

The name of the controls and buttons is displayed by moving the mouse pointer over it. Explanations with

links to quick help are displayed when clicking the question mark icon in the Header bar.

NOTE! In some places in MxMC, multiple cameras can be selected at once. Do so by using CMD + click
(Mac) or CTRL + click (Windows).
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The Device Bar
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Fig. 18: Device Bar

The Device Bar at the left margin of the MxManagementCenter is the central place for creating camera
groups and for adding and grouping cameras and clips. Its tree structure design provides a quick overview of
the contents and the composition of the individual projects by allowing you to open and close the individual

branches and view the hierarchical structure.

Adding Cameras, Creating Groups and Importing Clips
1. Open the edit mode at the bottom of the Device bar by clicking on

2. Next, clickon . The Adding devices and sources, p. 84 dialog opens.
Adding Cameras to a Camera Group

1. Open the edit mode at the bottom of the Device bar by clicking on

2. Drag & drop the desired camera from the Cameras section to the appropriate group in the Camera

Group section.

NOTE! If you have assigned a camera to one group, you can copy this assignment to other groups by

dragging the assignment from the first group to other groups.
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3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking

on

Setting Group Functions

Open the edit mode at the bottom of the Device bar by clicking on

To do so, move the mouse pointer over the group name. Three icons appear. Click on .

The Group Functions dialog opens.
Assign the desired functions to the cameras by activating the respective checkboxes.

o M o

Once you have defined all group functions, you can deactivate the edit mode by clicking on

Deleting Cameras, Removing Cameras from Groups, Deleting Groups

Deleting Cameras

1. Open the edit mode at the bottom of the Device bar by clicking on
2. Drag the camera from the Cameras section to

3. Once you have deleted the cameras, you can deactivate the edit mode by clicking on

NOTE! Deleting a camera from the Cameras section will also delete the group assignments of that camera.

Removing Cameras from Groups

1. Open the edit mode at the bottom of the Device bar by clicking on

2. Drag the camera from the Camera Groups section to

3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on

Deleting Groups

1. Open the edit mode at the bottom of the Device bar by clicking on
2. Drag the camera group from the Camera Groups section to

3. Next, activate the edit mode by clicking on

Working With the Device Bar

Configure Screen

Various features support the customization of the Device bar or the arrangement of items in the Device bar.
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Feature

Explanation

Opening/Closing Click on to close a section, click on to open it again.

Sections

Moving Sections  If you move the mouse over the upper part of the section, the g icon appears and the

.I,

Setting Display
Options

mouse pointer changes to the Move cursor. You can now click and drag the section up or
down.

You can select how the cameras are listed, i.e., by camera name, IP address, factory IP
address or reference image. Note that you can set different display options for the Cam-
eras and Camera Groups sections. For clips, you can choose to list the clips by name or
by path.

Click on and select the desired display option.

Sorting The Cam- The Cameras section allows sorting the list. Click on and select the desired sorting

eras

mode.

Editing Project Data

Set favorites for display in the Camera/Group bar and change the names of cameras and groups.

Special
Feature

Selecting
Favorites

from Cameras

and Groups

Editing
Names

Explanation

You can filter the displayed cameras in the Camera Bar and Camera Group Bar, p. 49 using
different filter criteria (by favorites, for example). Before you can use favorites, however, you

need to label the desired cameras and groups in the device bar as favorites.

Activate the Edit mode by clickingon . Move the mouse pointer over the camera or
group name. Several icons are shown. Click on . Next, deactivate the edit mode by click-
ing on

Using the device bar, you can quickly modify the names of cameras and groups. Activate the
Edit mode by clicking . Click on the camera or group name you want to change - it will

turn yellow. Click again on the name and edit it as needed. Deactivate the edit mode by click-
ing on
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Navigation: Targeted Selection of Views
Special Feature Explanation

Selecting Views The Device bar allows for selecting a specific view for a group of cameras or one camera.
Move the mouse pointer over the camera or group name. Different icons will appear
depending on whether you have moved the mouse over a camera or a group name. Click

on the icon of the view you want to use.

Camera views
Live view
Playback view

Smart Data Search View

Group views
Grid view
Graphic view
Grid Playback

further views (Smart Data Search View, Info view)

Overview of the Different Camera Statuses

An icon next to the camera name or the camera IP address indicates the current status of the camera.
Icon Explanation

Camera is not active.
Camera is not reachable.
Wrong camera password.

Privacy mode is active.

FRONN WO

Limited functionality (only live image access) due to old firmware (<4.0), old camera model (M/D/V12,
M/D/Q22M) or proxy issue.

Camera password does not grant administrative access.

No license for this camera.

®
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Camera Bar and Camera Group Bar

[ BN MxManagementCenter

Live - Foyer

O oo L O

<> @ N 2 18.10.18 14:14:24

Fig. 19: The camera- and camera group bars

The Group or Camera bar at the upper margin of MxManagementCenter provides the means for quickly
selecting individual cameras/camera groups or for switching views.

In addition, icons in the camera images of the camera bar indicate the current status of the corresponding
camera:

The height of the bar and thus the size of the images can be increased to cover two lines. To do this, pull
down the lower frame border until it locks into place.

Camera Bar

The Camera bar displays the cameras with the image that was transferred from the camera when the camera
was added. The camera name that was captured when the camera was added is shown in the gray Info bar at
the bottom of the camera image.

Sorting the Cameras

By default, the cameras are displayed according to the order in which they were added to the Device bar. In

order to make it easier to locate single cameras, you can change this order and sort the cameras. Do so by

moving the slider e on the lower frame border to the desired position:

" © unchanged order
" @ alphabetical sorting
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" (@ sorted by IP address

Showing Camera States

The following camera states can be displayed in the camera image:

" @ Camera is not active

" . Camera is not reachable.
" @ Wrong camera password
" @ Privacy mode is active

= Limited functionality (only live image access) due to old firmware (<4.0), old camera model
(M/D/V12, M/D/Q22M) or proxy issue.

- @ Camera password does not grant administrator rights.

Selecting Cameras

Select the desired camera either with a single click or drag and drop the camera into the display area. The

Info bar of the selected camera turns yellow.

Switching To The Group Or Camera Bar

By clicking on the top frame border of the bar, you can switch from the Camera bar with individual cameras

to the Group bar for managing camera groups.

Group or Camera Bar

The Group bar displays the camera groups with the reference image or icon configured in the camera man-
agement section (see Setting Up Camera Groups, p. 87). The name that was entered when creating the cam-

era group is shown at the bottom of the reference image or icon.

Sorting The Camera Group Display

The camera groups are displayed according to the order in which they were added to the Device bar. You can

change this order and sort the camera groups alphabetically.

To do this, move the slider e on the lower frame border until the slider indicates alphabetical sorting: @

Select a camera group

Click on the desired camera group. The Info bar of the selected camera group turns yellow.

Switching To The Camera Bar

Click on the upper frame border of the bar to change from the Group bar with camera groups to the Camera

bar for managing individual cameras.
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The Alarm Bar

All cameras - M73 mx10-32-6-96
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The Alarm Bar @ s located at the right of MxManagementCenter. It turns red when there is an unac-
knowledged alarm event. This happens only if the Alarms option has been activated in the Camera Con-
figuration dialog box and if the event types responsible for triggering an alarm have been activated.
Clicking on the bottom frame border of the open Alarm bar will open the Export bar. Using drag & drop, the
Export bar provides a quick and easy way to collect recordings for subsequent exporting.

Recognizing and Acknowledging New Alarms

If the bar is hidden, new alerts will be indicated by a red frame border m If the bar is open, the
Info bar of the event image turns red. A ringing at the door bell will color the bar in green m

To acknowledge a new alarm, right-click on the event image and select Confirm. To acknowledge all new

alarms at once, select Confirm All.

Filtering Alarm Images

The alarm images in the Alarm bar are sorted chronologically. You can filter the event images by camera, by

group or by event type. There are two sliders for this purpose: the group/camera slider and the event type

slider ® To set the filter, move the sliders until you see the desired results:
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" Group/Camera: Group @, camera @)
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Event
Icon

@ © 06

S

OO0 06

Event Type

MxActivitySensor

Video Motion

Sensor

Behavioral Detec-

tion

Shock Detector
[llumination

Microphone

PIR Sensor

Temperature

Action Group Ter-

mination

Internal Events

MxMessageSystem

Meta events
Signal Events
Time Events
Ringing event

Mailbox Message

Door Station Events

RFID Card Rejected

Explanation

Triggered by continuous movement of people or objects in certain

image areas.

Triggered by movements in predefined motion windows.

The sensor reacts to different behavior profiles of the tracked objects in
the image. Triggered by deviations from the recorded behavioral pro-

files.

Triggered by shocks on the camera (e.g., vandalism).
Triggered by exceeding or falling below the specified illumination.

Triggered by exceeding the set volume of the sounds picked up by the

microphone.

Triggered by a Passive Infrared Sensor which registers objects with a
heat signature moving within the sensor area. Triggered by exceeding
the set threshold.

Triggered by exceeding or falling below certain temperature
thresholds.

Triggered by the completed execution of an action group.

Triggered by internal camera events

Triggered by receiving a message from the MxMessageSystem via the
MxBus or from the network.

Triggered by Meta events

Triggered by state changes of user-defined signals.
Triggers at certain points in time.

Triggered by activation of the door bell.

Triggered by leaving a voice mailbox message.
Triggered by opening the door.

Triggered by the use of an invalid RFID card.
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Event Event Type Explanation

Icon

PIN denied Triggered by entering an invalid PIN.
All Events (default) No Filter - all events are shown

Playing Back Recordings

B To play back the alarm recording directly from the Alarm Bar (instant playback) move the mouse

pointer over the alarm image and click on (3.

B To play back the alarm in the Playback View, move the mouse pointer over the alarm image and click

on to switch to the Playback View.

Deactivating Alarms

You can use the Camera Configuration dialog box or the Alarm Bar to deactivate alarms.

® Deactivating alarms for a specific camera and event type:
Right-click on the desired alarm image and select Deactivate As Alarm.
® Disable alarms for all event types of a camera:
Right-click on an alarm image and select Deactivate All Alarms of This Camera.

The Export Bar

All cameras - M73 mx10-32-8-96 ? Cl @

Do. 20.08.20 13:52:08  «}»

rzﬁ \
: - |

|

hDi. 23.02.21 13:47:45 0.20.08.20 13:52:03 &

1134725205 (] @ M73 mx10-32-6-96 Di

2302.2113:47:45 43
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The Export Bar @ is located at the bottom of the MxManagementCenter. It contains the The Histogram Bar,

p. 172 which visualizes the distribution of event frequency.

Clicking on the frame of the open Export Bar will open the Histogram Bar and vice versa. The Export Bar

provides a quick and easy way to collect recordings for subsequent exporting.

Basic functions of the Export Bar

The Export bar can be opened in all views, and clips that have already been added can be edited in the bar.
To do so, right-click on a clip. A shortcut menu with the following functions opens:

= : Manually adjusting the time range

= : Turning audio and PTZ on or off for all clips
= : Duplicating a clip

= : Deleting one or all clips

You can add the clips in the Playback view, in Grid Playback and in the Smart Data Search View (see Exporting
Recordings, p. 186).

NOTE! The Export bar will not be deleted automatically after exporting, but only when closing the applic-
ation.

MxMC Views

The basic structure of the views is always the same. Each view, however, contains additional elements cor-
responding to the respective functional area. The following views are available:

® The Grid View, p. 56

® The Graphic View, p. 56

® The Live View, p. 57

® The Playback View, p. 58

® The Grid Playback, p. 59

® The Smart Data Search View, p. 60
® The Components View, p. 61

® The Al Camera Apps View, p. 62

® The Info View, p. 63

® The Wizards & Tools view, p. 64

® Configuration: Overview, p. 332
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The Grid View

The Grid view consists of a grid of live images and a focus window. This grid display is ideal for getting a
quick overview of all cameras of a group. You can drag the camera image that is most interesting to you onto

the focus window. Use the controls at the bottom to operate the camera.

You will always notice when a camera registers an event, regardless of whether or not the camera is in the
current group. The alarm info bar at the bottom of the camera's live image signals an event within the group.
The alarm info bar at the bottom of the Grid view shows the events of all attached cameras. To investigate
the event, simply drag the live image from the Grid view, or the event image from the alarm bar, into the

focus window.

Direct Selection
Using Drag&0rop from the
group bar.

Comera-/Group Bar

Focus Window
Drag ond drop cometas
from the grid or the comera
barinto the focus window, A ol Bor
Mouse-over, displays the
last 25 olarm images (by
dragging the mouse poin-
ter long the bar)
Switching ond
Control Functions
For the camera in Histogrom and
the focus window Retail Systom
(hidden)
Device Bar
iidden)
n ¥ Live Images
of the cameras of this
group as a roster
Alarm Bar

{hidden)

Control Elements

Control Bar for editing the Grid view when
wiith contrel and fundional elements the adifing mode is open

Fig. 20: The Grid View

The Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or
green upon a bell event). Move the mouse pointer over the camera icon to show the live image of the trig-
gering camera, allowing you to quickly monitor the situation.

You can use the group buttons of the Command bar to switch on/off the lights of several cameras at once,
to open several doors or to make an announcement over several speakers for one or more cameras of the
group, regardless of the displayed camera. In addition, you can right-click on the group buttons and open the

shortcut menu to control cameras that are not part of the current group.
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To make work easier, you can drag elements from the Command bar onto the floor plan and operate them
directly in the floor plan by clicking on them.

In case you want to monitor the live images of cameras of other camera groups in the Graphic view, you can
temporarily drag these live images onto the floor plan.

Camera-/Group Bar Mulfiple Cameras
(hidden) Symbolizes several cameras in one
place, e.g., on o mast.

Layout/Floor Plan
Cameras can be anan-
ged realistically an Camera Groups
loyouts/fioor plans. Clicking on the symbaol
4 opens the comesponding
Graphic viev
Histogram and
. Retoil System
(hidden)
Device Bar
(hidden)
Displaying live image
tempararily
By mouse-over; fempo-
rary posifioning of the live
3 image on the floor plan by
Camera Symbols drag&drop,

Wit adjustable
angles of view, red or
green fum on alarm
riggering.

Switching Functions

Switch functions directly with
switching symbols, .. opan door
Displays the stalus of the same
time: Door still apen.

Alarm Bar (hdden)
Red signals: A camero hos
registered on olarm

Fig. 21: The Graphic View

The Live View

The Live view allows you to control the live images of individual cameras. This includes switching various
functions, e.g., opening doors or switching lights.

In order to better recognize objects in an image area, the live image in the Live view can be zoomed and
image areas can be moved (PTZ). To facilitate quick loading of these image sections, several image positions
are already configured for loading using the slider ¢}y in the Live view. On Dual cameras, the program also

shows the ) slider. Use this slider to show the live images of either the right, the left or both image sensors.
When showing the live images of hemispheric cameras, you can select different display modes (slider @)).

You can also make settings for the Door Station cameras in the Live view (e.g., voice mailbox announce-
ments).
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Fig. 22: The Live View

The Playback View

The Playback view provides a quick and easy way to search for recordings and play back found sequences.
There are various options available. The way that you search depends on whether you want to search the

recordings for specific events, or if you want to search for events at specific times.

When searching for events, select a suitable playback mode (e.g. event images only) and start playback

(backward or forward) or use the (previous/next image) buttons to jump through the sequences.
When looking for incidents at specific points in time, you can search for a specific time or you can perform a
search using "time leaps" and time-lapse playback. Furthermore, it is possible to play back any date and time
and store that point in time so that the recordings of other cameras can be quickly searched for events at
that time.

The recordings can be played back forward or backward at different speeds, which makes it easier to search
for individual events.
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per Drag&Drop

Device Bar
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Fig. 23: Playback View

The Grid Playback

If a camera registers an event and you want to know if and what other cameras in that camera group were
recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously.
The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera to
find events or specific situations or if you are playing back recordings, the other cameras will follow the lead-
ing camera as soon as playback is paused. The program always shows the event images that are closest to
the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the

difference will be displayed at the lower border of the event images.
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Positioning at Desired Time
Use the timestamp in the focus window of the calendar slider 1o set the fime.

Device Bar
(hidden)

Histogram and
Retail System
thidden)

All comeras jump 1o the event image doses! Playback

1o the set time. The fime stomp below each Direct Positioning ot Desired
camera image indicaes the corresponding Time

date and fime.

Fig. 24: The Grid Playback

The Smart Data Search View

With the MOBOTIX Smart Data System event data from MOBOTIX cameras, MOBOTIX loT App events or trans-

action data, for example from POS systems, can be linked to the related video recordings in MxMC. This

enables conspicuous activities to be found and checked quickly.

In the Smart Data View, you can perform a detailed search (see Searching in the Smart Data Search View, p.

167). Advanced search options and complete video documentation assist you in maintaining a com-

prehensive overview of, for example, POS systems, video-based license plate recognition or access control sys-

tems. Smart Data sources can be added and configured in Smart Data Sources, p. 282.

The Smart Data Search View also includes the Post Video Motion Detection Search (see Searching With Post

Video Motion Detection (Post VM), p. 176)
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Fig. 25: The Smart Data Search View

The Components View

In the Component View, you can manage the following components:

B File Servers that are used to store video recordings.
® Smart Data Sources (license required) from which you can read transaction data

P7 Apps (no license required), POS systems or license plate recognition systems.

, e.g. from MOBOTIX

® MxThinClients, which allow you to display live images from MOBOTIX cameras on a monitor or TV set

with HDMI connection.
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Fig. 26: The Components View

User Management, p. 237 / Notifications / Bandwidth

Header Bar

Camera Bar and Camera Group Bar, p. 49

Context Help / Update / Network Environments, p. 215 / Connection Monitoring
Smart Data Bar

Histogram Bar

Home View / Previous View / Next View / Select View

® 0 ® © ® © © ©

The Device Bar, p. 45
Camera Settings, p. 267

@ @

File Server Settings, p. 276
Smart Data Sources, p. 282
MxThinClient Settings, p. 285

@ ® ©

Softbuttons Settings, p. 288

@ Settings Area for Camera Settings, p. 267, File Server Settings, p. 276, Smart Data Sources, p. 282,MxTh-
inClient Settings, p. 285 and Softbuttons Settings, p. 288.

The Al Camera Apps View

The Al Camera Apps view you can display the Al Apps Web GUI within MxMC to configure the corresponding Al
App or to open the Apps Dashboard for statistical and analytical purposes.
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Fig. 27: The Al Camera Apps View

The Info View

You can add an information page to every camera group in order to show special instructions for operating
this camera group or instructions for a notification chain in case of an alarm, for example. To show the inform-
ation in the Info view, you can compile the information and save it in a PDF or JPG file and then load the file

in the Group Management dialog box.

If you want to show up-to-date information that is presented on a web server, you also do this in the Info
view. Simply activate the edit mode and pull the URL into the Info view.
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Fig. 28: The Info View

The Wizards & Tools view

The Wizards & Tools view is only available to administrators. The options provided by this view can either be
executed for individual cameras or camera groups. Select the camera or camera group in the Camera/Group
bar or in the Device bar and then execute the desired feature.
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Fig. 29: The Wizards & Tools view

User Management, p. 237 / Notifications / Bandwidth

Header Bar

Camera Bar and Camera Group Bar, p. 49

Context Help / Update / Network Environments, p. 215 / Connection Monitoring
Smart Data Bar

Histogram Bar

Home View / Previous View / Next View / Select View

® @ ®©® © ® © © ©

The Device Bar, p. 45
Wizards & Tools, p. 291

©

Configuration: Overview

The Configuration view you to directly access and make settings for MOBOTIX cameras. In general, the view is
divided into a Basic Settings section and an Advanced Configuration section containing Configuration
Groups.

The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.

The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the

camera or the camera group.
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NOTE! The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Cam-

era Feature Overview, p. 9.

Structure of the camera configuration view

LN ) MxManagementCentar

Configuration - mx10-0-38-9

Q

Notification & Transfer VolP Telephony

Clips & Recordings v
& 20190312-070910

g

Fig. 30: Structure of the camera configuration view

Basic Settings

The Basic Settings @ contain basic configuration settings that are important for the setup of cameras and
camera system. The Basic Settings include the following areas:

B General Settings,

B Network,

® Time,

® Image Settings,

B MxActivitySensor and Recording.

The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 92.
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< Basic Settings

General Network Time Image & Exposure MxActivitySensor

Arming Enabled <

Frequency of Power Supply No artificial light v

Audi 2 Disabled -

Fig. 31: Basic settings

Advanced Configuration

The available configuration parameters are thematically grouped in tiles @ . Clicking on a tile opens the topic
area and tabs for the associated sub-topics.

Some of the topics contain graphical configuration items, such as those for defining exposure windows or
detection areas. For more information on how to operate these configuration items see Graphical Operation,
p. 340.

Extensive information on the setting options and parameters of the individual subject areas are currently

available only via the help pages of the camera. You can access the camera help table of contents directly
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).
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Configuring Advanced Settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!

1. Click on the respective tab to open the corresponding topic area.

2. Make your settings as required by topic.

NOTE! Clicking on the relevant topic area in the table opens an information page for the individual

topic areas of the Advanced Configuration settings.

@ [ ] MxManagementCenter

Configuration - mx10-23-236-50

..........................................................................................................................

Cameras < Users & Groups

© mx10-23-236-50 Public Access Rights Admin Group
% MOVE-10.182.0.173
B mx10-0-38-8 mx10-23-236-50

Configuration MC & VMS Function:

" 8 8 B B B B B B ¥

Camera Groups

@ mx10-23-236-50

5 5
¢ MOVE- 92.0.173
ot ‘ Disable all

&. mx10-0-38-9

Clips & Recordings B v
0 20190312-070910

-------------------------------------------------------------------------------------------------------

Fig. 33: Advanced Configuration - Users and Groups

Applying and saving changed settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!
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[ NN ] MxManagementCenter

Konfiguration - mx10-12-225

Kamerakonfiguration

Grundeinstellungen
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Obersicht Hardware

=) @) & Cx

Scharfschaltung Ereignisse Aufzeichnung

Benachrichtigung &
Obertragung

Hir

Analytics

Fig. 34: Applying and saving changed settings

You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-

meter values to factory settings, among other things:

Resetting To Factory Settings

Click on to reset all parameters for the current camera tab to the factory settings.
Undo/Redo Last Change

Click on to undo the last change. Click on to redo the change you previously undid.
Apply Changes

You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.

When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not

been implemented yet. Click . to make this change.
Saving Configurations

If parameter values are changed, the Store Configuration . icon turns red in the Command bar. Initially,
changes are always temporarily stored in the camera. To ensure that the current settings are also used after
the next restart, the changes must be saved permanently.
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1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on
Store.
2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last

permanently saved overall configuration.

Expert Settings

Various sections of the configuration provide additional settings that can be used to change parameters that

are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-

tings in the different sections. Click on to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration
Bar

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!

You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to
check which parameter values are available for the other cameras in the group. There you can also change
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-

era group.

Checking parameter values of other cameras in the group

LR ] MxManagementCenter

Konfiguration - mx10-31-11-117

Allgemein Netzwerk

. mx10-10-38-40
& ma0-21-21-191 e
fl mao-a1-n-n7 il Vom Master &

& mx0-15-12-115 Netzfrequenz [ mx10-21-21-191

Kameraguppen 3 vl Audioguelle [ Deaktiviert _______LJ

» i Alle Kameras

MxThinClient-Geriite b
&3 MxThinClient

Clips & Aufzeichnung 3 v

» P9 Toreinfahrt

Fig. 35: Checking parameter values of other cameras in the group
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Example: Check arming for multiple cameras

1. Click on the relevant parameter name @ .
2. It turns yellow and the Configuration bar shows all values associated with this parameter that were
defined for cameras in this group @ .

Changing a value for one camera or for multiple cameras

eCe MxManagementCenter

Konfiguration - mx10-31-11-117 7@ @)

¥zrieras & Cistsllungen

Allgemein Netzwerk Sl B Scharfschaltung
| TE——

'
e Netwfrequenz  (ELT'S

Kameraguppen & vl Audioguelle [ Deaktiviert L

» i Alle Kameras
» i Tirstationen

MxThinClient-Gerite v
3 MxThinClient

Clips & Aufzeichnung &) v
» P9 Toreinfahrt

Fig. 36: Changing a value for one camera or for multiple cameras

Example: Change a value using the Configuration bar

1. Click the appropriate parameter name in the Configuration view @ . It turns yellow and the Configuration

bar shows all values associated with this parameter for this group @ . The cameras for which this value is

set are assigned to the individual values.

2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area

turns yellow.

3. If the same value is set for several cameras and you want to change this value, click on the parameter

selection field in the Configuration bar ® . Then select the desired value.
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Setting up a MxManagementCenter-based video surveillance system can be costly and will
usually be done by an administrator / system installer. This section addresses admin-
istrators and system installers and provides an overview of the tasks that must be per-
formed to efficiently set up a system.

However, not all of these tasks are mandatory for a basic installation (see Basic Install-

ation: Overview, p. 74).

Step Explanation
Adding Cameras, p. 75 Integrate cameras with the Welcome wizard or in the
Device bar

Set alarm filters
Set up recording paths

Setting Up Camera Groups, p. 87  Create camera groups
Add cameras to groups

Define group functions

Adding Users, p. 90 Create users
Assign permissions
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Basic Installation: Overview

Step Explanation
Configuring Basic Camera Set- General settings
tings, p. 92 Network

Time

Image settings
MxActivitySensor
Recording

Checking System Security, p. 294  Verify system security settings

Secure the system

Backing Up And Exporting, p. 120  Save the settings made

Import Existing Project,

p. 114 Import an MxControlCenter file (INI file)
Import an MxEasy file (NDB file)

Basic Installation: Overview

The Setup section describes the steps required to set up a system. For a basic installation, however, not all

the steps shown are mandatory. The following list gives an overview of the most important steps of a basic

installation.
Step

Adding Cameras, p. 75

Setting Up Camera
Groups, p. 87

Adding Users, p. 90

Explanation

When starting MxMC for the first time, the Welcome Wizard opens and auto-
matically starts searching for MOBOTIX cameras. Cameras in the local network are
automatically detected and listed.

Cameras can also be added in the Device bar. Cameras that are in the local network
are also automatically detected and listed here. Cameras outside the local network

need to be added manually (see Adding devices and sources, p. 84).

Create camera groups to group your cameras. By organizing in groups, entire sur-
veillance areas are always recognizable at a glance.

Assign the cameras to the desired groups.

Set the layout for the Grid view and Graphic view.

After you have added the cameras and organized them into groups, create the users

and any other administrators and set their access permissions.
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Step Explanation
MxMC Licensing, p. Industry-specific solutions and special functions, such as the integration of cash
317 point systems, are subject to licensing. To be able to use them, the purchased

licenses must be activated.

Configuring Basic Cam- Make sure that the main arming option has been activated (see Basic Camera Set-
era Settings, p. 92 tings: General Settings, p. 97. Synchronize the time (see Basic Camera Settings:
Time, p. 99), arm the recording (see Basic Camera Settings: Recordings, p. 104) and

specify a recording destination if necessary (see Adding Cameras, p. 75).

Checking System After completing the basic configuration of the system, you can check its security.
Security, p. 294

Backing Up And Finally, you should save your settings. (You can save the settings locally as a project
Exporting, p. 120 file.) The Device Backup function can be used to save the settings across the entire
system.

Adding cameras, devices and sources

This section describes the necessary steps to add and configure cameras, devices and other sources.

Adding Cameras

The cameras and Door Stations can either be integrated with the Welcome wizard or added to the Device bar.
These cameras also include MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-com-
patible interface.

Integrating cameras with the Welcome Wizard

When starting MxMC for the first time, the Welcome wizard opens and automatically starts searching for cam-
eras. The number of found cameras is shown next to the Add button . This number is updated auto-
matically if the number of MOBOTIX cameras on the network has changed (i.e., by connecting

new/disconnecting existing cameras).
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Fig. 37: Integrating cameras with the Welcome Wizard

1. Click on Add Devices

All found cameras are displayed either in a list or as tiles. Whether the cameras are displayed in a list or

as tiles is determined by clicking on either the

tiles

or list button.

2. The respective camera status is automatically tested and displayed:

Q =The camera cannot be interacted with under the found or entered IP address.
= The camera is in a different network than the computer.
= The camera firmware is not up to date.
= The camera is password protected.
= Incorrect user data was entered.

= Preview image not available.

3. Select the cameras you would like to integrate.
® |f some of the selected cameras are password protected, click on Change Camera Access and

enter the user name and password.

® |f some of the selected cameras are not in the correct network, click on Edit Network Settings

Here you can choose whether the IP address is automatically determined or whether a fixed IP

address is used.

® Determining an IP Address Automatically: If your computer automatically gets its IP address
from a DHCP server (e.g., DSL router), then it also makes sense to have the system determine
the camera's IP address automatically. To do so, enable the Get IP Address Automatically
option.

® Using a Fixed IP Address: If you have assigned a fixed IP address to your computer, you will
probably prefer to assign a fixed IP address to the camera as well. To do so, enter the IP
address and the subnet mask.
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4. Click on Apply and wait for the cameras to be reconfigured.

NOTE! If the  icon is displayed instead of the preview image, the camera could not be reconfigured due

to incorrect user data. In this case, correct the user data and try again.

5. The number of selected cameras is shown near the Next Page button. Go to the next page.
6. Click on Done. The selected cameras are now integrated.

NOTE! Clicking on Start New Project opens the application directly, and you can add the cameras using

the Device bar.

Adding cameras via the Device Bar

e0® Willkemmen

MxManagementCenter

Q" 0O I

Geriite hinzufiigen Projekt &ffnen Meues Projekt starten

(4 (4 4

MxCC importieren MxEasy importieren MXU importieren

Mobotix » Kalsersirasse D-67722 Langmeil + info@mobotix.com » www.mobotix.com

Fig. 38: Adding cameras via the Device Bar

The first time you start MxMC , the Welcome wizard automatically opens, allowing you to add your cameras
and Door Stations. These can also be added using the Device bar. If you prefer to use the Device bar instead
of the Welcome wizard, click on Start New Project in the dialog. This opens MxMC directly in live view, and
the Device bar is open.

1. Open the edit mode at the bottom of the Device bar by clicking on
2. Next, clickon . The Add and Import dialog opens.
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" @Adding Cameras In The Local Network

All cameras and Door Stations in the local network can be detected and displayed automatically.

" @Adding Cameras Manually
Cameras outside of the local network (for example, on the Internet) need to be added manually.

Capturing the data of many cameras

The authentication data used by MxMC as well as the environment settings can be changed in one step for
many cameras in the Multi-Camera Configuration dialog.

1. To do this, open the edit mode in the Device bar by clicking on
2. Select the cameras as needed.
Mac: CMD + click, Windows: CTRL + click
3. Right-click on one of the selected cameras. The Multi-Camera Configuration dialog opens (see Multi-Cam-

era Configuration, p. 236).

Setting Alarm Filters

NOTE! For MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-compatible inter-
face, there is no alarm function available and you can thus neither activate background monitoring nor set

alarm filters. For an overview of how the camera functions differ, see Camera Feature Overview, p. 9 .

Events that lead to an alarm will change the background color of the Alarm bar, Alarm Info bar (see The Alarm
Bar, p. 51 and Alarm Processing, p. 148 ) and other Ul items to red. You can set the event types that trigger a

signal for specific cameras in the Camera Configuration dialog.
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1. To open the Device bar, click on  at the bottom of the bar.

2. Then either right-click on individual cameras or click on the icon, which is shown when you position
the mouse pointer over the camera name.

3. Click on Alarms to adjust the settings to your needs. The Alarm Events dialog opens.

Clip & Recording Configuration (o))
Name mx10-12-156-92
hiarms &
Connection Protocol MOBOTIX o]
|Alarm Signaling
URL 192.168.178.98 Active i
Remote URL DynDNS 0
User Name admin paim Ovecvisy
Password = esesss Alarm Active Weekly Profile Invert  Public Holidays
Enviranmant Staidard ® MxActivitySensor v 24 Hours 3 ignore &
Standard Compamy Private 6 Video Motion < 24 Hours < ignore S
Back dA @ Behavioral Detection + 24 Hours S ignore &
ackground Alarms
Remote 7 @ Shock Detector v 24 Hours z ignore 5
SsL i 6 lllumination v 24 Hours & ignore £
Bandwidth @ Microphone 7 24 Hours o ignore s
Bandwidth Settings > @ Passive Infrared Detector |V 24 Hours 2 ignore 4
Recording Settings Via Camera > @ Tempersture 7 24 Hours s ignore s
Alarms On > =
- @ Internal Events | 24 Hours 2 ignore ]
@ Message Events v 24 Hours < ignore -
. Meta Events V| 24 Hours o ignore 2
@ Signal Events V| 24 Hours Fo; ignore ~
@ Time Events v 24 Hours {o] ignore &
@ Ringing i 24 Hours & ignore <]
@ Mailbox messages v 724 Hour{s £} ignore -
(@ Door station 7] | 24Hous ¢ ignore 5
R o T
il @) R Rejected 7 | 24Hours ¢ ignore 2
@ PIN Rejected 7 _24 Hours 5 ignore +]
O Other V| 24 Hours Lol ignore -+
Edit weekly profiles...

Fig. 39: Setting Alarm Filters

4. Make sure that the Alarms option has been activated.
5. Select the event types that should create an alarm.
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6. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as

no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.
B Click on Edit weekly profiles to create new weekly profiles. The Weekly Profiles dialog opens.

Several predefined profiles are available, such as the Weekend profile (Saturday 00:00 to Sunday
24:00).

® To add a profile, click on|+|. Enter a description. Next, highlight the desired active times in the
table using the mouse. You can resize an active time block by clicking on the time block and then
moving the borders accordingly It is also possible to move a block. Click on the block to select it,
then drag the block to the new position. To delete a time block, click on ¢3.

[ N ] Wochenprofile

Wochenprofile Dienstag Mittwoch Donnerstag Freitag Sonntag

| Offnungszeiten
Weekend
Working Days 02:00

e
Fig. 40: Alarm Filter profiles

7. You can change the description of an existing profile. Right-click on the name and overwrite it.

8. To select a weekly profile, click on the Weekly Profile drop down list next to the event type and select
the desired profile.

9. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with opening hours and would like to activate the alarms for the closing times, click on the
Invert weekly profile checkbox and the profile is used in inverted fashion.

Setting Up Recording Paths

The program can access the stored recordings using the following methods: Access to recordings via the cam-
era (remote playback) or to a local directory where the recordings are stored or directly to a file server.

When accessing via the camera (MOBOTIX camera), no further settings are required. If you want to access the
recordings directly (file server or local directory), you need to define recordings paths and assign these to
the cameras. Direct access offers the advantage of an extremely fast playback speed (up to 60x).
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NOTE! Recordings of MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-com-
patible interface can only be saved on MOBOTIX NAS. To do this, first configure the MOBOTIX NAS and then
set up the recording path in MxMC.

Defining the Recording Path

o0 Einstellungen
Allgemein % Neuer Aufzeichnungspfad +
Netzwerk

Software-Update

N : i
Benachrichtigungen ame: Neuer Aufzeichnungspfad

Uberwachung Unter diesem Mamen kann der Pfad in der Kameraverwaltung als

Audio Aufzeichnungsserver ausgewdhlt werden.

Datenmenge Typ: | Lokal

Caches ) )

Sch h Bild Local: Uses a folder or a connected network drive on this computer.
chnappschuss-Silder Network Share: Directly accesses a shared folder on a different computer.

Live-Recorder MxNAS-ONVIF Base: 277

Aufzeichnungspfade

Fernsteuerung pfad: 7

Joystick-PTZ

MxMessageSystem

Retailsystem

Ein Aufzeichnungspfad ist ein Ort, auf dem die Kameras ihre Daten speichern. Die Anwendung kann direkt darauf
zugreifen, um die Daten anzuzeigen und abzuspielen. Es kiinnen mehrere Aufzeichnungspfade definiert und den
einzelnen Kameras zugeordnet werden.

Wichtig: Ein Verzeichnis muss vor dem Teil des Pfades enden, der die Werks-IP-Adresse der Kamera enthilt.

Server-Einstellungen testen: Testen

Voreinstellungen Anwenden Abbrechen m

Fig. 41: Defining the Recording Path

1. Open Settings in the MxManagementCenter > Settings > Recording Paths (Mac) or File > Settings >
Recording Paths (Windows) menu.

2. Click on "+" and enter the desired name. Under this name, the path can be selected as the recording path
in the Camera Configuration dialog.
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3. Select the type:

® | ocal

Contains a local folder on this computer or on a connected network drive. You can either enter the
folder path manually, drag & drop a folder to the input field or select the local or linked folder.
Path: You must select the path that contains the recording folders created by the camera.
Network Share

The program directly accesses a shared folder on a file server. In this case, you need to enter the
computer, the folder and the access data.

File Server (IP): IP address or DNS name of the file server with the share.

Directory: Name of the share on the file server.

Important: Make sure that the path ends before the folder containing the factory IP address of the
camera.

User Name/Password: Access data for the network share.

MOBOTIX NAS

Data is accessed directly on a shared folder on a MOBOTIX NAS.

File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.

Directory: Name of the share on the MOBOTIX NAS.

Important: Make sure that the path ends before the folder containing the factory IP address of the
camera.

User Name/Password: Access data for the MOBOTIX NAS.

MOBOTIX NAS (ONVIF-S/G)

The ONVIF-S/G recordings are accessed on a MOBOTIX NAS.

File Server (IP): IP address or DNS name of the file server.

User Name/Password: Access data for the file server.
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Assigning recording paths to the cameras

LK MxManagementCenter

Camera Configuration

Elos 158
Name mx10-6-53-201

...............................

P Connection Protocol | MOBOTIX

URL 10,6.53.201
||||||||| ¢ " Remote URL DynDNS (EEERRN N R R R

User Name admin

Password
Environment Standard
Background Alarms
Remote
SSL
ok Bandwidth
Bandwidth Settings

Recording Settings Via Camera >
Alarms On >

Remove

13.01.20 12:45:04

Fig. 42: Assigning recording paths to the cameras
1. Open the Camera Configuration dialog in the Device bar. To do so, clickon  at the bottom of the bar.

2. Then either right-click on individual cameras or click on the E’ icon, which is shown when you position
the mouse pointer over the camera name.

3. Select the appropriate recording path in the recording settings. The following options are available:
B Via camera: When accessing via the camera (MOBOTIX camera), no further settings are required.

B |ocal Path: Set the appropriate recording format: Use MxFFS, if the recordings have been stored in
an MxFFS archive. Use MxFileServer, if the recordings have been stored in the classic MOBOTIX folder-
/file structure. Then enter the local directory in the Device Directory text box.

NOTE! Click on the pen icon in the text field to open a file selection dialog.

B File Server: If file server access is used, MxMC searches the specified file server path for sub folders
with the corresponding recordings. Once the search has been completed, you can select the folder for
this camera in the Device Directory selection box.

B MOBOTIX NAS: When accessing a MOBOTIX NAS, select the appropriate camera IP in the Device Dir-
ectory selection box.
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Adding devices and sources
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Fig. 43: Adding devices and sources

Select the desired action:

Adding Cameras in the Local Network

All cameras and door stations in the local network are detected automatically.

1.
2.

Clickon . The Welcome wizard opens and lists all cameras that were found on the local network.
Select the camera you want to add (use CMD-click on a Mac or CTRL-click on Windows to select several

cameras).

Specify a user name and a password. Click on to do so. When multiple cameras have been selected,
all of these cameras will get this user name and password.

Click on and then on Finish. All new cameras are shown in the device bar in the Cameras section and

you can already see the live images of the cameras.
You should now complete the data for the individual cameras. Open the Camera Configuration dialog

for this purpose. To open the dialog box, you can either right-click onto individual cameras or you click
on the icon, which is shown if you position the mouse pointer over the camera name. The Camera

Configuration dialog opens (see Camera Configuration, p. 222).
Close the dialog once you have completely filled in the camera data in the Camera Configuration dialog.

Then deactivate the edit mode of the device bar by clicking on
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Adding Cameras Manually

Cameras outside of the local network (for example, on the Internet) need to be added manually.

1. Clickon .The Camera Configuration dialog opens.

2. Enter the camera access data:
Name: Enter a descriptive camera name.
URL: IP address of the camera.
Remote URL: To access the camera from outside of the local network, you can enter the corresponding
external address of the camera (such as a DynDNS name). Make sure that you also activate the Remote
option.
User name, password: Enter the user name and password of the camera.

3. Complete the network data and set up alarm notification as described in Camera Configuration, p. 222.

4. Close the dialog once you have completely filled in the data in the Camera Configuration dialog. Then

deactivate the edit mode of the device bar by clicking on

Creating Camera Groups

1. To create a camera group, clickon . The Group Configuration dialog opens.
2. Fill'in the data as described in Setting Up Camera Groups, p. 87.
3. Close the dialog once you have completely filled in the data in the Group Configuration dialog. Then

deactivate the edit mode of the device bar by clicking on

Importing Clips

You can use MxMC to play back exported MxPEG clips. Click on to do so. The Load Clips dialog opens:
Select the desired MXG file and click on Open. The clip appears in the device bar in the Clips section.

Importing recordings

This function allows you to add storage paths generated by MOBOTIX cameras.

1. Click Recordings.
2. Select the desired directory with the camera's recording structure and click Open.

The recordings are displayed in the Device Bar in the Clips & Recordings section.

MxFFS Medium

This function allows you to access a MOBOTIX storage device connected to the USB port with recordings in
MxFFS format.
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NOTE! To be able to read MxFFS media, you must start MxManagementCenter with administrator rights
(see Integrating MOBOTIX Storage Devices, p. 325). Without administrator rights, the storage medium will
not be recognized.

1. Click MxFFS Medium.
2. Select the desired directory and click Open.

The recordings in MxFFS-Format are displayed in the Device Bar in the Clips & Recordings section.

Creating Clips-/ Recording groups

Clips and recordings can be organized into groups.

1. Click Create Clips / Recording Group.
2. Specify a name for the group.
3. Move the desired clips and recordings into the group.

Connecting MxThinClients

Edit the MxThinClient setting here. The MxThinClient is a compact solution for displaying the live image of a

MOBOTIX camera on a monitor or TV set with HDMI connection.

Name

Enter the name for the MxThinClient here.

URL

Enter the URL or IP address of the ThinClient.

User Name

Enter the user name of the MxThinClient user here.

Password

Enter the password of the ThinClient user here.

Display resolution

Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.

Camera display

Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After
the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).

MxThinClients can also be added via the Component view (see The Components View, p. 61).

86 / 346



Setup
Setting Up Camera Groups

Setting Up Camera Groups

You can combine individual cameras into camera groups. For example, you can combine all cameras situated
on the same floor in one group. This allows checking on entire surveillance areas at one glance and - in case

of an alarm, you are quicker to access the relevant cameras.

Creating camera groups

MxManagementCenter

Foyer - Live

e R R R R TR R R R R R AN

Kameragruppen
v Hi Alle Kameras

@ mx10-10-38-40

£o -
‘ Gruppenkonfiguration

Name Name

Hinzufgen
Suchen
Manuell
Kameragruppe
B e

E Aufzeichnung

E Clip-/Aufzeichnungsgruppe

&) vninciient ONVIF LoRes-Profil verwenden
0 /s §..0-190112.mxq o
S SO
T T L E T T e T T T L L LR

8 <> > N b= L 2 G fandiay, (=) Ch &P 181018 11:40:56

Max. Bilder pro Sekunde 4B[s

Max. BildgréBe Unbegrenzt

ol E

Fig. 44: Creating camera groups

1. Open the edit mode in the Device bar by clicking on at the bottom of the bar. Next, clickon . The
Add and Import dialog opens.

2. Clickon .The Group Configuration dialog opens.
Enter a group name and - if desired - add an image or an icon that will be used to represent the group in
the group bar later on. To do so, click on the gray field and select one of the predefined icons. If you want
to use one of your own images, click on Custom.

4. Add a background image: Move the slider @ to the right until you reach the @ position. Click on the
arrow in the gray field and select the file with the background image (for example, ground or floor plan).

5. You can add an information page to a camera group in order to show special instructions for this cam-
era group, for example. Move the slider @ to the right until you reach the o position. Click on the

arrow in the gray field and select the file you want to use.
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6. Grid Tiles Bandwidth Limits: If a very large number of cameras is displayed in the Grid view, the per-
formance may decline. To avoid this, you can limit the frame rate of the live images within the grid
frames. Note that this limit does not apply to the camera displayed in the focus window.

Use ONVIF-S/G LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and
for third-party cameras that provide an ONVIF-S/G-compatible interface. If the checkbox is enabled, the
settings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these
cameras will be used.

7. Close the dialog once you have completely filled in the data in the dialog. Then deactivate the edit mode

of the device bar by clicking on

Adding Cameras to a Camera Group

After you have added cameras and created camera groups, you now should assign cameras to the proper
groups.

1. Open the edit mode in the Device bar by clicking on at the bottom of the bar.
2. Dragand drop the corresponding camera to the desired group.
3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking

on

Setting the Group View layout

To view and work with camera groups, there are two views available: the Grid view (grouping the cameras by
any criteria in raster form) and the Graphics view (realistic arrangement of the cameras on a graphic back-
ground). For each camera group you have the option of defining the Grid view grid layout and positioning the
cameras on the background image (e.g., building plan) in the Graphics view as desired.

NOTE!

If you have created a group and have not added any cameras yet, the application will show the icon P in

the Group and Device bar.

Setting the layout for the Grid View
When you first open the Grid view after you have created a camera group, the cameras belonging to the
group are displayed in the following grid layout by default:

B The aspect ratio of the camera images is 4:3.

B The Grid view is in auto grid mode. In auto grid mode, MxMC always tries to distribute the available
space as well as possible according to the specified camera image format, the size of the focus window
and the number of cameras. If you change the size of the window, the grid layout adapts automatically.

B The focus box displays the camera that is in the Device bar at the top of the group.

B The focus window size is twice as large as that of the camera images.
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Fig. 45: Setting the layout for the Grid View

1. To change the format of the camera images or the size of the focus window, open the edit mode by click-

ing on in the Command bar. The following sliders for adjusting the grid layout appear at the bottom

of the bar:
" @ = Format of the camera images and the focus window (4:3, 16:9, 8:3)

= @ = Size of the focus window (1x, 2x, ..., 8x the size of the camera images)
" @ = Maximum number of cameras

2. Move the sliders to the desired settings. To close the edit mode, click on

See also: Group Views, p. 202

Configuring the Graph View layout
When you open the Graphic view for the first time after creating a camera group, all cameras in that group

are listed at the right margin of the previously defined background image with a camera icon .
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Fig. 46: Configuring the Graph View layout

1. To arrange the cameras according to their actual positions on the background image, open the edit mode
by clicking on

2. To do so, move the mouse pointer over the camera icon. Two icons are shown.

3. Click on @ and drag the camera icon to the desired location.

4. Clickon to save the changes.

See also: Group Views, p. 202

Adding Users

After you have added the cameras and organized them into groups, set up users You can define different user
types (User Types, p. 245) like regular Users, Administrators or Supervisors with specific access and con-
figuration rights. You define access permissions based on time schedules.

CAUTION! An administrator possesses all rights.
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Fig. 47: Users settings

Users can be managed in the User Management section. To open the User Management section click on .
@ in the header bar.
The following steps show how to quickly add a user with default settings. For more details see: User Man-

agement, p. 237.

Adding Users

To add a user open the User Management and click on the Add icon GH® .

User basic settings

1. Enter the corresponding user name.

2. Select the user type: User, Administrator or Supervisor.

NOTE! The user type is set to User by default.

3. Check the Active option to enable the user to lock in.
Password

1. Enter a password and confirm it.

2. The Force Complex Password option ensures that users can only set strong passwords.
Requirements for a strong password:

B At least eight characters

® |ncludes lowercase and uppercase letters
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® |ncludes numbers
B |ncludes at least one special charactere.g.,! @ # 7 ]

B Cannot be one of the last thirteen passwords used on this user account.

NOTE! If you are trying to set a password that does not meet the criteria, a red frame around the text field
will appear.

Further settings vary depending on the user type. For more details see: User Management, p. 237

Configuring Basic Camera Settings

MxMC offers the possibility to adjust settings directly on the cameras. Some of the configuration options are
summarized in the Configuration view under the green Basic Settings tile. This area includes all topics that
are important or necessary for commissioning. Unlike "Advanced Features," the basic camera settings do not
require a license and are therefore always available.

NOTE! MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-compliant interface
cannot be configured using MxMC. For an overview of how the camera functions differ, see Camera Feature

Overview, p. 9.

Opening Basic Settings

1. Open the Configuration view by right-clicking on the navigation key in the Command bar. Select the Con-

figuration view.

NOTE! When opening this view, the system always loads the configuration of a camera group.
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2. If you did not purchase a license to use "Advanced Features," the Basic Settings section is opened by
default.
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3. If you have purchased an "Advanced Features" license, the Configuration view entry page will open. Click

on the Basic Settings tile.
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Configuring Basic Settings

Click on the respective tab to open the corresponding topic area.

2. Make your settings as required by topic.
More detailed information on editing the settings can be found in the table below. Clicking on the rel-
evant topic area in the table opens an information page for the individual topic areas of the basic set-

tings.
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Default setting

Basic Camera Settings: Gen-

eral Settings, p. 97

Basic Camera Settings: Net-
work, p. 109

Basic Camera Settings:
Time, p. 99

Basic Camera Settings:

Image settings, p. 100

Basic Camera Settings:

MxActivitySensor, p. 107

Basic Camera Settings:

Recordings, p. 104

Associated Parameters

Arming, Frequency of power supply, Audio source

Internal host name, BOOTP/DHCP, Second IP address

Automatically synchronize using a time server, Do not adjust automatically

Image size, JPEG quality, Camera selection, Display mode, Installation, Expos-

ure window, Exposure program, Max. exposure time

Active, Profile name, Event dead time, Edit detection area

Arming, Recording mode

Applying And Saving Changed Settings

The controls at the bottom of the configuration view can be used to perform actions such as permanently

storing the changed settings or to reset the parameter values to their factory settings.
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Applying Changes

Normally, the changes in the Configuration view take effect when you type or select the new value. The
changes made here are not automatically adopted because they could potentially cause problems with the
Network Settings. Instead, the Apply Changes ./ icon in the Command bar turns red, indicating that the
change is not yet in effect. To apply your changes, click on /.

Storing the Configuration

If parameter values are changed, the Store Configuration icon , turns red in the Command bar. Changes to
the configuration are always stored in the camera temporarily. To ensure that the current settings are also

used after the next restart, the changes must be saved permanently.

1. Click on Store Configuration ,. The program opens a system prompt. In the prompt, click on Store.
2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last
permanently saved overall configuration.

Resetting to Factory Settings
The parameter values of the opened tab can be reset to the factory default settings. Clickon  to do so.

Undoing or Repeating Changes

Click on  to undo the last change. Click on  to repeat the last change.
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Changing Parameter Values for Multiple Cameras in the Configuration

Bar

The Configuration bar on the right margin offers the possibility to change the settings of several cameras of a
group without having to change the camera or the camera group.

‘eo® MxManagementCenter
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x10-10-38-40 Aligemein
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v T
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IO OO

Changing the Value for a Camera

If the Configuration bar is not already open, open it by clicking on the right margin in the application.
2. Click on the desired parameter name in the Basic Settings. It turns yellow and the Configuration bar
shows all values associated with this parameter for this group. The cameras for which this value is set are

assigned to the individual values.
3. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area

turns yellow.

Changing a Value for Multiple Cameras

If the same value is set for several cameras and you want to change this value, click on the parameter selec-
tion field in the Configuration bar. Then change the parameter value for the cameras configured the same

way at once.

Basic Camera Settings: General Settings

The general topics on operating the cameras are found in the general settings.
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Fig. 48: Camera Settings: General Settings

Arming
The main arming feature needs to be activated in order to process events, execute actions and notifications

and record images and audio data.

Parameter Explanation

Activated The camera is always armed.

Off The camera is not armed: no image storage, actions or messages.

CS Arming is controlled via a custom signal that needs to be previously configured on the cam-

era. The camera can use a signal input, for example, as the main switch for arming by using

the custom signal.
From master The camera is armed only when the master camera is armed.

See also: ® Recording

B MxActivitySensor

Frequency of Power Supply

If the camera’s exposure control is not matched to the frequency of the power supply, sources of artificial
lighting may lead to image interference. This parameter sets the camera to the power supply frequency of the

respective country to prevent interference.
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Parameter  Explanation

No artificial If the camera is used in daylight conditions (rather than with artificial lighting), you can also

light use the No artificial light setting.
50 Hz The factory default setting for Europe is 50 Hz.
60 Hz Set the power supply frequency to 60 Hz for Canada, the U.S. and Japan.

Audio Source

Select the desired audio source. It is also possible to integrate an external audio source in addition to using
the camera's microphone. The audio source is used for two-way communication and recording audio data,
for example.

Basic Camera Settings: Time

The date and time can be manually set, adopted from the computer, or continuously synchronized through a
time server. If you use a time server, the clock can be synchronized using a time server over the Internet, a
time server service in the local network or another MOBOTIX camera. In this case, the camera's time server
must first be set in the camera web Ul Admin menu (Admin Menu > Camera Administration >

Time & Date > Use Camera as Time Server).
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Fig. 49: Basic Camera Settings: Time
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Automatically Synchronize Using a Time Server

Two protocols are available for synchronizing the camera using a time server: NTP and Time Protocol.

Parameter Explanation

Time B NTP: With this protocol, the camera continuously synchronizes with one or more NTP
Server time servers. If the NTP protocol has been selected, you can enter up to five time servers
and under Time server address. Theses servers must support the protocol specified in RFC
Time 1305. A green dot to the right of the time server address indicates that the time server is
Server accessible and offers an NTP service. It can take a moment for the camera to connect to
Address the time server and the dot to turn green.

® Time Protocol: With this protocol, the camera synchronizes every six hours (and when it
is rebooted). If Time Protocol (RFC 868) is selected, enter the Time server address in

this box. The server must support the protocol specified in RFC 868.

Current Display time of the current camera

Time

Time Zone Select the correct time zone for the camera location.

Do not adjust automatically

Deactivate automatic synchronization if the date and time are set automatically or if they are adopted from

the computer.
Parameter Explanation

Current Time  Display time of the current camera
If the camera’s time deviates from the computer’s time, click on Use PC time to adopt the

computer’s time.

Set time manu- Capture the desired data to manually set the date and time and click on Set time to con-

ally firm the entry.

Time Zone Select the correct time zone for the camera location.

Basic Camera Settings: Image settings

To display the camera live images, you can set camera views, image and exposure settings in this tab and cre-

ate and edit custom exposure windows directly in the live image.
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Fig. 50: Image settings

JPEG quality

The JPEG quality influences both the image quality as well as the file size of the JPEG and MxPEG files gen-
erated by the camera.

Using a compression of 60% (default) will usually deliver good-quality images that are suitable for most pur-
poses. If the value is lower than 20%, you can see pixelation within the image. For values higher than 70%, dif-
ferences to the uncompressed original image are hardly visible. The file size, however, may increase to more
than 100 kB (for a 640x480 pixel image).

Camera selection

On Dual cameras, select the image sensor to use when displaying the images: right image sensor, left image
sensor, both image sensors or automatic day/night switching. When configuring the image settings for both
sensors, first select the sensor you want to configure using the left or right checkbox in the live image preview

window and enter the settings you want.

Display mode

There are various display modes available depending on the camera model.
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All Cameras Except Hemispheric Models

®  Full image: The entire live image from the camera is displayed.

B Lens correction: This option displays a portion of the live camera image (with lens correction). This
option is only available for L22 lenses, provided that the camera configuration is adjusted accordingly.

B Picture-in-Picture: This option displays a small image from one camera sensor inset in the large
image of the other. This setting is available on MOBOTIX Dual models only.

B Picture in Zoom: This option displays a small version of the entire live camera image in the lower
right corner of the large live camera image. This way, the entire image is visible even when the live
image is zoomed.

®  Event in Picture: This option displays a small version of the latest event image in the lower right

corner of the large live camera image.

Hemispheric Models

B Full image: The entire (distorted) full image of the image sensor is displayed.

®  Normal: A corrected image is displayed. This image can be panned and tilted. This is the factory
default setting for hemispheric cameras.

B Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one
joint view. Note that you can use PTZ actions to modify all four views independently from one another.

®  Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-
orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3.

®  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smaller
images (each with aspect ratio 4:3) in one large image.

®  Double panorama: This mode shows a panorama view for the North half of the image and a second
panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This view
only makes sense for the ceiling-mounted MOBOTIX Hemispheric model. Both partial views (North and
South) can be changed independently of each other using PTZ commands.

Installation

You can set the mounting position of a MOBOTIX Hemispheric camera: wall, ceiling or floor. The mounting
positions are set separately for the left and right lenses for cameras with two active image sensors.

Exposure window
It is set to ensure the proper exposure/brightness for the live camera image.
Custom

Creating And Editing Custom Exposure Windows Select the Custom option and then click on the window in
the live image preview.
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Action Explanation

Create expos- Draw a window using the mouse pointer.

ure windows

Move expos- Left-click on the exposure window and move it to the desired position.
ure windows

Modify expos- Move the mouse pointer over one of the white "handles" until the t icon is displayed. Left-
ure windows  c|ick with the mouse and drag the window making it larger or smaller.

Delete expos- Click @
ure windows

Exclude Pull open a window of the appropriate size at the position that should be excluded from
areas from  exposure metering. Click in the window and keep the mouse button depressed until two icons
exposure appear. Click on to determine the exclusion window. The window turns red.

metering

Visible image area

This setting enables you to use the current visible image section as the exposure window.

Predefined

You can use a number of predefined exposure windows: When you select the corresponding window, it will be
displayed in the live image for review. A predefined exposure window is always applied to the full-image area,
that is, the entire image of the sensor.

Full image: Entire area of the image.

Quarter: An exposure window at the image center that covers a quarter of the viewable image area.
Center: One exposure window at the image center.

Spot: One small exposure window at the image center.

Top: One horizontal exposure window at the top of the image.

Center: One horizontal exposure window at the image center.

Bottom: One horizontal exposure window at the bottom of the image.

Right: One vertical exposure window at the right border of the image.

. Vertical: One vertical exposure window at the image center.

Left: One vertical exposure window at the left border of the image.
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Right AND left: Two vertical exposure windows at the left and right borders of the image.

Exposure program

These parameters influence the balance between an exposure time that is as short as possible and hardware
aperture that is as small as possible. The objective is to reach a fair compromise between clear images of
moving objects (short exposure time, high amplification) and as little image noise as possible (long exposure

time, low amplification).

B 0: Default program.

B  Negative: The programs will reduce exposure times to decrease motion blurring; could increase image
noise.

B Positive: The programs will increase exposure times to reduce image noise; exposure in very bright

environments is not impacted.

Maximum exposure time

This parameter determines the longest exposure time used by the camera. This setting enables you to either
avoid motion blurring as lighting conditions decrease, or even specifically allow it. Select shorter maximum
exposure times if you do not want motion blurring. You can use a longer maximum exposure time (max. of
1/1 =1 second, for example) if you want the camera to produce images with good exposure (with motion blur-

ring), even in low light situations.

Basic Camera Settings: Recordings

In this tab, the most important recording settings can be made, such as selecting the recording mode or set-

ting the recording speed.
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Arming

The arming feature for event control handles camera recording. However, the main arming of the camera
needs to be activated in order to make the recordings in the first place.

Parameter Explanation

Off The recording feature is deactivated.

No further parameters will be displayed.
Activated The recording features of the camera are activated (default setting).
CS The recording is activated by a custom signal (CS).

From master The recording feature of the camera will only be enabled if recording has also been activated
on the master camera.

Recording mode

You can select the type of recording for events and story images. The availability of the parameters will
depend on the recording mode you select.
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Recording
Type

Snapshot

Recording

Event record-
ing

Parameter

This option will save individual pre- and post-alarm images (JPEG images), but without sound.
Snap shot interval

This option determines the amount of time between the individual pre-alarm and post-alarm

images. You can set values from zero to ten minutes (max.).

Pre-alarm images

Number of the image that are recorded before the event.

Post-alarm images

Number of the image that are recorded after the event.

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep,
expressed in hours and days, if you deactivate this option.

The maximum value for time to keep indicates how long images and video clips need to be
stored.

This option stores clip files for every event using the MxPEG codec with variable frame rate
and optional audio data.

Record audio data

If available in the camera, audio data can also be recorded. Set this option to active to enable

audio recording.

Event frame rate

Recording speed in frames per second (fps).

Recording time before event

Time (in seconds) to include in recorded stream before an event has occurred.

Recording time after event

Time (in seconds or minutes) to include in recorded stream after an event has occurred.

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep,
expressed in hours and days, if you deactivate this option.

The maximum value for time to keep indicates how long images and video clips need to be
stored.
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Recording Parameter
Type

Continuous Continually saves video and (optionally) audio data as MxPEG clips.

Recording  Record audio data
Similar to Event Recording, audio data from the camera be recorded with the same quality,
regardless of the frame rate. Set this option to active to activate the microphone.
Frame rate

Recording speed for continuous recording.

Unlimited time to keep

The time to keep is set to unlimited by default. You can select a maximum time to keep,
expressed in hours and days, if you deactivate this option.
The maximum value for time to keep indicates how long images and video clips need to be

stored.

Basic Camera Settings: MxActivitySensor

The MxActivitySensor is a camera-internal video motion detector that can identify direction of motion detec-
tion and object size while blocking out any undesired interference (such as trees swaying in the wind) when
detecting motion. By default, a MOBOTIX camera ships with a predefined MxActivitySensor profile.

You can activate and deactivate this profile in this tab, change the name of the profile, adjust the event dead

time, change the detection range and define new areas.
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Fig. 51: The MxActivitySensor

Active

The MxActivitySensor profile is also activated when the Arming feature is enabled in the general settings.

Profile name

You can change the preset profile name.

Event Dead Time

The event dead time defines a period of time (0-3600 sec.) after an event during which no new events from
the same profile are detected. By defining an event dead time you can avoid, for example, that a complex

action (person walks through the active image area) triggers multiple events. You can adjust the preset event
dead time (5 sec.).
Edit detection area

Proceed as follows to adjust the default detection area or to define additional image areas:

Click on the green detection area in the live image preview.

Action Explanation
Change Position the mouse pointer on one of the white "handles" until the t icon is displayed. Click
shape of

and hold the left mouse button and drag the frame to make the detection area larger or smal-
detection |gf.

area
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Move
detection

area

Rotate
detection
area

Change
shape of
detection

area

Deleting a
Detection
Window

Create a
detection

window

Exclude
area from

analysis

Left-click on the detection area and move it to the desired position.

Click on @ and, while holding the mouse button down, rotate the detection area clockwise or

counterclockwise.

Switch to polygon mode by clicking on @ You will see white corner points on the corners.

Drag the corner points to the desired position. You can insert new corner points by right-clicking
on the white line or in the detection area. Right-click on a dot to delete a corner point. Then
click on

Click on 9

Use the mouse to pull open a new window in an area that is not yet covered by another win-

dow.

Pull open a window of the appropriate size at the position that should be excluded from the ana-
lysis. Click in the window and keep the mouse button depressed until two icons appear. Click on
to determine the exclusion window. The window turns red.

Basic Camera Settings: Network

Your network interface settings determine how the camera can communicate with the “outside” world and

how the camera can be accessed from outside of the local network. When changing parameter values, please

note that the changed values are not automatically applied as in the other tabs of the Configuration view. For

changes to take effect, you must click on ,/ in the Command bar.
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Internal host name

The host name is the unique camera name in the network under which it is accessible.

BOOTP/DHCP

BOOTP and DHCP are protocols with which IP addresses can be managed in a network and automatically

assigned. The camera can use them to automatically obtain its network configuration.
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Parameter

Off

On
client

mode

On
server

mode

Explanation

The camera’s network configuration is manually established. Enter the appropriate information
in the IP address and subnet mask boxes and, if necessary, change the standard route or gate-

way and the DNS server.

IP Address: You can access the camera in the network via its IP address. Ask your network
administrator which IP address is available.

Subnet Mask:: A matching subnet mask needs to be entered for the IP address in order for
computers to be able to communicate in a network. Again, it is your network administrator

who will tell you which subnet mask to use.

Default Gateway:
The gateway acts a relay between individual networks and it coordinates the data traffic
between these networks. Enter the IP address of the gateway that should be used.

DNS Server:

A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if
you want to address computers using their name instead of their IP address for other con-

figurations (FTP, email).

Use BOOTP/DHCP to set the IP address and network configuration automatically. The gateways
and the default route are automatically determined via BOOTP/DHCP and configured.

This camera provides DHCP service to clients on the local network. The IP address of the cam-
era will be 192.168.0.19 with subnet mask 255.255.255.0 by default.

Default Gateway:
Enter the IP address of the gateway that should be used.

DNS Server:

A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email).

Additional IP address

The camera can manage two different network configurations. If you enable this checkbox, the factory

default IP address and the subnet mask will also be used, ensuring that the camera remains accessible at all

times.
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Checking System Security

After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p.
291 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status
based on common best practices. If test criteria are not met, possible measures to protect the cameras are

provided.

NOTE!

The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see
Camera Feature Overview, p. 9.

Verifying Settings for System Security

1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the

Wizards & Extras view.

@ L] MxManagementCenter
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2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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3. Click Secure System. The following criteria are checked:
B Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is
easy for cyber attackers to guess the standard "meinsm" password.

® Enabled Public Access: If Public Access is enabled, a number of different camera functions can be
used without a password.

B Activated HTTP web server: It is possible for data, including user data such as passwords and images,
to be transmitted via the network without encryption when HTTP is used.

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in
which cameras were not checked due to a connection error, for example.

Status Explanation
® Notsecured  There was at least one criterion that was listed as not secure.

7 Softwaretoo  Please check the camera software and update it, if necessary.
old

© Connection Check your network connection to the camera and perform the security check again.
error

@ Not supported The camera (s) cannot be analyzed or secured using the wizard.

@ Secured Camera is secure; no further action is necessary.
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4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed
together with whichever of the three criteria that were fulfilled as well as the measures that need to be

taken to properly secure the cameras:

Criterion

Password

SSL encryp-

tion

Public
Access

Explanation

Changes the password of all user accounts on the cameras that use the standard “meinsm”
password. It also include ONVIF users whose passwords have never been changed.

Enter a new password and confirm it. A suitable password has at least eight characters. It can
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a
password that does not meet these criteria, a red frame appears around the text field. The
frame turns green once you have entered a valid password.

The new password is automatically entered in the MxMC project data.

Disables camera connections via unencrypted HTTP and configures the cameras to accept

HTTPs connections only.
The TCP port and the SSL setting will be automatically updated in the MxMC project data, if

necessary.
The TCP port will not be updated for cameras that are connected via a remote URL. For

remote URL connections, you may need to change port forwarding in the router to the appro-

priate setting.
Please note that different services, such as network messaging etc., will no longer work when

you disable HTTP.

Disables access that does not require password entry to the web interface and the APIs of the

cameras.

5. Click on OK in the dialog box. The selected security measures will be performed. The security status for

the selected camera or camera group will be analyzed once again and the result for each camera is dis-

played.

Import Existing Project

If you have already used MxControlCenter or MxEasy, you can import an existing MxControlCenter.ini file
from the MxControlCenter or the MxEasy.ndb camera list from an MxEasy installation. In both cases, the cam-
eras already integrated in the MxControlCenter (MxCC) or MxEasy are automatically transferred to the

MxManagementCenter with their access data.
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Furthermore, it is possible to quickly integrate a large number of cameras and camera groups into MxMC
using a manually created list in MXU format. You need to adhere to specific rules for the format when creating
the list in order to correctly export the contents of the MXU file.

Importing configurations from MxControlCenter

When importing an MxCC file, the following is taken into account:

® The layouts defined in MxCC are created as groups in MxMC.

® The background layouts from MxCC, including the background graphics and definitions of the camera
symbols, are transferred to the Graphic view of the associated group.

B |f a global password has been assigned, this will be entered for all cameras that do not have a user
name.

® For each hyperlink used, a softbutton is created in MxMC.

® Furthermore, the tree structure from MxCC is shown in the Device bar and file servers configured in
MxCC are created in the MxMC settings.

eC® Willkornmen

MxManagementCenter

Q" 5 +

Geriite hinzufigen Projekt &ffnen Meues Projekt starten

[ 4 4

MxCC importieren MyxEasy importieren MXU importieren

Mobotix » Kalserstrasse D-67722 Langmell « info@mobotix.com » www.mobotix.com

Fig. 52: Importing configurations from MxControlCenter

1. Open the Welcome Wizard from the File > Welcome menu.

2. Click on Import MxCC. Decide if the current project should be saved.
3. Import the desired INI file.
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Importing Configurations From MxEasy
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Fig. 53: Importing Configurations From MxEasy

1. Open the Welcome Wizard from the File > Welcome menu.
2. Click on Import MxEasy. Decide if the current project should be saved.
3. Import the desired NDB file.

Importing MXU Files

Using a manually created list in .MXU format, you can quickly add a large number of cameras and camera
groups. You need to adhere to various formatting rules when creating the list in order to correctly export the

contents of the MXU file (see Creating MXU Files for Imports, p. 117).

CAUTION! This list does not replace the project import, during which program settings, such as settings for

the cameras and camera groups with assigned layouts, are imported.
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1. Click on Import MXU to import cameras and camera groups in the Welcome wizard. You can save the
existing project, if necessary.

2. Open the MXU file.

3. Decide whether the cameras and groups from the MXU file should replace the entire configuration or they
should be only added.

Creating MXU Files for Imports

You can quickly add a large number of cameras and camera groups to the MxMC using an MXU file. There are

several format specifications that need to be followed when generating such an MXU file.

Format for Simple Imports

It needs to adhere to the following format for a simple import of cameras:

® Unformatted UTF-8 text

® One or more camera lines with the following structure:
Name<TAB>IP<TAB>Username<TAB>Password<CR LF/LF>

® Elements in a camera line need to use TABs as separators.

® Line breaks are either CR LF (Windows) or LF (UNIX).

® Comment lines are preceded by a //.

B Camera names need to be unique and cameras using the same name will not be added more than

once.
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Example:

Main Entrance 10.6.37.25
Side Entrance 10.6.15.206
Entrance Gate 10.6.23.132

admin meinsm
admin meinsm
admin meinsm

Format for Advanced Imports

Expanded Format

The file needs to use the following format for the advanced import of cameras, groups, clips and settings for

graphics and grid view:

B First line always #EXTMXU

«,”

B Any additional commands must start with #EXT. Parameters use “:” as separators.
Example: #EXTGROUP:Doorstations

Commands for advanced imports

HEXTMXU

#EXTGROUP:name:f:r:icon:map:info

#EXTGROUP:

#EXTCLIP:clipMXG

H#EXTMXPEG:name:clipMXG

#EXTCURRENTCAMERA:name
#EXTCURRENTGROUP:name

#EXTSUBGROUPS:name

Marker to indicate the beginning of the file

Group “name” is created and all further cameras will be added to this
group.

f: Large focus window (0=0x, 1=1x, 2=2x ...)

r: Tile ratio (0=4:3, 1=HD, 2=8:3)

icon: If numeric, index of the internal group icons; otherwise, file

name corresponding to the *.mxu file.
map: File name of the background image
info: File name of the information page

All further cameras will not be added to a group if no name is spe-
cified (unless “All cameras”).

Camera demo clip is added. Clips need to be stored in the same dir-
ectory as the *.mxu file.

MXPEG clip with “name” is added. This references the absolute path of
the MXG file.

Select camera.
Select group.

The following groups (each with the name in a line) are added to the
group “name” as a subgroup.
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#EXTINFO:Comment Comment line.

#EXTEND End of file, all further lines are ignored.
Example:

NOTE!

To enable SSL, add https:// in front of the camera URLs.

#EXTMXU

// To enable SSL, add "https://" in front of the camera URLs
https://10.3.31.125 admin meinsm
https://10.3.31.126 admin meinsm
#EXTGROUP:Doorstations:2:2:2

Main Entrance 10.6.37.25 admin meinsm
Side Entrance 10.6.15.206 admin meinsm

#EXTGROUP: Indoor:2:2:3

Building East https://10.3.31.251 admin meinsm
Building West https://10.7.25.186 admin meinsm
Staircase https://10.6.115.57 admin meinsm
Canteen https://10.12.32.65 admin meinsm

#EXTGROUP:Outdoor:2:2:4
Parking Visitors 10.5.46.39 admin meinsm

Parking Employees 10.10.231.107 admin meinsm

#EXTGROUP:Dual Cams:2:2:10

Checkoutl 10.10.106.26 admin meinsm
Checkout?2 10.10.152.225 admin meinsm
Checkout3 10.13.242.195 admin meinsm

#EXTGROUP:Faststreams:2:0:11

Ground Floor 10.2.2.169 admin meinsm
Second Floor 10.2.104.130 admin meinsm
Third Floor 10.3.11.51 admin meinsm
Elevator 10.3.209.198 admin meinsm

#EXTGROUP:Clips:2:2:grouplcon.png:groupMap. jpg
#EXTCLIP:FiremanMXG
#EXTCLIP:PoleMXG
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#EXTCURRENTCAMERA:Main Entrance
#EXTCURRENTGROUP:Doorstations

#EXTEND

Backing Up And Exporting

Once the system has been set up to add all the cameras, organize the cameras into groups, create the users,
set their access permissions and verify system security, you should save the settings as a project. Everything
is saved, except for settings that are only relevant for the local installation, such as the Remote Control port.
Secured system settings can be e-mailed directly from the application. You can also include the encrypted
access data for each camera (user name and password). When opening the project in MxMC, these access
data will be used automatically. If you do not supply the access data, the user name and password will have
to be entered manually for each camera.

You can quickly export a tabular overview of all cameras and camera groups from MxMC and save it in MXU
file format. The table lists the cameras with their IP addresses and the camera groups with the associated

cameras.

Furthermore, you can export project data to easily import them in the MOBOTIX LIVE App.

Saving projects

1. Click on in the Header bar. The Projects and Network Environments dialog opens.

2. Click on Save As and complete the dialog.
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Providing projects via email

In the header bar, click on Projects and Environments and then on Email to

. This will generate a

project file which will be transferred to the mail program as an attachment within a new e-mail.

NOTE!
A properly configured email client is required for this purpose.

Export MXU File

You can conveniently add large numbers of cameras, camera groups, devices and recordings/clips in MxMC
using a list in MXU format. To create an MXU file based on the current project data, proceed as follows:

1. Select File > Export MXU... from the Menu bar.
2. Click on Save. The table is saved as an MXU file.

Export project data for MOBOTIX LIVE App

To export project data for the MOBOTIX LIVE App proceed as follows:

1. Optionally select a specific camera group to export.

2. In the menu, select File > Export to MOBOTIX Live.
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3. Click on All Cameras or Selected group.

Export to MOBOTIX LIVE

Select cameras to export.

All cameras Selected group

4. Enter and confirm a password for encryption of the export data and click OK.

Export to MOBOTIX LIVE

Please choose a password for
encryption.

Enter password

Confirm password

Cancel

5. Specify a storage location and save the export file.
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This section is for users. It provides assistance with daily MxMC operation, from monitoring

one or more cameras to searching records.

Areas Topics

Live Surveillance ® Working with the Live view
B Working with the Grid view
® Working with the Graphic view
® Using Door Stations
B Working with multiple monitors

B Working in different network environments

Alarm Processing B Alarm notification
B Setting up alarm notification
B Filtering alarm images

® Playing back alarm recordings

Searching in MxMC B Searching and playing back in the Playback View
B Searching and playing back in the Grid Playback View
B Smart Data System, p. 167
® The Histogram Bar, p. 172
® Post Video Motion Detection (Post VM), p. 176
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B Searching and playing back door events

B Exporting recordings

Live surveillance

The section describes basic scenarios and options of live surveillance.

Working With The Live View

The Live view allows you to control the live images of individual cameras. This also includes switching various

functions, e.g. opening doors or switching lights.

Showing Cameras

@0 e MxManagementCenter

Live - mx10-16-202 114

O

O O e O O O T

8 <> @ N— 0 2 8 90 = | 14.09.2113:50:36

Fig. 54: Showing cameras
To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera
from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed

camera is marked with a yellow bar in the Device bar as well as in the Camera bar.
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Customizing Image Settings
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Fig. 55: Customizing image settings

Use the Brightness@ and Contrast‘ controls to adjust the image display of the displayed camera to the
current environment.

Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

NOTE! Adjusting the image settings does not have any effect on the camera settings. These will not be
changed
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Performing PTZ Actions
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Fig. 56: Performing PTZ actions

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or
panned with the mouse button pressed down. PTZ controls are only available on the MxMC main screen or
on the secondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image

area around (PTZ). To facilitate quick loading of these image sections, several image positions are already
pre-configured for loading using the slider 0

The program also shows the @ slider on Dual cameras. Use this slider to show the live images of either the

right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can configure different display modes (slider @).

Zooming and Moving Image Sections

You can zoom using the slider 0 or the mouse wheel. Zooming with the slider takes place only on the com-
puter. This means that only the image section of the current live image is modified.

To see other image sections, you can move the live image using the mouse.

If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the

PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera

does not record the full image). To use this feature, click on the slider 0 and keep it pressed until it starts
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flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and keep

it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections

Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are

predefined in the camera.

" Preview (), detail €3, overview () and point of interest )
" Top @), bottom @), left @, right @)
The camera will then move to the selected position. Note that the PTZ actions are executed on the camera

and also influence the recordings (only if the camera does not record the full image). Move the @ slider to

the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as
needed. Keep the slider on this position until it flashes once. The new image section has been stored.

Choosing a Sensor

If you want to show the live images of only the right or the left image sensor, you can move the @ slider to

the right to O (left sensor) or further to the right to O (right sensor).

Correcting The Distortion Of Hemispherical Images

When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036,
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In
order to get naturally-looking images, the camera will automatically correct the distortion in these modes.
This distortion correction can be refined even further when using the panorama correction. The selection of a
display mode is always done locally and thus does not influence the camera settings. However, the selection
is also applied to the other program views. When selecting a display mode in the live view for a specific cam-
era, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in the
live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Smart Data

Search View are also shown in the selected display mode.

Selecting The Distortion Correction Mode

= @ Full image: Shows the entire (distorted) full image.

" @ Normal: Shows a distortion-corrected image and allows executing PTZ actions.
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u @ Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to
the right border. The aspect ratio (width to height) is 8:3.

" @ Surround: This option shows four image sections (one for each cardinal direction: N, E,; S, W) in
one joint view. Note that you can use PTZ actions to modify all four views independently from one

another.

" @ Double panorama: This mode shows a panorama view for the North half of the image and a
second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3.
This mode makes sense for a hemispheric camera that is mounted to the ceiling. It can be sub-
sequently customized to use local PTZ.

" @ Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider @ to the right until you reach the desired position. This slider position will
be stored automatically until you change it again.
Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction

allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do so,
move the @ slider to the right to and use the mouse to correct the image. To store the corrected setting,
click on the slider and hold it until the slider icon briefly appears in the center of the image.

Status Display

The Status bar displays different states by means of icons. The status displays always refer to the displayed
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed

again or is still open.
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Fig. 57: Status display

Icons in the Status Display

Door Status Dis- m door is closed.

piay door is open.

E.-‘ door is locked.
. door lock switch is locked, but the door is open!

Light Status Dis- light is off.

play icon is lit: Lights are on, needs to be switched off manually.
Microphone Status microphone is switched off, no announcement possible.
Display microphone is on, announcements are possible.

microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station.

Switching additional devices via Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.
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Fig. 58: Switching additional devices via Softbuttons

To execute a Softbutton, click on to open the Softbutton menu, then click a Softbutton accordingly.
To edit Softbuttons see Softbuttons Settings.

Manually recording live images

In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you
observe a suspicious situation that should be recorded. While you keep track of the situation in the live
image, the images are recorded and saved as a MXG file.

Users with administrator rights can specify where the clips are saved and how long the recordings can be in
the Program Settings (Mac: MxManagementCenter > Preferences > Live Recorder menu, Windows: File >
Settings > Live Recorder menu).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature
Overview.

Audio can only be recorded with the Live Recorder under these conditions:

B Audio transmission must be activated on the camera side.

® In the Live View of MxManagementCenter, the audio connection must be activated by clicking on .
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Fig. 59: Manually recording live images
Starting And Stopping Recordings

To start recording, click on Live Recorder E Recording will stop automatically after the recording time set
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop

the recording from within this message or extend the set period of time. To stop recording before the time

expires, click on E again.

NOTE! If you change the view, the recording is automatically stopped. However, a camera change within
the Live view does not stop the recording.

Play Clip
The live image data is stored in a MXG file at the location specified in Program Settings during recording. The
clip file is automatically imported into the current project when the recording stops and the Device bar shows

it alongside the @ icon in the Clips section. You can click on the clip name to playback the MXG clip file via

the Device bar.

Working With The Grid View

The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-
ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to
you onto the focus window. Use the controls at the bottom to operate the camera.
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Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the
desired group from the Device bar into the display area or click on the desired group in the Group bar. The

displayed group is indicated by a yellow bar in the Device bar as well as in the Group bar.

LR MxManagementCenter

Grid - Treppenhaus
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iii Erdgeschoss

14.09.21 13:50:36

Fig. 60: Showing a group

Working With The Focus Window

At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in
the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.
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Fig. 61: Camera in a focus window

Zooming And Moving Image Sections

Use the slider 0 to zoom. The zoomed image sections can then be moved with the mouse. These actions
take place in the application. This means that only the image section of the current live image is modified.
The camera will not move and therefore zooming will not affect the possible recording of the generated cam-

era image.

1. Drag the slider @ to zoom in on or out of the live image.
2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are

predefined in the camera.

" Overview ), point of interest ), preview (Y and detail view €Y

" Top @), bottom @), left @, right @)

Move the slider Standardo to the next position or until you have found a suitable position.
Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on =
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Opening Doors And Switching Lights
If a camera is connected to a door station and has been configured accordingly, you can open the door by
clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be

turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If an

ExtlO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient temperature

of the module or the box and view it by clicking on E

Executing Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.

To execute a Softbutton, click on to open the Softbutton menu, then click a Softbutton accordingly.
To edit Softbuttons see Softbuttons Settings.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note

that the camera sequencer can also switch cameras automatically.
Instructions:

1. Click on the camera sequencer icon to activate the automatic switching.

2. Right-click on to change the following settings:

® puration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.
B Autostart: Once you switch to the Grid view, the sequencer starts automatically.

B Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate

the situation. To start again, click on .
B Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer

over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be
shown sequentially in the grids focus window for a defined time. You can automate this camera group change

with the group sequencer.
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Instructions:

1. Click on the group sequencer icon to activate the group sequencer.

2. To change the sequencer settings right-click on :

® Duration: set the duration to show each group. You can set a value between 1 sec and 60. The “Com-
bined Sequencer” activates the group sequencer together with the camera sequencer (“Autostart” on
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic
have been cycled before switching to the next group. When the “Combined Sequencer” is active then
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group
sequencer.

B Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions

At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or
open several doors.

In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that

is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 62: Switching group functions

Manually recording live images

In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you
observe a suspicious situation that should be recorded. While you keep track of the situation in the live
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus window
is always recorded. For this reason, live recording can also only be used in the Grid view when there is a focus
window.

Users with administrator rights can specify where the clips are saved and how long the recordings can be in
the Preferences, p. 250 (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu:
File > Settings > Live Recorder).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview, p. 9.
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Fig. 63: Manually recording live images
Starting And Stopping Recordings

To start recording, click on Live Recorder E Recording will stop automatically after the recording time set
in the program settings has expired. Just before this time expires, a message will be displayed. You can stop
the recording from within this message or extend the set period of time. To stop recording before the time

expires, click on E again.

NOTE! The recording ends automatically when switching to another view. However, changing the group
within the Grid view will not result in an early termination of the recording, unless that group has no focus

window. In the latter case, the recording will end.

Play Clip
The live image data is stored in an MXG file at the location specified in Program Settings during recording.
The clip file is automatically imported into the current project when the recording stops and the Device bar

shows it alongside the@ icon in the Clips section. You can click on the clip name to playback the *MXG clip
file via the Device bar.

Working With the Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera,

allowing you to quickly check the situation.

Temporarily showing the live image of a camera

To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addition,
the live image of another camera group can also be displayed in the Graphic view. Drag & drop the desired
camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group

To keep track of all live images in the current group, you can activate the camera sequencer or the group
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after

another in a small window. You can move this window to any location and enlarge it or make it smaller.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note

that the camera sequencer can also switch cameras automatically.

Instructions:

1. Click on the camera sequencer icon &4 to activate the automatic switching.
q g

2. Right-click on to change the following settings:

® Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

B Autostart: Once you switch to the Grid view, the sequencer starts automatically.

B Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate
the situation. To start again, click on .

B Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer

over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be
shown sequentially in the grids focus window for a defined time. You can automate this camera group change

with the group sequencer.
Instructions:

1. Click on the group sequencer icon to activate the group sequencer.

2. To change the sequencer settings right-click on :
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B Duration: set the duration to show each group. You can set a value between 1 sec and 60. The “Com-
bined Sequencer” activates the group sequencer together with the camera sequencer (“Autostart” on
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic
have been cycled before switching to the next group. When the “Combined Sequencer” is active then
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group
sequencer.

B Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions

At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or
open several doors.

In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that
is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 64: Switching group functions
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Operate Door Stations

Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-

tion-specific functions are provided in addition to the program functions for cameras.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that

provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see:

B Camera Feature Overview, p. 9.
® Door Station Settings, p. 209

Bell Signaling

If someone rings the doorbell, it can be indicated in different places of the application.
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Where?

Alarm bar
and Alarm

Info bar

Explanation

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar @ is located at the bottom of the MxManagementCenter and
the Alarm Info bar @ below the camera image of the corresponding door camera.
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Where? Explanation

Doorbell When the bell is rung, a ringing notification is displayed, no matter which view you are in. The

notification prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification E was not deactivated in the header.

[ ] [ ] MxManagementCenter

O O T L LN N R R T

.............................................

NOTE!
The notification can be temporarily disabled by an administrator by clicking on Notification

@ in the application header.
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Where? Explanation

Counteron  The counter next to the bell icon in the Live view is increased by one.

the bell icon

[ ] [ ] MxManagementCenter

Live - Foyer
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Setting Bell Signaling

Go to Door Station Settings, p. 209 to find out which signaling options can be combined and where they can
be configured.

Open Door and Switch Lights

If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To

do this, use the and keys in the Live view Command bar and in the Command bar of the Grid view
focus box.

Working With Multiple Monitors

MxManagementCenter supports the use of multiple monitors. Camera live images can be displayed on mon-
itors directly connected to the computer running MxMC. Camera live images can also be switched to addi-
tional display devices using an MxThinClient.

Displaying Live Images On Monitors Connected To The Computer

If several monitors are connected to the computer running MxMC, the live images of individual cameras can

be displayed by double-clicking on the different monitors. To do so, double-click either:
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® on a cameraimage in the Camera bar

® on an eventimage in the Alarm bar

® on a cameraimage in the Grid view

® oron acamera icon in the Graphic view

and select the monitor on which you want to view the live image.
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Fig. 65: Displaying Live Images On Monitors Connected To The Computer

Using MxThinClient To Display Live Images On Additional Monitors

As far as MxMC is concerned, any number of monitors can be connected and operated. However, the number
is limited by the graphics card installed in the computer. By using one or more MxThinClient devices, you can
increase the number of display devices available for MxMC. This allows you, for example, to switch to addi-
tional display devices (monitors or TV sets) by double-clicking on the camera live images from MxMC.

NOTE! MxThinClient devices are not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera

Feature Overview, p. 9.
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Adding a MxThinClient

1.

Hinzuflgen

The MxMessageSystem needs to be activated in the Preferences, p. 250 because the camera live images
are connected via this system (Mac: MxManagementCenter > Settings > MxMessageSystem; Windows:
File > Settings > MxMessageSystem). Also, make sure that the same parameters are set as in the MxTh-

inClient.
Furthermore, you must make sure that MxThinClient and the computer running MxMC use the same time

server.
Open the edit mode in the Device bar by clickingon  at the bottom of the bar. Next, clickon . The

Add and Import dialog opens.
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Fig. 66: Adding a MxThinClient

Clickon . The MxThinClient Configuration dialog box opens.

Enter a name for the MxThinClient that will be shown in the Device bar. You can freely select the name.
Use the URL option to enter the current IP address or DNS domain name.

Under Serial Number you need to enter the factory IP address printed on the MxThinClient housing.
Remember that you need to enter the number correctly because it represents the address at which the

o v AW

MxThinClient is accessed in the MxMessageSystem.

Enter the user name and password you used when installing the MxThinClient.
8. Select the resolution that the camera's live image uses when data is sent to the additional display unit. If

you select a resolution that is not supported by the display device, the message Resolution Not Sup-

ported is shown on the display of the display device. In this case, select a lower display resolution.
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9. Select how long the live camera image will be displayed before the MxThinClient will continue to run in
the configured mode.

If you select Unlimited for the display length, the camera's live image is displayed until the MxThinClient
receives a new command, such as when an event is triggered based on an event-controlled setting.

If you want to stop the display of the camera’s live image before the set display length elapses, click on
the (=) icon. It appears when you move the mouse pointer over the name of the MxThinClient in the
Device bar.

10. Close the dialog box. Then deactivate the edit mode of the device bar by clicking on

Using MxThinClient

To switch a live camera image to an additional display device, either double-click on the desired camera
image or drag and drop the camera image to the appropriate MxThinClient in the MxThinClient section of the
Device bar.

NOTE! The MxThinClient section is only visible in the Device bar if a MxThinClient has been integrated.
You need to possess administrator rights to add, manage or delete an MxThinClient.

Working In Different Network Environments

Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS
access over the Internet.

See also: Network Environments

Selecting an Environment

If you want to access the cameras from a different location (different network), select the corresponding pre-
viously created environment. Switching to a different environment causes the network address data for con-
necting to the cameras to be switched automatically.
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Fig. 67: Selecting an Environment

1. Right-click on in the Header bar. The Projects and Network Environments dialog opens.
2. Click on Environment.
3. Select the desired environment.

Temporarily Adjusting the Bandwidth

By assigning a bandwidth to an environment, you can specify how the images are pulled from the cameras
given different connection speeds. This basically controls how the images can be displayed for live viewing
and event research. Selecting a bandwidth thus also controls the image quality. Note that you can tem-

porarily overwrite the bandwidth setting without actually changing the camera setting.

1. Clickon in the Header bar. The Bandwidth Mode dialog opens.
2. Select the desired setting:
" HiRes: The images are transferred using the settings made in the camera.

" LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Pro-

gram Settings for LoRes.

. Unchanged: Use this to return to the original setting of the camera.
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Alarm Processing

An important component of a video management system is the alarm function. It allows you to specify which
events lead to alarms and how you are notified in the event of an alarm. In addition, you can define the alert-

ing behavior for individual time periods in weekly profiles.

NOTE! Alarm processing functions are not supported by MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-

era Feature Overview.

Alarm Notification

Alarm-triggering events can be signaled at various points in the application.

Where? Explanation

Alarm bar  If alarm notification has been activated in the Camera Configuration, the Alarm and Alarm
and Alarm  Info bars will turn red and will inform you about the events that triggered the alert (green
Info bar when a bell is rung). The Alarm bar @ is located at the bottom of the MxManagementCenter

and the Alarm Info bar @ below the camera image of the corresponding camera.
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Alarm Noti- In addition, you can choose to receive an alarm message and an alarm sound.

fication This requires the alarm notification option to be enabled in the Camera Configuration dialog
and the Alarms checkbox to be set in the Notifications section (Mac:
MxManagementCenter > Settings menu, Windows: File > Settings ) menu.
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Camera icon When a camera detects an alarm, the corresponding camera icon turns red @ or green (bell

and group  event). You can take a quick glance at the situation observed by the camera by showing a

icon inthe small live image (move mouse pointer over the icon) or by showing a live image on a second

Graphic monitor, if available (double-click on the camera icon).

view If you positioned an additional camera group on the background image (floor plan), the cam-
era group turns red @ or green when a camera in this camera group registers an alarm-trig-

gering event.

e MxManagementCenter
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Setting Up Alarm Notification

The following table describes where and how the notification options can be set.
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Notifications Settings

Alarm bar, For an alarm to be signaled in the Alarm bar and the Alarm Info bar, you must activate alarm
Alarm Info notification for each camera and select the events that will trigger an alarm.
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24 Stunden

24 Stunden

» Hi Parkplatz Bandbraite 24 Stunden

v i Treppenhaus Bandbreitensinstellungen > @ PIR-Sensor 24 Stnden

s mx10-38-11 Aufzeichnungseinstellungen Oateiserver > | @ roroorae 3% Stocider

An >

@ interne Ereignisse 24 Stunden

@) Meta-Ereignisse 24 Stunden
@ signalereignisse
© zsitercignisse

@ «iingein

©) Mailbox-Nachrichten
(@ Trstation

@ R0 zurickgewiesen

©) PN zurickgewiesen

£ Anderes

24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden

24 Stunden

v
v
v
v
v
v
v
v
v
@ Nachrichtenereignisse (v | 24 Stunden
v
v
v
v
v
v
v
v
v

o lo oo o oo o oo oo lole oo o lole

24 Stunden
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16.10.18 15:42:47

1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.

Optionally open the dialog box in the Device bar by clicking on and then right-click-
ing on the corresponding camera.

2. Click on Alarms, enable alarm notification and set the events that should trigger an
alarm.
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Alarm Noti-  In addition to signaling in the Alarm bar and Alarm Info bar, you can set up a visual and aud-
fication ible alert. Do so by navigating to the notifications (Mac: MxManagementCenter > Settings
menu, Windows: File > Settings menu), selecting the Alarms option and then selecting the

alarm sound, alarm duration and volume.

o0 Einstellungen
Allgemein Alarme
Netzwerk
Software-Update Alarmbenachrichtigungen: = Disabled
Benachrichtigungen
o Alarmton: =
Uberwachung rmion:H{ Alarm
Audio Dauer: -+
Datenmenge D R A A A R R S A R S
Caches 3s 1 min
s o
f:hnappschuss Bilder Lautstirke: q
Live-Recorder | U
Aufzeichnungspfade 0 100
Fernsteuerung
ke Aktivieren, um bei einem Kamera-Alarm eine Machricht zu erhalten. Sie kinnen Melodie, Daver und

Joystick-PTZ Lautstérke des Alarmtens einstellen.
MxMessageSystem
Retailsystem Kiingel

Klingelton:  Alarm

Lautstarke:

...........
a 100
Legt den Ton der Tarklingel fest.
Voreinstellungen Anwenden Abbrechen m

Cameraicon In order for the camera icon and group icon to turn red or green in the Graphics view when
and group an alarm event occurs, the same settings must be made as for notification in the Alarm bar
icon in the and Alarm Info bar.

Graphic view
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Setting time
ranges for

alarms

Kameragruppen

» Hi Alle Kameras

» W Parkplatz

* I Treppenhaus
£

MxManagementCenter

Kamerakonfiguration
Name Foyer
Verbindungsprotokoll  MOBOTIX
URL
Remote-URL
Benutzername
Passwort
Umgebung
Standard Zuhause

Hintergrundalarmierung

Bandbreitensinstellungen
Aufzeichnungseinstellungen

| Alarme

Signalisierung von Alarmen
Aktiv

Alarmibersicht
Alarm
& MuactivitySensor
€ videomotion
(@) Verhakensdetektion

& Erschitterungssensor
€ Beleuchtung
@ € Miroton

> N @ Pr-sensor

@ Interne Eraignisse

@ Nochrichtenereignisse [

@) weta-Ereignisse
@ signalercignisse
© zeitereignisse

@ wingein

© Mailbox-Nachrichten
(@ Torstation

@ RFID z2uriickgewiesen

Wochenprofil Invertioren
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden
24 Stunden

24 Stunden

v 24 Stunden

24 Stunden

24 Stunden

4| 24 Stunden

24 Stunden
24 Stunden

24 Stunden

‘Wochenprofile bearbeiten...

18.10.18 15:42:47

In addition, you can select a weekly profile for every event type that should trigger an alarm.

1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-

responding camera in the Camera bar.

Another option is to open the dialog box in the Device bar by clicking on and then

right-clicking on the corresponding camera.

Make sure that the Alarms option has been activated.

As long as no other weekly profile has been selected, the setting is valid from Monday
00:00 to Sunday 24:00.
4. Click on Edit weekly profiles to create a weekly profile for an event type. See also Set-

ting Alarm Filters for information on how to create and select a weekly profile.

Filtering Alarm Images

All Alarm images are displayed in the Alarm bar and in the Smart Data Search View. To get a quick overview,

you can filter the display of images according to different criteria.

Filtering Alarm Images In The Alarm Bar ("Filtering The Display Of Alarm Images" section):

The alarm images in the Alarm bar are sorted chronologically. You can filter the display of alarm images by

camera, group, event type, and confirmation status.

Filtering the Smart Data Search View by event types:

All event images of the selected cameras are shown in chronological order. You can filter the view according

to event types.

152 / 346



Using The Application
Researching in MxMC

Playing Back Alarm Recordings

You can play the recording of an alarm directly in the Alarm bar ("Playing Back Recordings" section) or dir-
ectly in The Smart Data Search View, p. 60.

Researching in MxMC

This section describes basic research functions of MxMC.

Searching And Playing Back In Playback View

Recorded clips cannot only be played in the player, but they can also be searched. The way that you search
depends on whether you want to search for specific events within the recorded clips or whether you want to
search for events at specific times.

General Playback View controls

‘ene MxManagementCenter

O Playback - mx10-12-225

Kameragruppen

» I Alle Kameras

P Piayback-Modus
Normale Wiedergabe

9-30 e Vollsténdige Aufzeichnungen /

* i Treppenhaus Ersignisaufzaichnung
& mx10-12-225-173

Bs mx10-38-112-21

Bildwiedergabe

v W EG Ereignish‘nlder
& mx10-12-225-173 Voralarmbilder

Markierte Bilder
Zeitraffer-Wiedergabe

1TBg

Fig. 68: General playback view controls

To search and play back recordings, first activate Playback mode or select the date and time and then

use the Previous/Next Image buttons m, to browse the recordings; alternatively, you can start the
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playback using the Forward/Backward Playback buttons [RGB Hold the Forward/Backward Playback to
select a playback speed between 0.5 times and maximum.

General operation of the Playback View for MOBOTIX MOVE and ONVIF-
S/G cameras

‘00 ® MxManagementCenter

Playback - mx10-12-225

Hs mx10-38-12-21

Kameragruppen a v

& mx10-12-225-173

0-10-49-30
inClient-Geréite

= Client

Clips & Aufzeichnungel (33 v

.............................................................................................................................

Fig. 69: General operation of the Playback View for MOBOTIX MOVE and ONVIF-S/G cameras

NOTE! All playback capabilities are supported by MOBOTIX MOVE cameras and third-party cameras that

provide an ONVIF-S-compatible interface. For these cameras, recordings can only be played forward.

Therefore, first select Date/Time @ , and then start playback using Forward Playback E @.
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Performing PTZ actions in recordings

‘ene MxManagementCenter

Playback - mx10-12-225

& mx10-12-225-173
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Kameragruppen & v

» I Alle Kameras
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Fig. 70: Performing PTZ actions in recordings

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or
panned with the mouse button pressed down. PTZ controls are only available on the MXMC main screen or

on the secondary monitor in Grid View.

You can zoom and move the visible image area not only in live images but also in recorded images (PTZ). This

enables you to examine specific image areas more closely while the recorded video stream is playing back.

On Dual cameras, the program also shows the @ slider. Use this slider to show the images of either the right,

the left or both image sensors. When playing back the recordings of hemispheric cameras, you can set dif-

ferent display modes (@).

Zooming and moving image sections

You can zoom using the slider 0 or the mouse wheel. To see other image areas, you can move the recorded

image using the mouse.

Choosing a sensor

On Dual cameras, you can opt to see the recordings of the right, the left or both image sensors. To do so,

move the ) slider to the right to () (left sensor) or further to the right to ) (right sensor).
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Subsequent distortion correction of hemispherical images

When showing recorded images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036,
L25/B041, you can select different display modes. In order to get naturally-looking images, the camera will
automatically correct the distortion in these modes. This distortion correction can be refined even further
when using the panorama correction. Note that this type of correction only takes place locally. This means
that the distortion correction of the recorded images only takes place on this computer. The stored record-

ings (from the camera or a file server) are not influenced in any way.

- @ Full image: Shows the entire (distorted) full image.
" @ Normal: Shows a distortion-corrected image and allows executing PTZ actions.

- @ Panorama: This option shows the distortion-corrected image of an entire room (corrected 180°
panorama view) from the left to the right wall. The aspect ratio (width to height) is 8:3.

u @ Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in
one joint view. Note that you can use PTZ actions to modify all four views independently from one

another.

" @ Double panorama: This mode shows a panorama view for the North half of the image and a
second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3.
This mode only makes sense for a hemispheric camera that is mounted to the ceiling.

" @ Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

Selecting The Distortion Correction Mode

Move the slider @ to the right until you see the desired view. This slider position will be stored automatically

until you change it again.

Panorama Correction
The distortion-corrected images of the different display modes can be further refined using the panorama cor-
rection. Move the (@) slider to the right to (@) and use the mouse to correct the image. To store the corrected

setting, click on the slider and hold it until the slider icon briefly appears in the center of the image.

Browsing recordings for event images
When searching for event images, first select the image playback type:
B Event images: Only shows event images.

B Pre-event images: Shows only the first recorded image for each event.

B Highlighted images: Shows only the images, which had been marked as important before.

156 / 346



Using The Application
Researching in MxMC

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.
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Fig. 71: Browsing recordings for event images

1. In the Playback view, select the Playback mode by right-clicking on ® and selecting the desired mode
Q.
2. Browse the recordings using the and m buttons. Starting with the current event image, these but-

tons show the previous or next event image.

Browsing recordings for a specific date and time

If you have set up a continuous recording for certain times and you want to check for events during those
times, for example, you can limit the search to these times. You can search for events at a given time by using

time leaps or time-lapse playback.
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Searching for a specific date and time

‘aD @ MxManagementCenter

Playback — Parkplatz

Fig. 72: Searching for a specific date and time

1. Click on Date/Time ® and enter the date and time to search for.

2. The event image jumps to the event in the recordings that is closest to the specified date and time.
3. Click on Playback E

or

1. Click on the Calendar slider @ . The date and time will be shown above the slider.

2. Move the slider until you reach the date and time that is closest to the point in time you want to examine.
The event image jumps to the event in the recordings with the specified date and time. If such a record-
ing is not available, the event image jumps to the event that is closest to the specified point in time (in
the direction of searching). In the latter case, the slider turns read the time difference to the specified

point in time is shown above the slider.

3. Click on Playback

NOTE! The farther away you move the mouse pointer from the slider, the more precise your setting will be.

Searching Several Cameras For Persons Or Objects
Scenario: Camera A is overlooking the gate and signals an event. The event image in the Alarm bar shows a
delivery truck driving through the gate. You want to know if the truck has also passed the area monitored by

camera B.
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1. To do so, move the mouse pointer over the event image. Three icons are shown.

2. Open the Playback view mode by clicking on E
3. Play back the recording (end of recording) © .

‘a0 e® MxManagementCenter

Playback — Parkplatz

Fig. 73: Playback the recording

4. Drag&drop camera B from the camera bar into the Playback view.
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5. The playback automatically selects the recording that follows the end of camera A's recording @ . You
can continue this process for any number of cameras.

Investigating Multiple Cameras For A Specific Point In Time

You want to know if other cameras have recorded something at a specific point in time:
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Al

Do. 26.02.15 08:26:03 -00:03:57 h

26.02.15 08:30:00

1. Set the reference time using the Pin button @ .

2. Drag the cameras from the Camera bar @ one by one.
3. The application shows the event images of each camera that are closest to the specified point in time.

Limiting The Search Range For An Incident

Scenario: Your camera monitors a parking lot from which a car had been stolen during the day. Follow these
steps to locate the event as quickly as possible:

1. Start the Playback mode (right-click on ) and select an interval (e.g., 1 day ).

2. Keep clicking on Previous Imagem until the car can be seen again in the image.
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3. Now select a shorter interval (e.g., 1 hour ).

4. Keep clicking on Next Imagem until the car has left the frame.
5. Keep on using shorter intervals until you have found the exact point in time of the incident.

NOTE! You can also use the Forward/Backward Playback m buttons to play back using the same
time leaps.
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NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.

Playing Back Recordings

Playing Clips

To play the clips, the play buttons EXIRAEQ@EEME] and the playback mode are available in the Command bar
of the Playback view. First set the desired mode for playing the recordings, such as event images only or with
one hour time-lapse, in the Playback mode.

Next, use the Playback Buttons to browse and play back the images one-by-one or continuously EI
E in backward or forward direction.

NOTE! As mentioned in General Operation Of The Playback View For MOBOTIX MOVE And ONVIF Cameras,
playback of recordings is limited when using MOBOTIX MOVE cameras and third-party cameras that provide

an ONVIF S-compatible interface. Recordings of these cameras can only be played forward. For an overview

of how the camera functions differ, see Camera Feature Overview.
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The following table summarizes the actions that you can perform with the playback buttons, depending on

the playback mode:
Playback Mode

Complete Record-

ings

Event Recording

Event Images
Pre-alarm Images

Highlighted Images
1 day time lapse

1 hour time lapse
10 minute time
lapse

1-minute time

lapses

MxManagementCenter

Playback - mx10-12-225

P Playback-Modus
Normale Wiedergabe
Vollstdndige Aufzeichnungen /
Ereignisaufzeichnung
Bildwiedergabe
5 Ereignisbiider
Voralarmbilder

Markierte Bilder

Zeitraffer-Wiedergabe
G 1 7e0

E 1 Stunde

[CH 10 Minuten

.............................................................................................

Playback Buttons
Jumps one image backward/forward.
m Plays back all recordings backward/forward.

m Jumps to the end/the start of the recorded sequence.
m Plays back until the start/the end of the recorded sequence has been

reached.

m Shows the previous/next image every time you click on the button.

E The previous/next images are shown automatically one after the other.
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Setting The Playback Speed
The Playback Speed option @ allows you to speed up or slow down the playback of a recording. This also

applies if you play back a recording backward.
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1. Click on Playback Speed. The background of the button turns dark gray.

2. To play the recording forward, left-click and hold the left mouse button and move the mouse pointer to
the right. The further you move the mouse pointer down (to the right), the faster the playback speed.

3. To play the recording backward, left-click and hold the left mouse button and move the mouse pointer to

the left. Again, the further you move the mouse pointer down (to the left), the faster the playback speed.

Precise Positioning by Image
If you want to examine a scene very closely, you can view the recordings one image at a time. To do so, stop

playback (click on E or E). Now use the two buttons m (forward) and (backward) to navigate the
images one by one.

Searching And Playing Back In The Grid Playback

If a camera registers an event and you want to know if and what other cameras in that camera group were

recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously.
The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera to
find events or specific situations or if you are playing back recordings, the other cameras will follow the lead-

ing camera as soon as playback is paused. The program always shows the event images that are closest to
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the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the
difference will be displayed at the lower border of the event images.
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Fig. 74: Grid Playback

1. Open Grid Playback by right-clicking on the Navigation button and selecting Grid Playback.
2. Drag the desired camera group from the group bar.
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3. Use the time stamp in the focus window @ or the calendar slider @ to set the time.
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4. All cameras jump to the event image that is closest to the specified point in time. The time stamp
beneath each camera image shows the time and date of the image. The difference to the reference time

is shown at the right.

NOTE! You can also use the Grid Playback by dragging a group onto the Playback view. The original cam-
era will be shown in the focus window.

Smart Data System

With the MOBOTIX Smart Data System, transactions in MxMC can be linked to the video recordings made at
the time of the transactions. Use the Smart Data Search to search all recorded events and related images. You
can filter the results by all kinds of events. You can reduce the results to the events you have marked as
"important". The search results are displayed as list and/or as preview images including camera name, time
stamp and type of event trigger. You can play back the recording to an event directly from the event image.
From the Smart Data Search View you can easily access the Playback View or the Export View (see Searching
in the Smart Data Search View, p. 167).

NOTE! In order to use the MOBOTIX Smart Data System for third party systems - e.g. cash point systems,
you must purchase a Smart Data License. No license is required for P7 IoT App data. The MOBOTIX loT App
Interface is integrated into MxMC by default.

NOTE! The Smart Data Search View is not available for MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-

era Feature Overview, p. 9.

Searching in the Smart Data Search View

With the MOBOTIX Smart Data System, transaction data can be linked to the video recordings made at the
time of the transactions. Smart Data source can be e.g. MOBOTIX P7 Apps (no license required) or general
Smart Data sources (license required) like POS systems or license plate recognition systems.

The Smart Data System enables you to quickly find and review any suspicious activities. The Smart Data Bar
and the The Smart Data Search View, p. 60 are available for searching and analyzing transactions. The Smart
Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and for this

reason it is convenient to use it for reviews and searches.

Smart Data Sources can be added and configured in The Components View, p. 61.

NOTE! The Smart Data Search is not available for MOBOTIX MOVE and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview, p. 9.
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Opening the Smart Data Bar

The Smart Data Bar is available in all views. To open the Smart Data Bar, click on the right frame border of
the application. The Alarm Bar will appear. Click on the frame border again to switch to the Smart Data Bar.
You can also open it from the menu (View > Smart Data Bar).

‘ene MxManagementCenter

Playback - Eisdiele 7 C @

Bon #465
Bediener #2 / 30
2x Cola 0,5 8,00 €
Limonade 0,5 4,00 €
Tafelwasser .. 3,00 €
4,00 €
19,00 €
Gesamtbetrag 19,00 €
[Rechnung #392
Bediener #2 / 30
Tisch #39 geoeffnet
2x Zwiebels.. 11,00 €
2x Tomatens.. 11,00 €
Cola 0,5 4,00 €
Kameragruppen & v | L : - £ Limonade 0,5 4,00 €
| - 2 - Tafelwasser .. 3,00 €
1 Alle Kameras | ; f | 5 o Tisch #39 geschlos..
E Bon #467

Hi Torstationen
Bediener #2 / 30

»
»

» §i Parkplatz F = . Tisch #39 geoeffnet
= 4 > : : " 50,00 €

1 Treppenhaus
17,00 €

MxThinClients \ b — .m;] €
(=NY lient hung #3v3
Bediener #2
Tisch #8 geoeffnet
par 13,60 €
Gesamtbetrag 13,60 €

. 05.10.17 13:28:54 Rechnung #394

Bediener #2

Eisdiele i Biergarten

,1 Kino

........................................................................................................................................

Fig. 75: Smart Data view

The Smart Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and

for this reason it is convenient to use it for reviews and searches.

Using the Smart Data Bar

If a Smart Data Source, e.g. a cashpoint is transmitting new data to the camera, the Smart Data Bar is auto-
matically updated. It enables live surveillance of the cash point and of the retail data of a camera. You can
group transactions that belong together and display them.

® Displayed time range: The Smart Data Bar only contains the data from the last 24 hours. To search
data that is older than 24 hours see Defining Search Filters, p. 169.

B Search feature / Filter feature: You can filter the entries for each cash point’s camera by search term.
The hits are highlighted in yellow. You can jump to the next/previous search result using the two

arrows on the lower edge.
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® Do not show system transactions: By default, the Smart Data Bar shows all transaction that are
stored on the corresponding camera. Some of the transactions, e.g. from a cash point, show purchases
and events that are directly associated with the purchases, such as the “Total sum.” Other trans-
actions show only administrative events, such as when the cashier logs on. Click on E to enable/dis-
able display of system transactions.

® Do not group receipts (for VECTRON cashpoints only): Transactions are grouped by receipt number
or purchase by default. Individual sales can be grouped if the cash point signals the conclusion of the
transactions by creating a receipt number. Counter sales can be grouped by counter if the counter is
settled in the cash point system. Click on [g] to disable display by groups. The data will be reloaded.

B Playback transactions: Open the Playback view by double-clicking on a transaction line. The trans-
action will be played back.

Detailed search and analysis in the Smart Data View

In the Smart Data View you can search and filter data of one or more Smart Data sources.

Fig. 76: Searching in Smart Data View

Defining Search Filters

You can define and store several search filters. The search query will be automatically saved every time the

search criteria are changed.

Open the Smart Data Search View e. g via Menu View.
Click on the name @ of the Search to change it.
Select the desired Smart Data Source @ .

Hw e

Specify the period of time for the search @ . You can also enter a period of time that allows you to enter

any start and end time stamp, in addition to a series of preset time windows (including “today”).
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5. To add another filter criteria click on BH® .
The criteria can be linked using that all or one filter criteria must match.

B Select ﬂ to define that all criteria must match
B Select n to define that one of the defined criteria must match

6. Click on lmll to delete a search criterion.

7. To define additional search queries click on ® and repeat steps 1-5.
8. Click on Search ® to perform a search.

Deleting Search Filters

Click on E to delete a filter.

Displaying Search Results
The search results are displayed with preview images in a list with detailed data or in tiles, depending on the

selected display option from the Command Bar @ (List View or Tile View ).

Switching to Post Video Motion Detection

To switch Post Video Motion Detection from the Command Bar click the button @)

Playing Back Events

Instant Playback:

In the Tile View you can watch the recording of an event directly in the event image (instant playback). To

do so, move the mouse pointer over the image. Three icons appear. Click on @ to start the playback.

NOTE! A click into the image after starting the playback opens the recording in full screen mode in the cur-

rent program window.

Playback View:
You can also play back the recording in the Playback view. To do so, move the mouse pointer over the event

image. Click on to switch to the Playback view.

Marking Events

When browsing event images in Tile View , you can right-click on an image to mark the event as "import-

ant." The same applies to events that you have marked as "important" m in the Playback view or in the

Alarm bar: You can view them as a collection in the Smart Data Search View.
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Error Handling

An exclamation mark @ is displayed in the results list bar. If it is red, errors have occurred. Clicking on the
exclamation mark opens a window in which the respective cameras and the associated errors are listed. Dis-

played errors are:

B general communication error

® software version too old

® camera model is not supported
® camera is not reachable

sarch =+

Fiter

oty

Event Definition Id

Fig. 77: Smart Data Search error handling

Exporting Search Results as CSV file

For example, for further research with external applications or archiving Smart Data Search Results can be

exported as CSV file.
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Fig. 78: Exporting Smart Data Search Results

1. Click the export icon @ .
2. If necessary, change the file name and the export directory.
3. Click Save.

The Histogram Bar

The histogram illustrates the distribution of event frequency and thus provides a quick overview of the

events of one or more cameras.
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Fig. 79: The Histogram Bar

The Histogram Bar shows events of the selected source and selected time range.

NOTE! The range of logged events may reach farther back than the recordings.

Opening The Histogram Bar

To open the Histogram bar, select Menu View - Histogram Bar or drag the blue ribbon on the bottom mar-
gin of MxMC upwards. To begin with, the histogram always shows the entire range of the events logged by the

camera.

Working With The Histogram

08:15 06:30 06:45 07:00 0715 O07:30 0745 0800 08:15 08:30 0845 09:00 0915 0930 0%45 10:00 10115 10:30 10:45 11200 1145 1130 1145 12200 12115 12:30 1245 1300 13115 1330
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Fig. 80: Histogram bar in detail
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Histogram elements

@: ﬂ Resolution of zoomed area (high / low), set zoom range of histogram, event filter selection.
@ : Event area
® : Time range and selected camera / group

@ : Selected event

Refined view on event frequency

Click ﬂ to switch to a refined resolution of the zoomed area in more detail.

The length of the bars indicates the frequency of logged events per time unit. The display switches to a higher

resolution.

For more detailed information on a specific point in time, click on the related spot in the zoomed area or the
overview area. If you move the mouse point over an event, a tool tip shows more information.

In the Playback view, a red marker is also displayed to indicate the current position.

Displayed Time Range

Click to set the displayed time range (e. g. one day or six months). To define a custom time-range scroll

the mouse-wheel on the Histogram Bar.

In the playback you can click on an event to jump to its/nearest recording.

Event Filters

Click to select an event filter.
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select event filter
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These events can be selected:

B MxActivitySensor Events

B Video Motion Events

B Behavioral Detection Events
® Shock Detector Events

® |llumination Events

® Microphone Events

B Passive Infrared Detector Events
® Temperature Events

® |nternal Events

B Message Events

® Meta Events

® Signal Events

® Time Events

® Ringing Events

® Mailbox Messages Events

® Door Station Events

B RFID Rejected Events

B Pin Rejected Events

® Thermal Events

B All event types (default)

Searching With Post Video Motion Detection (Post VM)

Post Video Motion Detection allows searching recordings for changes in one or more image areas of a camera.
The function is integrated as a smart search option. A legacy version function is also available.

B Post Video Motion Detection (Post VM), p. 176
B Post Video Motion Detection (Post VM) -legacy, p. 180

Post Video Motion Detection (Post VM)

The post video motion detection allows searching recordings for changes in one or more image areas of a

camera. This is done with the help of “motion windows.”
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Fig. 81: Integrated Post Video Motion Detection

Opening Post Video Motion Detection

Smart Data Search - 10.8.80.156
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1. Open the Smart Data Search View e. g. via Menu View.

2. In the Command Bar click the button [@] @ .
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Creating motion windows
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Fig. 82: Creating motion windows

1. Clickon ® in the top right of the image area on the right-hand side of the settings dialog. The image
of the selected camera with a predefined video motion window ® shows up.

2. You can execute the following commands:
B Modify the size of the video motion window: By moving the sides or the corners of the window.

B Create additional video motion windows: Draw a new window with the mouse.
® Duplicate a video motion window: Click on @

® Delete a video motion window: Click on @

® Deactivate a video motion window: Click on .

3. To close the editor window, click on ® in the top right corner of the window.

Setting the trigger conditions

The Post VM window provides options for setting different parameters that influence the motion detection
results.
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Fig. 83: Setting the trigger conditions

Trigger level: (White bar in diagram ® )

Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize a
movement if only a few pixels change from one image to the next. Move the bar to the top to recognize
a movement only if many pixels change.

O sensitivity: ®

This setting controls how large the change of each pixel in a video motion window must be to count as
movement. Together with a low threshold value, this setting can be used to fine-tune video motion
detection. If you move the slider to the right, the detection sensitivity increases, i.e., even smaller

changes will trigger the detection.

Correct Changes in Illumination: @

Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for
example, from sun to a cloudy sky).

@ Deadtime:

This sets the amount of time after the last detected post video motion event, during which pixel
changes in a video motion window are ignored.

@ Median Value: ®

Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.

Setting a value that is too high can lead to smears in the preview window.

N Color Filter:
Select a color to limit the motion detection to a specific range or colors. The Post VM event will trigger
if this color changes during post video motion detection.
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Searching for changes in Video Motion Windows

G a-
= TJ %r

i

Once you have defined the video motion windows and have set the trigger conditions, you can search the

recordings for changes in the video motion windows.

1. Click on Search @ .

NOTE! While search is running the "search" button becoms to a "cancel" button to stop/cancel the
search.

2. Click on a search result image @ to show a preview image in the upper right corner ®@ .

Post Video Motion Detection (Post VM) -legacy

The post video motion detection allows searching recordings for changes in one or more image areas of a
camera. This is done with the help of “motion windows.”

Creating motion windows

1. Open the context menu of the plug in by right-clicking on f¥. Select Post Video Motion detection. The
dialog for setting up the post VM settings opens.
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Fig. 84: Creating motion windows

2. Clickon in the image area on the right-hand side of the settings dialog. A new window with a pre-
defined video motion window opens.

3. You can execute the following commands:
B Modify the size of the video motion window: By moving the sides or the corners of the window.

B Create additional video motion windows: Draw a new window with the mouse.
® Duplicate a video motion window: Click on @

® Delete a video motion window: Click on Q

® Deactivate a video motion window: Click on .

To close the editor window, click on in the top right corner of the window.

Setting the trigger conditions

The Post VM window provides options for setting different parameters that influence the motion detection

results.
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Fig. 85: Setting the trigger conditions

Trigger level: (White bar in diagram)

Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize a
movement if only a few pixels change from one image to the next. Move the bar to the top to recognize
a movement only if many pixels change.

sensitivity:

This setting controls how large the change of each pixel in a video motion window must be to count as
movement. Together with a low threshold value, this setting can be used to fine-tune video motion
detection. If you move the slider to the right, the detection sensitivity increases, i.e., even smaller
changes will trigger the detection.

Correct Changes in Illumination:

Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for
example, from sun to a cloudy sky).

@ Deadtime:

This sets the amount of time after the last detected post video motion event, during which pixel
changes in a video motion window are ignored.

@Median Value:

Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.

Note: Setting a value that is too high can lead to smears in the preview window.
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= BigColor Filter:
Select a color to limit the motion detection to a specific range or colors. The Post VM event will trigger

if this color changes during post video motion detection.

Searching for changes in Video Motion Windows

Once you have defined the video motion windows and have set the trigger conditions, you can search the

recordings for changes in the video motion windows. Use the playback buttons in the command bar at the

bottom.
It is best to use the Backward/Forward playback buttons when searching continuous recordings. For
searching in event images, use the Previous/Next image buttons. If MxMC detects a change within a

video motion window, the frame of that window turns red and the search stops.

Searching And Playing Back Door Events

Door Station-specific events and recordings can be searched for and played back with MxMC, just like all
other events and recordings. However, there are some small differences, which are discussed in more detail
below.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that
provide ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Camera
Feature Overview.

Watching and Playing Doorbell Recordings

Bell Settings

If there were visitors ringing in your absence, you will see this by checking the counter near the Bell Settings
@ in the Live view.

NOTE! The number displayed in the counter depends on the filter settings configured in the Alarm bar.
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Live - Foyer

1. Clickon E to see who has rung. Instead of the live image, the event image for the last bell activation is
displayed, and a red slider with the number "1" is displayed on the right side of the multislider @ .

2. If there are several doorbell recordings, click on the red slider and drag it to the left until the next higher
number is displayed in the slider. At the same time, the event image also changes to the image of the pre-
vious bell activation.

3. To play the respective doorbell recording, click on E again. The view switches to the Playback view.

Click on E The recording is played back.

Alarm Bar

A missed bell activation is also indicated by a green Alarm bar. This only happens if the Alarms option has
been enabled for the corresponding cameras in the Camera Configuration dialog and if the bell event has
been selected as an alarm triggering event. When the Alarm bar is opened, a green bar below the event image
indicates a missed bell activation. You can watch the recording of the missed bell activation directly in the
Alarm bar using the Instant Playback function.

-

3

Foyer — 28 sec.
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1. To do so, move the mouse pointer over the event image. Three icons appear. Click on (3. The recording
is played back directly in the Alarm bar.
2. You can also jump from the Alarm bar directly to the recording in the Playback view and play it back

without having to search for it there. To do this, move the mouse pointer over the event image once

again and click on

Viewing and Listening to Voice Mailbox Messages

Voice Mailbox Messages
If visitors have left messages in your absence, this is indicated by the counter next to the voice mailbox mes-

sages ® in the Live view.

Live - Foyer

1. Click on E to see who left a message. Instead of the live image, the event image for the last message is
displayed, and a red slider with the number "1" is displayed on the right side of the multislider @ .

2. If there are several messages, click on the red slider and drag it to the left until the next higher number is
displayed in the slider. At the same time, the event image also changes to the image of the previous mes-
sage.

3. To play and listen to the respective message, click on E again. The view switches to the Playback view.

Click on E The recording is played back.
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Alarm Bar
A voice mailbox message is also signaled to you in the Alarm bar by turning red, and the new event image is

marked with the icon. This only happens if the Alarms option has been enabled for the corresponding
cameras in the Camera Configuration dialog and if the voice mailbox message has been selected as an
alarm triggering event. To play back the message, move the mouse pointer over the event image. Three icons

appear. Click on 7| The message is played directly in the Alarm Bar (see The Alarm Bar, p. 51).

Searching and Playing Back Door Events

Like all events, door-specific events (e.g., attempts to open a door with an invalid PIN) can also be searched

and played back. Playback and search option options are available in:

B Searching And Playing Back In Playback View, p. 153
B Searching And Playing Back In The Grid Playback, p. 165
B Searching in the Smart Data Search View, p. 167

Exporting Recordings

Using the Playback view, you can export recorded video data from one camera, while the Grid Playback
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export.
You can save individual images with the Snapshot function.

Saving Snapshot Images

Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid
view and Grid Playback for all displayed cameras.
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Fig. 86: Saving Snapshot Images

To do so, click on the Snapshot button in the Command bar. By default, images are saved in the image
folder of the user account. The destination path and the image settings for saved images can be selected via
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images

(Windows) menu item.

Exporting Camera Recordings

The Playback view allows setting a time range for a recording (event recording or continuous recording) in

order to select it for exporting.

Open the Playback view.
Drag the desired camera from the Camera bar or the Device bar.
Find the start of the relevant recording.

H

Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

1. Mark the start of the clip by clicking on the gray flag on the left
2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip
by clicking on the gray flag on the right. Both flags are now green.

3. Click on Export and select the export profile.
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4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:

First, make sure that no export area has yet been set using the "export flag." If an export area has already
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

1. Click on Export . Then click on the desired export profile @ . The dialog box used for defining the

export range appears.
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2. Specify the export range @ .
3. Click on OK and then on Save.

tion.

NOTE! If you select the Automatically Import After Export checkbox in the Export dialog, the exported
clip will be automatically added to the Camera bar and in the Device bar to the Clips & Recordings sec-

Exporting Camera Group Recordings

The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to

select it for exporting from multiple cameras.

1. Open the Grid Playback.
2. Drag & drop the desired camera group from the Group bar or the Device bar.

3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is

extended to the other cameras in the group, and the recordings with the closest relevance to those in the

focus window recording will be displayed in the tiles.
4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

1. Mark the start of the clip by clicking on the gray flag on the left

2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip

by clicking on the gray flag on the right. Both flags are now green.
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3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To

do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the

desired cameras by clicking on the corresponding circles @ .

4. Then click on Export and select the export profile @ . The Export dialog box appears.
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Fig. 87: Select export range using visual markers

5. Select a target folder and enter a file name.

Manually capture export range:

||||||||||||||||||||||||||||||||||

26.02.15 08:26:53

Make sure that no export area has yet been set using the "export flag." If an export area has already been set,

you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

1. Before you define the export range, you can limit the selection if you do not want to export all of the

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the
top left corner. Select the desired cameras by clicking on the corresponding circles @ .

2. Click on Export and select the export profile @ . The dialog box used for defining the export range

appears.
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Fig. 88: Manually capture export range

3. Specify the export range ® .
4. Click on OK and then on Save.

NOTE! If you activate the Automatically Import After Export option, the exported clips are automatically
added to the Group bar.

Exporting Recordings From The Export Bar

The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback and in the Smart Data

Search View. After an export, the clips are not deleted automatically. It is deleted when the program is closed.

Adding Clips for Exporting in the Playback View

1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.

2. Find the recording you are interested in.
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Fig. 89: Adding Clips for Exporting in the Playback View

3.

Mark the start of the time range by clicking on the gray flag on the left [*. Play the recording until you

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the

gray flag on the right . Both flags are now green © .

You can set the end marker first (gray flag on the right), then play the recording from the beginning so
you can set the start marker (gray flag on the left) at the desired point.

Click on the image of the recording and maintain the position until you see a scaled-down image of the
recording @ .

Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback

The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

1.
2.

Drag the desired camera to the focus window in the grid and find the relevant recording.

Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you
have reached the end of the clip you want to export. Mark the end of the time range by clicking on the

gray flag on the right ™. Both flags are now green.
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3. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar
will open automatically, allowing you to save the image there.

4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to
show the same time. Drag the camera with the next recording in the sequence of events into the focus
window. Mark the start and the end of the clip as described above, then drag the recording into the
Export bar.

5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-
ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection
box for that camera.

4. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar
will open automatically, allowing you to save the image there. The selected clips will be copied to the
Export bar.

5. Repeat these steps until you have added all time ranges you want to export.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.
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NOTE! If the following image is shown in the player view, there is no video data saved for the selected
export period.

Fig. 90: No video data available for export

Editing Clips

If you have added a recording to the Export bar for which you previously used distortion correction or zoom
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three
icons appear:

MxManagementCenter

Playback - mx10-12-225

)

+

WK AOD> D @Rp & 140214 100553 &)
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- 0: Clip is exported with zoom.
Click on 0 to export the clip without zoom. The icon is disabled.

- @: By default, the clips are exported with audio (provided that audio had been recorded).
To export without audio, click on @ The icon is disabled.

- : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.

[ NN ] MxManagementCenter

Playback - mx10-12-225

Clips bearbeiten

E Kameraname mx10-12-225

14.02.14 08:35:00 [

H| El = 140214 10:05:53 |3

Dauer 1 Stunde 30 Minuten

4] uoio ein - atie
. Audio aus - alle
Zoom ein - alle
. Zoom aus - alle
Duplizieren
m Loschen

. Alles léschen

KO D> D @ Rz 140214 100558 &)

Exporting Clips

Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AV,
MP4 or MKYV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.

Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import
After Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after

exporting.
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Using Joysticks MxMC

This section describes the usage and integration of joysticks in MxMC.

General usage of joysticks

The range of functions of a joystick varies depending on the model. Before using the device, familiarize your-

self with the range of functionality, e.g. by referring to the manufacturer's documentation.

NOTE! Before usage joysticks and keypads need to be calibrated (see Preferences, p. 250).

MOBOTIX PTZ Keyboard integration into MxManagementCenter

The MOBOTIX PTZ Keyboard is fully integrated into MxManagementCenter. For detailed information it's
recommended to read the manual (see www.mobotix.com > Support > Download Center > Marketing &

Documentation ).
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MOBOTIX

Fig. 91: MOBOTIX PTZ Keyboard

NOTE! Before usage joysticks and keypads need to be calibrated (see Preferences, p. 250).
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MxMC related key asignment

Button Primary MxMC Function Secondary Function (after pressing a "SELECT" but-
number ton
. MiddleSecton
0 Previous Camera 1 1ot
1 Next Camera 2

2 Cam Sequencer 3

3 Previous Group 4

4 Next Group 5

5 Group Sequencer 6

6 Device Tree 7

7 Alarm Bar 8

8 Smart Data Bar ©

9 Cancel Cancel

10 0 0

11 Enter Enter

- mmEmm
12 Door Opener rd
13 Light toggle

14 Softbutton 1

15 Softbutton 2

16 Softbutton 3

17 Softbutton 4

18 Softbutton 5

19 Softbutton SELECT * (Button Com-

bination)
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Button
number

Primary MxMC Function Secondary Function (after pressing a "SELECT" but-
ton

24

25

26

27

28

29

30

31

Full Window L
PTZ SELECT * (Button Combination)

Live Recording START / STOP

Snapshot

Microfone On / Off

Handset Pick up / Hang up

Select Monitor (Button Combination

Select Camera (Button Combination

20

21

22

23

39

Previous Image L
Backward Play

Stop / Pause

Forward Play

Next Image

34

35

36

37

38

Live View L
Playback View

Grid View

Graphic View

Info View

Turn right Next image (]

Turn left

Previous image

Turn right increase playback speed forward 4th axis L

Turn left

increase playback speed backward 4th axis
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This section addresses administrators who manage a system using MxMC.

Topics Explanation

Group Views, p. Editing the layout of the Grid view, editing the layout of the Graphic
202 view, assigning group functions, storing information for a camera group,

limiting the frame rate of live images

Door Station Bell settings, voice mailbox settings
Settings, p. 209

Network Envir- Create and manage environments, customize network data for each
onments, p. environment
215

Cameras And  Manage cameras, manage camera groups, integrate and manage third-
Camera party cameras

Groups, p. 217

User Man- General user rights, manage user rights
agement, p.
237
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Topics Explanation
Preferences, p. General settings, network, software update, notifications, monitoring,
250 audio, data volume, caches, snapshot images, live recorders, remote con-

trol, joystick PTZ, MxMessageSystem

Checking Sys-  Maintenance functions, security functions
tem Security, p.
294

License Man-  Activate licenses, manage licenses

agement

Group Views

After the initial installation, adjustments of the group views may be necessary. This section contains inform-

ation about more detailed Grid and Graphic view configurations as well as general group parameters.

Editing the Grid View layout
When creating the camera groups, the Grid layout - the grid in which the cameras are arranged - is created

based on default values that can be customized. To do so, click in the Command bar or in the Device bar.

The Command bar then displays several controls for configuring the grid layout.
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Fig. 92: Editing the Grid View layout

As a first step, before you change the format of the camera images or the size of the focus window, decide
whether the grid layout should automatically adjust when you resize the window, or whether you want to

manually define the size of the tiles and their position.

Using Auto Grid Mode

The auto grid mode @ is used by default. In auto grid mode, MxMC always tries to distribute the available
space as well as possible according to the specified aspect ratio of cameras images (4:3, 16:9, 8:3), the size of
the focus window and the number of cameras. This causes the grid layout to automatically adapt to any

changes. In auto grid mode, the following sliders are available for changing the grid layout:
= @: Format of the camera images and the focus window (4:3, 16:9, 8:3)
. @: Size of the focus window (1x, 2x, ..., 8x the size of the camera images)
= @: Maximum number of cameras

Move the sliders to the desired settings. To close the edit mode, click on E

Selecting manual mode

In manual mode @, you set the size of the individual tiles and their position based on the selected format of
the camera images (4:3, 16:9, 8:3). In contrast to auto grid mode, the layout is not adjusted automatically in
manual mode. To switch from auto grid mode to manual mode, move the slider @ to the right until you

reach the position @ The following sliders are available in manual mode:
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u @ = Format of the camera images and the focus window (4:3, 16:9, 8:3)

" @ = Maximum number of cameras

1. Move the sliders to the desired settings.

2. To move a tile to a different position, move the mouse pointer over the tile. Click on @ and drag the tile
onto the desired position. For better orientation, a blue frame indicates the target position.

3. To set the size of a tile based on the selected format, move the mouse pointer over the border of the tile
until a double arrow is shown. Drag the tile to the desired size.

4. To close the edit mode, click on

Editing the Graphic View layout

Changing the camera position on the background image

In the Graphic view, you can define background images such as a floor plan or a plan layout. You can then
arrange the cameras of the group on these according to their actual position. When opening the Graphic view
of a camera group for the first time, all cameras of the group are shown as anicon ¢ at the right-hand mar-
gin of the background image @ .

To adjust the position of the cameras, open the edit mode @ by clickingon . Move the mouse pointer over
the camera image. Two icons are shown ® . Click on @ and drag the camera icon to the desired location. To
close the edit mode, clickon . When you exit the edit mode, the changed settings are saved automatically.

MxManagementCenter

Grafik - Parkplatz

Fig. 93: Changing the camera position on the background image
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Editing camera icons

You can change the icon size and rotate the icons to reflect the viewing direction and the angle of view of the
cameras.

Open the edit mode @ by clicking on . Move the mouse pointer over the camera image. A dotted line in
the shape of a square is shown around the camera icon. To make the camera icon larger or smaller, click on
the right or bottom left corner of the square and pull it inwards or outwards @ . To change the orientation of
the camera icon, hover the mouse pointer over the icon until a hand is displayed. Hold down the mouse but-
ton and turn the camera icon around its own axis until you are satisfied with the orientation. To close the edit

mode, click on . When you exit the edit mode, the changed settings are saved automatically.

MxManagementCenter

Grafik - Parkplatz

Fig. 94: Editing camera icons

Dragging additional camera groups onto the background image

You can position additional camera groups on the background image (floor plan) of a camera group. If a cam-
era of an added camera group detects an event and the Background Alarm has been enabled for this camera,
the camera group icon turns red or green (bell event). Click on the group icon to open the Grid view of the

camera group.
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‘en e MxManagementCenter

Grafik - Parkplatz

Fig. 95: Dragging additional camera group onto the background image

Open the edit mode and drag the desired camera group(s) from the Group or Camera bar onto the floor

plan. To close the edit mode, click on m When you exit the edit mode, the changed settings are saved auto-

matically.

Positioning controls on the background image

The Command bar at the bottom of the Graphic view contains several controls. If a camera has been set up to
control a light, for example, you can switch the lights of this camera in the Graphic view. You can drag these
controls onto the background image (floor plan) and simply click on them to execute the corresponding func-

tion for easier operation later on.
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Fig. 96: Positioning controls on the background image

Open the edit mode . To open the shortcut menu, right-click on the desired operating function. Then drag
the control to the floor plan with the mouse pointer. To close the edit mode, click on . When you exit the

edit mode, the changed settings are saved automatically.

Assigning group functions

NOTE!
Group functions are not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview, p. 9.

In the Grid, Graphic and Info view, you can use group functions to turn on a light, open a door, or make an
announcement for one camera in the currently selected group.
In addition, the Switch Light and Open Door group functions can be assigned to multiple cameras, so you

can switch multiple lights or open multiple doors at once with a single click.
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Fig. 97: Assigning group functions

Proceed as follows to assign group functions:

1.
2.

Open the edit mode in the Device bar by clicking on at the bottom of the bar.
To do so, move the mouse pointer over the group name. Three icons appear. Click on . The Group

Functions dialog opens.
Assign the desired functions to the cameras by activating the respective checkboxes.

Once you have defined all group functions, you can deactivate the edit mode by clicking on m

Adding Information For A Camera Group

You can assign an information page to a camera group in order to show special instructions for this camera

group, for example.

1.

Open the edit mode in the Device bar by clickingon  at the bottom of the bar. Next, clickon  and

thenon . The Group Configuration dialog opens.

2. Move the slider @) to the right until you reach the @ position.

Click on the arrow in the gray field and select the file you want to use.

Limiting the frame rate of live images

If a very large number of cameras is displayed in the Grid view, the performance may decline. To avoid this,

you can limit the frame rate of the live images within the tiles. Note that this limit does not apply to the cam-

era displayed in the focus window.
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Fig. 98: Limiting the frame rate of live images

1. Open the Group or Camera bar by clicking on the upper gray frame border. Click on the frame border
again to switch to the camera Group view.

2. Right-click on the group icon and select the maximum number of frames per second and the maximum
image size.

3. Use ONVIF-S/G LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and
for third-party cameras that provide an ONVIF-S/G-compatible interface. If the checkbox is enabled, the
settings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these

cameras will be used.

Door Station Settings

There are several ways that MxMC can respond to ringing and mailbox notifications. Here you will find inform-

ation on how to set these notification options.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF S-compatible interface. For an overview of how the camera functions differ (see Camera

Feature Overview, p. 9.

See also:
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B Operate Door Stations, p. 140
® Door Station Wizard, p. 312

Bell Settings

Setting the ring tone

Allgemein
Metzwerk
Software-Update

Uberwachung

Audio

Datenmenge
Caches
Schnappschuss-Bilder
Live-Recorder
Aufzeichnungspfade
Fernsteuerung
Joystick-PTZ
MxMessageSystem
Retailsystem

Benachrichtigungen

Vereinstellungen

Einstellungen

Alarme

Alarmbenachrichtigungen:

Alarmton:

Dauer: =/

Lautstérke:

Disabled

Alarm

L T T T T T T I I R O I O A |
3s 1 min
0 100

Aktivieren, um bei einem Kamera-Alarm eine Nachricht zu erhalten. Sie kdnnen Melodie, Dauer und
Lautstérke des Alarmtens einstellen.

Klingel
Klingelton: | Alarm
Lautstérke: ————————————— \,
0 100

Legt den Ton der Tlrklingel fest.

Anwenden

Fig. 99: Setting the ring tone

Abbrechen

1. Open Settings in the MxManagementCenter > Settings (Mac) or File > Settings (Windows) menu and

click on Notifications.

2. Select the desired ring tone and adjust the volume.

Setting bell signaling

When a bell is rung, this can be indicated in different locations in MxManagementCenter. Consult the fol-

lowing table to learn which signaling options can be combined and where they can be configured.

NOTE! The alarm signaling must be activated in the camera settings, a bell profile must be set up and the
correct bell profile must be selected in MxMC for bell notification to work.
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Notifications Settings

Alarm bar, Alarm info bar, You need to configure the alarm notification for the doorbell ringing to be
doorbell notification, indicated at these places.
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1. To do so, open the Camera Configuration dialog box by right-clicking on
the corresponding camera in the Camera bar.
Another option is to open the dialog box in the Device bar by clicking on
and then right-clicking on the corresponding camera.

2. Click Alarms and activate the Alarm notification and the doorbell ringing.

Ring tone off
You can switch off the ring tone of the signaling by setting its volume to "0"
(see Setting The Ring Tone).

Counter on the bell icon only Deactivate doorbell ringing in the Alarms dialog box and only the counter on
the bell icon will increase by one each time.

1. To do so, open the Camera Configuration dialog box by right-clicking on
the corresponding camera in the Camera bar.

Another option is to open the dialog box in the Device bar by clicking on

and then right-clicking on the corresponding camera.
2. Click Alarms and deactivate doorbell ringing.

Completely off Disable the gey checkbox in the ge| settings m to switch off the bell com-
pletely (see Turning Off The Bell Completely).

Selecting a bell profile

A bell profile basically controls the reaction if someone is ringing at the door station. The camera provides
several predefined bell profiles.
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Profile Explanation

No phonering  MxMC and all other remote stations will not react, i.e., you will not notice if someone is
ringing (neither visually nor by sound).

Ringing You will hear if someone rings the doorbell. The visitor cannot leave a message.
Ring and Mail-  You will hear if someone rings the doorbell. If no configured remote station reacts within a
box given period of time, the Door Station plays back a previously recorded announcement

and the visitor can leave a message.

Voice Mailbox  After ringing, the Door Station immediately plays back an announcement and the visitor

can leave a message.

Announcement After ringing, the Door Station immediately plays back an announcement. The visitor can-

only not leave a message.

@08 MxManagementCenter

Live - Foyer 7 G @

Kiingeleinstellungen

Klingel

B «ingelerofi Kiingelprofile

Zahler zurlicksetzen
i Letztes Kiingeln Do. 20.09.18 16:46:11
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Fig. 100: Selecting a bell profile

1. Switch to the Live view of the Door Station.

2. In the Live view, right-click on the Bell icon to open the Bell Settings.
3. Click on Bell Profile and select the profile you want from the list.
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Resetting the ringing counter

The counter next to the bell icon in the Live view is incremented each time the doorbell is rung, regard-
less of whether or not you react to the ringing. Resetting the counter will help in recognizing if you have
missed a ringing, which is why you are encouraged to regularly reset the counter. Once you have reset the

counter, you will be informed how long ago the last reset took place.

Switch to the Live view of the Door Station.

1.

2. In the Live view, right-click on the Bell icon E to open the Bell Settings.
3. Click on Reset Counter.
4.

The counter has been reset and is no longer shown next to the Bell Settingsm button.

Turn bell off completely

If you do not want to be disturbed by the doorbell, you can deactivate a specific bell or contact number. This
means that ringing is neither signaled at any of the remote stations, nor is the "ringing counter" increased. In

this case, you will not be informed about missed visitors and visitors will not be able to leave any messages.

LN MxManagementCenter

Live - Foyer

Klingeleinstellungen

=4 Klingelprofil Klingelprofile »
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Fig. 101: Turn bell off completely

1. In the Live view, right-click on the Bell icon E to open the Bell Settings.
2. Disable the Bell checkbox.
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Mailbox settings

Selecting a voice mailbox

Depending on the installed options and the configuration of the Door Station, you may have several bell but-
tons or - in case a MOBOTIX Keypad module has been installed - several contact numbers. Each of these bells
or contact numbers has its own mailbox. The corresponding mailboxes are presented in the list (below the
name of the bell).

NOTE! All settings made in the Mailbox function always apply to the selected mailbox. This also means
that the new messages counter only applies to this mailbox. To get the messages and recordings of a dif-
ferent mailbox, select that mailbox first.

LN MxManagementCenter
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Fig. 102: Selecting a voice mailbox

1. In the Live view, right-click on the Voice Mailbox icon to open the Mailbox Settings.
2. Click on Voice Mailbox to select the desired mailbox from the list.

You can select a bell profile for each voice mailbox. For instructions on how to do this, see Selecting A Bell
Profile.

Activating The Voice Mailbox And Selecting A Welcome Message

1. Enable the Active checkbox.
2. Click on the Announcement button. Select the announcement to be played to the visitor.
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Enabling the Message

If visitors should be allowed to leave a message, activate the Leave Message option.

Network Environments

Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS
access over the Internet. These two methods require the use of different network access data. To avoid hav-
ing to change the network access data every time, you can set up different network environments for the cor-
responding network access data in MxManagementCenter. Switching to a different environment causes the
network address data for connecting to the cameras to be switched automatically (see Working In Different

Network Environments, p. 146).

Creating and Managing Environments

Creating environments

1. Clickon in the Header bar. The Projects and Network Environments dialog opens.

2. Click on Environment and then on . This adds an environment with the name "New Environment".

Assign a suitable name.

MxManagementCenter
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Fig. 103: Creating environments

Changing names and deleting environments

1.
2.
3.

Open the Network Environments dialog box.
Editing names: Click on . Highlight the name and overwrite it.
Deleting environments: Click on @ next to the environment you want to delete. Click on the red Delete

box to the right of the environment.

Configuring network data for each environment

1. To set network data, open the Camera Configuration dialog. To do this, either right-click on the indi-

vidual cameras in the Camera bar or open the Edit mode in the Device bar and right-click on the indi-
vidual cameras. The Camera Configuration dialog opens.

Environment: Shows the current network environment. After starting the program for the first time, it
shows the standard environment. All existing network environments are shown in the blue bar. Click on

the environment you want to use. Next, perform the required network settings for this environment.
® Background alarm calls: Specify whether a permanent event stream connection to the camera should

be established in the selected environment or not. You can deactivate this option if a permanent
event stream connection is not required or even unwanted (when using MxMC in low-bandwidth net-
works, for example). If this option has been deactivated, the application will only open an event
stream connection if necessary, such as for showing the live stream of the camera or recordings via
the camera. In this case, alarms will only show for this camera, while the connection has been estab-
lished.

Remote: Only activate this option if you want to access the camera from a remote location (e.g., via
DynDNS).

SSL: If you rather want to use an encrypted connection for the selected environment, activate this
option (recommended setting). Note that HTTPS needs to be activated on the camera (in the browser
in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

Bandwidth: Select the bandwidth to use for this environment:

HiRes: The images are transferred using the settings made in the camera.

LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Prefer-
ences, p. 250 for LoRes.

Camera configuration

This section describes basic options to configure cameras.
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Cameras And Camera Groups

Here you will find information on the administration of cameras and camera groups. This includes topics such
as changing the network data of a camera or exchanging cameras between camera groups.

NOTE! Administrator rights are required to perform these administrative functions.

Managing cameras

Editing camera data

To change a camera's access data and network data, open the Camera Configuration, p. 222 dialog.
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Fig. 104: Editing camera data

1. To do this, either right-click on the desired camera in the Camera bar ® or open the edit mode in the

Device bar and right-click on the corresponding camera @ . The Camera Configuration dialog opens.
2. Edit the data as desired.

Editing Camera Data Of Multiple Cameras

In the Multi-Camera Configuration dialog, you can change the authentication data used by MxMC as well as

the environment settings of multiple cameras in one step.

1. To do this, open the edit mode in the Device bar by clicking on .
2. Select the cameras as needed.
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Mac: CMD + click, Windows: CTRL + click
3. Right-click on one of the selected cameras. The Multi-Camera Configuration, p. 236 dialog opens.

Activating |/ Deactivating camera background alarms

NOTE! Background alarms are not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera
Feature Overview, p. 9).

An activated option means that the application maintains an active event stream connection to the camera,
regardless of whether or not MxMC is showing the live stream. Using the event stream connection, the cam-
eras will send event information to MxMC , which will show them as alarms depending on the settings (see
Adding Cameras, p. 75). You can deactivate this option if a permanent event stream connection is not
required or even unwanted (due to high system loads on systems with very many cameras or when using
MxMC in low-bandwidth networks, for example).

If this option has been deactivated, the application will only open an event stream connection if necessary,
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms
will only show for this camera, while the connection has been established. This option is deactivated by fact-
ory default.

@ @ MxManagementCenter

Live - mx10-12-225

------------------------------------------------------------

| .
i n if
k-112-21

A LT L LRI LT e —— R

Verbindungsprotokoll  MOBOTIX F A |

URL 1012225

Remote-UAL

Benutzername

Passwort  esaens
ayer

@ mx10-12-225 ram Umgebung
o mao-38-12-21 i Standard Zuhause
Hintergrundatarmierung
Remote
Alle z I» . E8
i Parkplatz
¥ Treppenhaus
@& mx10-12-226

géndbreitencinsteliungen
Autzeichnungseinstellungen

MxThinClient-Gerdite v ‘

B3 MxThinClient

Clips & Aufzeichnungel 23 v

o e

8 <> @ N—0H 2 &8 00 = Ch P 171018 12:10:20

1. To open the Camera Configuration dialog, either right-click on the corresponding camera in the Camera

bar ©® or open the edit mode in the Device bar and right-click on the corresponding camera @ . The Cam-
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era Configuration dialog opens.
2. De-/activate the Background Alarms function.

Deleting cameras

LK ) MxManagementCenter

Live - mx10-12-225 'P G @

O RN R RN

) |
(TN )
Foyen . Rk 112-21

R T L L T L L L RRTE vame

Verbindungsprotokoll  MOBOTIX

URL 10.12.226

Remote-URL

Benutzername

mx10-12-226
Verbindungsprotokoll = MOBOTIX
URL 10.12.226
Remote-URL
@ mx10-12-225 Benutzername ;i Umgebung

Passwort  aseees

Bla mxi0-38-1 Passwort  eeeees Standard Zuhause
Umgebung i Hintergrundalarmierung
Remote
. E

» i Parkplatz
¥ ¥ Treppenhaus

@& mx10-12-226

8. mx10-3
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Autzeichnungseinstallungan
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» H 1.06

MxThinClient-Gerate
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Clips & Aufzeichnunge: (&) v

17.10.18 12:10:20

Fig. 105: Deleting cameras

1. Open the Camera Configuration dialog by right-clicking on the corresponding camera in the Camera bar

® or open the edit mode in the Device bar and right-click on the corresponding camera @ . The Camera

Configuration dialog opens.
2. Click on Remove.

Managing Camera Groups

Moving cameras between Camera Groups

The Device bar lets you quickly drag and drop cameras from one group to another.

1. In the Device bar, open the edit mode by clicking on and then drag and drop the cameras as desired.

2. Close the Edit mode by clicking m
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Removing cameras from a Camera Group

‘a0 e® MxManagementCenter

Playback - mx10-38-112-21

Kameragruppen
v i Alle Kameras

v H Tn‘bpenhaus

5 / mx10-12-
MlThinC'J,'em-Gc::le
3/ BxThinClient

Clips zeichnungel & v
> B Gate

O O OO T RN N RN RN O R e

ﬁ( > Ch R KO D @ pE 16.02.18 09:40:33
Fig. 106: Removing cameras from a Camera Group
1. Open the edit mode in the Device bar by clicking on .

2. Drag and drop the camera from the appropriate group to .

3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on m

Deleting Camera Groups

Deleting a camera group will not delete the cameras that are assigned to the group.
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‘e0e® MxManagementCenter

Playback - mx10-38-112-21

Kameragruppen
v Hi Alle Kameras

16.02.18 09:40:33

Fig. 107: Deleting Camera Groups

1. Activate the Edit mode by clicking .
2. Drag a group from the corresponding section to .
3. Next, activate the edit mode by clicking on m
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Camera Configuration

Cllp & Recording Contiguration 7est - mx10-12-156-92
B oo mx10-12-166-92

Connection Protocal | MOBOTIX
URL 192.168.178.98
Remate URL. DNS
User Name

- Password

Bandwidth Settings
Recording Settings
Aarms

Sensor

21.01.21 07:47:28

Fig. 108: Camera Configuration
Cameras that are available in mxmshould be configured according to their intended useOpen the Camera
Configuration dialog to enter and edit the camera data.

For bulk configuration of multiple cameras hold the SHIFT key when selecting the cameras.

O @

e e et et it e Cameras >
Cameras RSN Password  [MultipleValues]

® 10.32.19.237 _

EE’? 10.14.28.43 Environment Default

@ 10.22.10.129 [packground Alarms ]

B mx10-32-44-114 Remote L

5 mx10-32-24-131 =5 Ll

cr:é mx10-32-19-229 Bandwidth | [EH} HiRes s |

Bs mx10-23-9-171 Bandwidth Settings >

D9 mx10-22-68-36 Recording Settings Via Camera »
Alarms

G. mx10-22-10-156

[ 10.32.2{1.131

=1 10,

Fig. 109: Bulk configuration of multiple cameras
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Camera Access Data Configuration
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Clip & Recording Configuration

Name mx10-12-156-92
Connection Protocol MOBOTIX

URL 192.168.178.98
Remote URL DynDNS
User Name admin

Password anasns

Environment Standard

Standard Compamy Private

Background Alarms

Remote v
SSL B
Bandwidth

Bandwidth Settings >
Recording Settings Via Camera >
Alarms On >
Sensor
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Fig. 110: Camera access data configuration

Name: The camera name is displayed automatically. If required, you can enter an individual name for each
camera.

Connection Protocol: In order for MxMC to be able to establish a connection to the camera, a suitable con-
nection protocol must be selected depending on the available interface of the camera manufacturer. If you
have integrated the camera with the Welcome wizard, the corresponding protocol is used automatically.

When manually adding the camera, select the appropriate protocol. The following protocols are available:

B MOBOTIX: Select this protocol to establish a connection to a MOBOTIX IoT camera.

® MOBOTIX with Pelco-D: The requirements to use Pelco-D protocol are:
® MOBOTIX loT Camera with MxBus or MxBus Module RS232

® A PT Head with Pelco-D support
® The serial interface must be activated and configured in the camera software (for the parameter
settings see the cameras reference manual the documentation of the pan and tilt head)
® MOBOTIX MOVE: Select this protocol to establish a connection to a MOBOTIX MOVE camera.
B ONVIF-S/G: Select this protocol to connect to an ONVIF-S/G compatible camera.
B Axis PTZ: Select this protocol to connect to a camera with Axis PTZ control.
B MOBOTIX Face Detect: Select this protocol to connect to a MOBOTIX P7 camera MOBOTIX Face Detect
App running.
URL: The IP address is either discovered automatically via Bonjour or it has been entered manually. MxMC
supports both the IPv4 and IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name)
when adding it to access the camera from outside the local network.

NOTE! Before you can access the camera from outside of the local network, you need to activate the

Remote option in the Environment Settings, p. 226.

User name, password: Access data that had been entered when adding the camera.
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Environment Settings
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Clip & Recording Configuration @

MName mx10-12-156-92

{3

Connection Protocol MOBOTIX

URL 192.168.178.98
Remote URL DynDMS

User Mame admin
Password e

Environment Standard

Standard Compamy Private

Background Alarms

Remote

SSL

Bandwidth

Bandwidth Settings

Recording Settings Via Camera >
Alarms On 2
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Fig. 111: Camera network environment configuration

Environment: Shows the current network environment. After starting the program for the first time, it shows
the standard environment. All existing network environments are shown in the blue bar. Click on the envir-
onment you want to use. Next, enter the network settings you want to use for this environment. To define
environments, see Network Environments, p. 215.

Background Alarms: An activated option means that the application maintains an active event stream con-
nection to the camera, regardless of whether or not MxMC is showing the live stream.

Using the event stream connection, the cameras will send event information to MxMC, which will show them
as alarms depending on the settings (see Adding Cameras, p. 75). You can deactivate this option if a per-
manent event stream connection is not required or even unwanted (e.g. due to high system loads on systems
with very many cameras or when using MxMC in low-bandwidth networks).

If this option has been deactivated, the application will only open an event stream connection if necessary,
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms
will only show for this camera, while the connection has been established. This option is deactivated by fact-

ory default.

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.

Remote: Activate this option if you want to access the camera from a remote location (via DynDNS).

SSL: Activate this option if you want to use an encrypted connection to the camera. By default, the con-
nection between MxMC and the camera is not encrypted. Note that HTTPS needs to be activated on the cam-
era (in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.

Bandwidth: Select whether you want to get the images from the camera in HiRes or LoRes by default. The
values (frame rate, image size and image quality) used for HiRes and LoRes connections are set in section
Bandwidth Settings for MOBOTIX IoT Cameras and in section Connection Settings for MOBOTIX MOVE cam-

eras.
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Bandwidth Settings (MOBOTIX Cameras)

Clip & Recording Configuration ®@®

Name mx10-12-156-92

Connection Protocol | MOBOTIX <

URL 192.168.178.98

Remote URL DynDNS

User Name admin

Password = sesess

Environment Standard
Standard Compamy Private

Background Alarms =

Remote v

SSL =

Bandwidth (Hi)

Bandwidth Settings b

Via Camera >

Recording Settings
Alarms On >

Remove

Fig. 112: Bandwidth Settings (MOBOTIX Cameras)

Bandwidth Settings

Bandwidth Settings HiRes

Frames per Second | Unchanged

<>

Resolution Unchanged

<>

Image Quality Unlimited

<>

Bandwidth Settings LoRes

Frames per Second | 1fps

<>

Resolution CIF (320x240)

<>

Image Quality 30%

<>

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values:

® frame rate in Frames per Second
® Resolution

® Image Quality

Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)

CAUTION! In contrast to bandwidth settings of MOBOTIX cameras, changes to the media profiles of
MOBOTIX MOVE / ONVIF-S/G cameras are made directly on the cameras. Therefore, these changes affect all

applications that use these profiles.
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Clip & Recording Configuration ® ® [connection Settings ®
il A Pan2 Authentication Username Token o
Connection Protocol | ONVIF 2
Protocol RTP via UDP a
URL 192.168.178.102 '
Remote URL DynDNS Bandwidth Settings HiRes
User Name root HiRes Profile profile_1_h264 2
Password -
' Video Encoder default_1_h264 =
Environment Standard )
Standard Compamy Private Video Codec H.264 <
Remote Frames per Second 30 fps <
SSL
Resolution 1280x1024 o
Bandwidth
: 709 e
Connection Settings > Image Quality 0% &
Recording Setti N > : -
i B one Bandwidth Settings LoRes
LoRes Profile profile 1_h264 s
r Video Encoder default_1_h264 o
Video Codec H.264 o
Frames per Second 30 fps a
Resolution 1280x1024 &
Remove
Image Quality 70% a2

Create MxProfiies@ Transfer Changes @

Integration Key: 157f0a3b-cc93-47f3-b5f3-17527353c722

Fig. 113: Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)
You can specify:

Authentication method: Select between

B Username Token
B Digest

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values

®  HiRes/LoRes Profile, which is defined as ONVIF-S/G profile on the camera:
® Video Encoder profile

® Video codec

® frame rate in Frames per Second

® Resolution

® Image Quality
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Click on Create MxProfile @ to create a profile, which is optimized for a MOBOTIX environment of the cam-
era. By default, MxManagementCenter creates two profiles named MxHiQuality for HiRes and MxLoQuality
for LoRes.

Click on Transfer changes @ to transfer changes on the loaded profiles to the camera.

Recording settings
Saved recordings can be accessed in a variety of ways, depending on the connection protocol.

With MOBOTIX cameras:

® Via camera (MOBOTIX cameras): The camera is handling access to the recordings.

® Via recording path: The camera is handling access to the recordings via a previously defined record-
ing path. Recording paths can be defined in the program settings (Mac: MxManagementCenter > Set-
tings > Recording Paths; Windows: File > Settings > Recording Paths).

® Via a local directory: Local path (recordings are accessed on the local computer).

With MOBOTIX MOVE / ONVIF cameras:

® Via MOBOTIX NAS: Access to recordings via a previously defined MOBOTIX NAS. Access data can be
defined in the program settings (Mac: MxManagementCenter > Settings > Recording Paths; Win-
dows: File > Settings > Recording Paths).

Click on Recording settings to adjust the settings to your needs. This opens another dialog box.

1. Choose the desired recording path:
Access via the camera:
No further settings are necessary.

Access via recording path:
B Select the corresponding recording path and set the corresponding recording format: Use MxFFS if

the recordings have been stored in an MxFFS archive. Use MxFileServer if the recordings have been
stored in the classic MOBOTIX folder/file structure.

B MxMC searches for the corresponding recordings in the subdirectories of the predefined file server
path. Once the search has been completed, you can select the folder for this camera in the Device Dir-
ectory selection box.

Access via local directory:
B Select the Local path option and set the corresponding recording format:

B Enter the file path in the Local path text box.

Note: Click on the pen icon in the text field to open a file selection dialog.

Access via MOBOTIX NAS:
B Select the appropriate MOBOTIX NAS and then select the appropriate device directory based on the

displayed IP addresses.

2. Close the dialog box. The settings will be saved automatically when you close the dialog box.
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Setting up and changing Alarm Notification

Feature Overview, p. 9).

NOTE! The alarm feature is not supported by MOBOTIX MOVE cameras and third-party cameras that

provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera

This section allows selecting the event types that will lead to an alarm if the corresponding event is triggered.

An alarm will be indicated at the following locations:

B Alarm Bar turns red or green (door bell), the alarm images are shown in the Alarm bar.

B Alarm Info Bar turns red or green (door bell) in the live images.

B Alarm Settings allow setting up visual and sound notifications for alerting (Mac:

MxManagementCenter > Settings, Windows: File > Settings).

1. Click on Alarms. The Alarm Events dialog opens.

[0X)

Clip & Recording Configuration
Name mx10-12-156-92

Connection Protocol MOBOTIX ]

URL
Remote URL

192.168.178.98
DynDNS
User Name admin

Password

Environment Standard

Standard Compamy Private

Background Alarms
Remote v
SSL

Bandwidth

Bandwidth Settings >

Via Camera >
On >

Recording Settings
Alarms

Sensor

Remove

Fig. 114: Editing Alarm Notifications

2. Activate Alarm Signaling.

arms

|Alarm Signaling
Active

J-Narm Overview
Alarm
® MxActivitySensor
@ Video Motion
@ Behavioral Detection
@ Shock Detector

@) tumination

@ Microphone

@ Passive Infrared Detector
@ Temperature

@ Internal Events
@ Message Events
. Meta Events

@ Signal Events
@ Time Events

@ Ringing

@ Mailbox messages
@ Door Station

@) rFiD Rejected

@ PIN Rejected

€ other

Active Weekly Profile
v 24 Hours
¥ 24 Hours
v 24 Hours
v 24 Hours
¥ 24 Hours
v 24 Hours
v 24 Hours
V| 24 Hours
" 24 Hours
+ 24 Hours
il 24 Hours
¥ 24 Hours
v 24 Hours
v 24 Hours
v 24 Hour§
¥ 24 Hours
v 24 Hours
v _24 Hours
V| 24 Hours

Edit weekly profiles...

<>

<>

<

<>

<>

<>

Invert

Public Holidays

ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore
ignore

ignore

3. Select the event types that should trigger an alarm.
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4,

In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as

no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.

® To create new weekly profiles, click on [74. The Weekly Profiles dialog opens. Several predefined pro-

files are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).

® To add a profile, click on| + |. Enter a description. Highlight the desired active times in the table. You
can resize an active time block by clicking on the time block and then moving the borders accordingly
It is also possible to move a block. Click on the block to select it, then drag the block to the new pos-
ition. To delete a time block, click on €9.

® You can change the description of an existing profile. Right-click on the name and overwrite it.

To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and highlight

the desired profile. The calendar icon turns white.

To easily invert the settings of the weekly profile, simply click on the calendar icon. For example, if you

have created a profile with opening hours and would like to activate the alarms for the closing times,

click on the calendar icon (31 to invert the profile. The icon turns red.
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Sensor Settings (MOBOTIX Cameras)
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Clip & Recording Configuration @
Mame mx10-12-156-92

Connection Protocol MOBOTIX -
URL 192.168.178.98

Remote URL DynDMS

User Name admin

Password S

Environment Standard

Standard Compamy Private

Background Alarms

Remote v
SSL B
Bandwidth

Bandwidth Settings >
Recording Settings Via Camera >

Alarms

Sensor
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Fig. 115: Sensor Settings (MOBOTIX Cameras)

NOTE! The sensor settings are available only for MOBOTIX Cameras with two optical sensors.

You can specify how the sensors are to be integrated in MxManagementCenter.

B Click on sensor 1 or2 @, to edit the sensor name.

B Click on the Merge Sensors icon @ to combine both sensors as one single camera to be integrated into
MxMC.

B Click on the Merged Sensor icon @ to release the combination of both sensors. Each sensor will be
integrated as individually configurable camera in MxMC.

B Click into the Preview field ® to set the recent video frame as preview image for the selected sensor.

Multi-Camera Configuration

The Multi-Camera Configuration dialog box allows changing authentication data used by MxMC and the
environment settings of many cameras in one step. When opening the dialog, the application shows the cur-
rent settings of the cameras. The field is labeled with "multiple values" or a minus sign is shown in the [—|

checkbox if one option has several different settings.

Meaning of the setting options

The meaning of the entries can vary depending on the field type. The following table therefore gives a brief

overview of the possible entries per field type and their meaning.

Field type Current status
admin All cameras have the user name admin.
The cameras have different user names.
[Mehrere Werte]
This settings has been activated for all cameras.

This settings has been deactivated for all cameras.

[]
=]

L2 HiRes "HiRes" has been set as bandwidth setting for all cameras.

The cameras have different settings.

' The cameras have different values.
[ Mehrere Werte
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Editing Settings

The fields and settings in the Multi-Camera Configuration dialog are much the same as those in the Camera
Configuration dialog. One difference is the way settings are edited. Therefore, only the editing will be
explained here. For more information about the general meaning of the settings, see the Entering And Editing
Camera Access Data help topic instead.

Unlike the Camera Configuration dialog, the Multi-Camera Configuration dialog allows you to reset set-
tings that have not yet been saved. Depending on the field type, you can use different methods.

Field Explanation
type
user |f you change the text box of a setting, such as User name, a small cross appears on the right-hand

side. Click on the cross to reset the entry to its original value.

|—|  When closing the dialog, the previous setting will be restored.

[ mel If you select Several Values in a selection box, closing the dialog will restore the previous setting.

Notes on the settings

When processing the following fields, these special features must be observed:

® Recording path:
Local path: The Local Path option can be selected for all cameras. Note that you will need to enter the
paths individually for each camera in the Camera Configuration dialog (see Recording Path in Enter-
ing and Editing Network Data).
Recording path: If you select a recording path (see Recording Path in Entering and Editing Network
Data), MxMC automatically searches the device directory for each camera. The search has been com-
pleted if the progress bar is replaced by OK. If you close the dialog beforehand, you will have to enter
the device directory for each camera in the Camera Configuration dialog.

= Alarms:
The Alarms option activates or deactivates the alarm notification for all cameras. Note that you will
have to set the alarm settings for the event types individually for each camera. Use the Camera Con-

figuration dialog to do this (see Setting up and Changing Alarm Notification).

User Management

In section user configuration of MxManagementCenter all users can be managed by an administrator. Three

types of users can be managed:
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B Administrator
® User
B Supervisor
For details see User Types, p. 245.

MxManagementCenter

User Configuration lda8-112-21 7 G @

= R R R RN RN R RN R AT PrraER IR INRy

User Management

Name Diego Maradona
Supervisor Configuration o »
Type User
=z
° + o Active
1 . Admin Password
Password

n Diego Maradona
Confirm Password

n Erling Haaland

Expires Never

Auto Login @ Force Change on Next Login

Force Complex Password

Logout Admin Login
-

Weekly Profile 24 Hours
Invert

Edit weekly profiles..

Logout

Logout on Inactivity Never

User Rights
Change Password
Camera Groups
Live

Research

Event Handling
Device Switching

Application Usage
P g RN RE AR

Fig. 116: Users settings

To open the User Configuration section click on . @ in the header bar.

Adding Users

Click on the g&l icon @ to add a user.
2. Enter the corresponding user name.

3. Select the user type: User, Administrator or Supervisor.

NOTE! The user type is set to User by default.

4, Enter a password and confirm it.

5. The Force Complex Password option ensures that users can only set secure passwords.

NOTE! A secure password has at least eight characters, consists of lowercase and uppercase letters,
including at least one special character, one digit and one character. Furthermore, it cannot be one of

the last thirteen passwords used on this user account. If you are trying to set a password that does not

meet the criteria, a red frame around the text field will appear.

Further settings vary depending on the user type. For more details see: User Configuration, p. 240.
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Deleting Users

Click on the icon ® and then on @ next to the user you want to delete.

NOTE! The default Admin cannot be deleted

User Configuration

The User Configuration @ appears when adding a new user or when clicking on an existing user. For a
detailed description of the settings see User Configuration, p. 240

Auto Login

The Auto Login option @ allows you to select an user which logs in automatically when
MxManagementCenter is started.

User Management

Supervisor Configuration

Admin

Erling Haaland

Sascha

8
Diego Maradona
<
<

sers

Auto Login
Logout Admin

Fig. 117: Auto Login

Admin

Diego Maradona
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Supervisors

A supervisor can execute functions for which regular user do not have access rights. These functions can be
made available temporarily starting a Supervisor Mode. For a detailed description of the Supervisor Approach

and Supervised Rights see details see Supervisor Configuration, p. 245

Supervisor Configuration ®®

Supervisor Approach | six-gye-principle B

User Management ®@®
Stop on Inactivity Mever B

Supervisor Configuration
l Supervised Rights
Change Password

1 . Admin ﬁLive <

Research
Diego Maradona Event Handling ?
. Device Switchi b,
n Erling Haaland ekl
Application Usage >

n Sascha
Auto Login Diego Maradona »

Logout Admin

Fig. 118: Supervisor Configuration

1. Click on Supervisor Configuration® to edit the Supervisor settings (see Supervisor Configuration, p.
245).

2. In addition, you can specify after how many minutes of inactivity this user will be logged out auto-
matically.

NOTE! While a recording is being played back in Playback view or in Grid Playback, MxMC does not
automatically terminate the supervisor mode after the specified period of time.

3. Select the functions that can be accessed after entering the password.

User Configuration

The User Configuration is accessable via the User Management, p. 237 dialog. The settings vary depending on
the user type (see User Types, p. 245).

When adding a new user or clicking an existing user, the following settings can be edited:
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Basic settings

User Configuration )
Mame Diego Maradona

Type User
Active

Fig. 119: User basic settings

The following basic settings are available:

Name: Enter the user name as it should appear e.g. on the login screen.
Type: select the user type (see User Types, p. 245).

Active: Check to activate the user (default).

Password
Password
Password . i
Confirm Password senn

Expires Mevear

Force Change on Next Login

Force Complex Password ||

Fig. 120: User password settings
Password: Enter the login password.

Confirm Password: Repeat the password.
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Expires: Select a period after which the password must be renewed frequently.
Force Change on Next Login: Check if the password needs to be changed the next time the user logs in.
Force Complex Password: Check if the password must meet the following requirements .

Requirements for a strong password:

B At least eight characters

B |ncludes lowercase and uppercase letters

B |ncludes numbers

B |ncludes at least one special charactere.g.,! @ # 7 ]

B Cannot be one of the last thirteen passwords used on this user account.

NOTE! If you are trying to set a password that does not meet the criteria, a red frame around the text field
will appear.

Log in

NOTE! This section is not displayed when creating an administrator because the administrator always has
all rights and access to MxMC.

Login
Weekly Profile E-fl_ H-‘.‘rt_l_rﬁ B
Invert

Edit weekly profiles...

Fig. 121: Login

Weekly Profile: Select a Weekly Profile to allow the user to access the system only at the times specified in
the profile.

NOTE! The profile "24 hours" is set by default. This means the user always has access to MxMC.

Invert: Check to invert the access time which is defined in the selected weekly profile.

Edit weekly profiles: Click to create or edit Edit weekly profiles. A dialog opens with the options Weekly
profiles and Holidays. For details see Weekly Profiles, p. 247.
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Log out
Logout

Logout on Inactivity =~ MNever

Fig. 122: Logout

Logout on inactivity: Select after how many minutes of inactivity the user will be automatically logged out.

User Rights

Every user new has all possible user rights initially. Deactivate the rights that should not be available for a spe-

cific user in the User Rights section.

NOTE! This section is not displayed when creating an administrator because the administrator always has
all rights and access to MxMC.

User Rights

Change Password
Camera Groups
Live

Research

Event Handling

Device Switching

VVVVVVE

Application Usage
| 8 = |
Change Password: Check to allow the user to change his login password.
Camera Groups: Select the Camera Groups that the user should have access to.
Live: Select the functions the user should be able to use in Live mode:

® Talk

B |jsten
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® Camera PTZ
® Change Bandwidth

Research: Select the functions the user should be able to use in Research mode:

B Audio Playback

® Playback

B Smart Data Search View
® Histogram Bar

B Export

B |ive Recorder

Event Handling: Select the events the user should be able to handle:

B Confirm Alarms

B Confirm all Alarms

B Confirm and Comment Alarms

B Confirm and Comment all Alarms
® Change Event Filters

Device Switching: Select the devices the user should be able to switch:

® Doors
" Lights
® Hyperlinks

Application Usage: Select the modules of MxManagementCenter the user should be able to use:

® Header Bar

® Tool Bar

® Device Bar

® Camera Bar

® Group Bar

B Alarm Bar

® Export Bar

B MxThinClient Devices
B Clips

® Action Log

B Switch Environments
® Privacy Mode

® Al Camera App
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User Types

Administrator: An Administrator has all rights for configuring and using MxMC.

User: An User can be added by an administrator only. An regular user cannot configure MxMC. Depending on
user rights he can use the system,

Supervisor: A Supervisor can be added by an administrator only. As a Supervisor a user can execute func-
tions for which a regular user does not have the rights. He can temporally log in addition to a regular user e.g.
if recordings only may be seen based on the four-eye-principle. A supervisor doesn't have administrative
rights. See Supervisor Configuration, p. 245.

Also see User Management, p. 237.

Supervisor Configuration

The Supervisor Configuration is accessable via the User Management, p. 237 dialog. The settings vary depend-
ing on the user type (see User Types, p. 245).

Supervisor Configuration (=)
Supervisor Approach = six-eye-principle B

Stop on Inactivity Mever B

Supervised Rights
Change Password
Live

Research

Event Handling

Device Switching

W W W W WY

Application Usage

Fig. 123: Supervisor Configuration
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In the Supervisor Configurationthe following settings can be made:

Basic settings

The following basic settings © are available:

Supervisor approach: Select the Supervisor approach

® Disabled (default): Starting the Supervisor Mode is not possible

® four-eye-principle: Supervisor mode can only be started when a Supervisor logs in additionally to the
current user.

B six-eye-principle: Supervisor mode can only be started when two Supervisor log in additionally to the
current user.

Stop on Inactivity: Select the time period after which the supervisor mode should be automatically ter-
minated in case of inactivity.

Supervised settings

In the Supervised Rights section @ you can activate the functions that should be available in the Supervisor
Mode.
Change Password: Check to allow to change the password of the current user.

Live: Select the functions the user should be able to use in Live mode:

® Talk

B |isten

® Camera PTZ

® Change Bandwidth

Research: Select the functions the user should be able to use in Research mode:

B Audio Playback

B Playback

B Smart Data Search View
® Histogram Bar

® Export

B |ive Recorder

Event Handling: Select the events the user should be able to handle:

B Confirm Alarms

B Confirm all Alarms

B Confirm and Comment Alarms

B Confirm and Comment all Alarms

B Change Event Filters

Device Switching: Select the devices the user should be able to switch:
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® Doors
B |ights
® Hyperlinks

Application Usage: Select the modules of MxManagementCenter the user should be able to use:

® Header Bar

® Tool Bar

® Device Bar

® Camera Bar

® Group Bar

® Alarm Bar

® Export Bar

® MxThinClient Devices
® Clips

® Action Log

B Switch Environments
® Privacy Mode

® Al Camera App

Weekly Profiles

In the User Management, p. 237 you can select for a user a Weekly Profile to grant access to MxMC according
to profiles time schedule. The following steps describe how to edit Weekly Profiles and Holidays.

Editing Weekly Profiles

There are two predefined profiles available from the beginning: the Weekend profile (Saturday 00:00 to
Sunday 24:00) and the Working days profile (Monday 00:00 to Friday 24:00).
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e0ce ‘Weekly Profiles S~

Montag Dienstag Mittwoch Donnerstag Freitag 9 Sonntag

Nightshift

2

21:0
O

23.00
E K

Fig. 124: Weekly Profile Editor

To edit a Weekly Profile you have the following options:
Adding a Weekly Profile

1. Click on @.

2. Enteraname @.

3. Inthe time table ®
B define the desired active time blocks by dragging the mouse

B resize an active time block by clicking on the time block and then moving the borders accordingly.

® to move a block, dragit to the new position.
Editing a Weekly Profile
1. Select the profile @ .

® To change the name of an existing profile. Double-click on the name @ and overwrite it.

2. To modify the time schedule in the time table ®
B define the desired active time blocks by dragging the mouse

B resize an active time block by clicking on the time block and then moving the borders accordingly.

® to move a block, drag it to the new position.

B to delete a time block, select one first and then click on @ @ .
Deleting a Weekly Profile

1. Select the profile @ .
2. Click on the trash icon {mll ® .
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Editing Holidays

You can define holidays, which will be excluded from the Weekly Profile "Working Days".

o0 ® Weekly Profiles

weekly... [T Date |01.01.21
01.01.

24.12. o Repeat annually

312,

QQ

Fig. 125: Holiday editor

Adding a holiday

1. Enter or select the holiday date @ .
2. Check Repeat annually @ if required.

3. Clickongd ® .
Editing a holiday

1. Select the holiday @ .
2. Modify the holiday date @ .
3. Check Repeat annually @ if required.

Deleting Holiday

1. Select the holiday @ .
2. Click jmj © .
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Preferences

General program settings for MxManagementCenter can be changed in menu MxManagementCenter >

Preferences (Mac) or File > Preferences (Windows). Settings can be edited in the following sections:

General

Network
Software Update
Notifications
Monitoring
Audio

Data Volume
Caches
Snapshots

Live Recorder
Remote Control
Joystick PTZ

MxMessageSystem

Customization

Email Notification

Restore Defaults

Preferences

Language

English a

You will need to restart the application to apply the changes.

Behavior
Double-click for fullscreen.
Display Area
Scaled when resizing Camera/Group bar (needs application restart).
Scaled when resizing Alarm/Export bar (needs application restart).
Graphics Mode

OpenGL

Activate OpenGL to enable de-warping of hemispheric images. Deactivate OpenGL, if you observe
problems when displaying camera images.

Quality:  Normal B

Select the quality for scaling images. Higher quality may result in lower performance when displaying
many camera images at the same time.

Login
Do not show user list on login screen

This option hides the list of users, when logging in. The username has to be entered instead.

Apply Cancel

L

Fig. 126: General Settings

Language: Sets the program language. You may have to restart the software in order to apply your change.

Behavior: Deactivate this option to prevent that a double-click triggers the full-screen view on the main mon-

itor or on other monitors.

Display Area: If you are working with the Camera/Group bars or the Alarm/Export bars, you can change the

width of the bars. Use this option to automatically resize the display area in such a case.

Graphics Mode: Activate to dewarp hemispheric images. A prerequisite for the OpenGL mode is a graphics

card with OpenGL V2.1 support, since it performs the actual distortion correction of transferred hemispheric
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images. Deactivate OpenGL if your graphics card does not support this mode or if you experience problems

when displaying the camera images.

Login: Check Do not show user list on login screen to hide the user list on the login screen.

Network
@0 Preferences

General Proxy Server
Network -
Software Update _ ' No Proxy
Notifications System Proxy
Monitoring © custom Proxy
Audio
Data Volume Hostname: 10.10.0.10 Port: 8081
g::zils\ots User Name: IErIing Haaland| ]
Live Recorder Password: |cscescses
Remote Control
Joystick PTZ Select "No Proxy" to bypass your system proxy settings. Select "Custom Proxy" for a
MxMessageSystem manual proxy setup.

Customization
Email Notification

Restore Defaults

Fig. 127: Network

Proxy Server: Select the desired proxy here.

No Proxy, a direct connection will be established.

System Proxy will apply the proxy settings of the system, including the exceptions defined.
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Software Update

® 0 Preferences

General Software Update
Network

Notifications

Monitering Current version: 2.5.2b2
Audio

Data Volume
Caches
Snapshots
Live Recorder
Remote Control Last check

Joystick PTZ

MxMessageSystem 14. September 2021 12:12:26 CEST
Customization
Email Notification

You can search for new versions manually or automatically.

Check Now ]

Check for updates: = At application start B

Restore Defaults Apply Cancel m

Fig. 128: Software Update

MxMC can use the update feature to automatically search for new program versions. To do this, check the
Check for Updates checkbox and set the polling interval. The update function requires an Internet con-
nection.

The search for new versions can also be performed manually. To do so, click on Search Now. If a new pro-

gram version is available, you will see this here.
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Notifications

Preferences

General

Network
Software Update
Monitoring

Audio

Data Volume
Caches
Snapshots

Live Recorder
Remote Control
Joystick PTZ
MxMessageSystem
Customization
Email Notification

Restore Defaults

Alarms

Alarm Notifications:  pjsapbled

<
Alarm Sound: | pjarm
~

Alarm Size: |25%

Duration: ~

OV 0 L A

3s 1 min

Volume: -

0 100

Automatic alarm confirmation: = Never

Enable to get a message if a camera is sending an alert. You can alse set the melody,

duration and volume of the alarm sound.
Bell
Bell Sound: | plarm
Volume: TR AT

0 100

You can set the melody and the volume of the bell sound.

Apply Cancel

Fig. 129: Notifications

Alarms: In addition to the event notifications in the Alarm bar or the Alarm Info bar, you can set up an alarm

notification and/or alarm sound that signals new alarms. Enable Alarm Notifications to receive an alert.

Select the desired alarm sound and set its duration and volume.

Bell: When the bell is rung, a ringing notification is displayed. Select the desired ring tone for the notification

and adjust its volume using this option (see Operate Door Stations, p. 140).
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Monitoring
® 0 Preferences
General Lost Connection Detection
Network
So@are Update Play Sound: = Always off B Sound: Alarm
Notifications ™
e hi B
Audio Show Warning: =~ HiRes only
Data Volume Deadtime: 10 2| seconds
Caches
Snapshots Lost connections can trigger a sound or a visual warning after the specified deadtime
Live Recorder has passed.
Remote Ceontrol
Joystick PTZ 4 Action Log
MxMessageSystem
Customization Archive and start new action log every: = Week

Email Notification

You will need to restart the application to apply the changes.

Backup Path
/Volumes/DatafActionLog v 4

Backup path for Action Log to store readable versions. Leave blank to
disable.

Application Error Report

Show dialog to generate a service report after an unexpected quit.

_ Restore Defaults A@Iy . ] Cancel m

Fig. 130: Monitoring

Lost Connections: If the connection to a camera is lost (e.g., due to a network failure or changed camera
access data), the application can send a warning.
This is where you configure the warning. Activate the Lost Connection Detection checkbox and specify how

you want MxMC to react if the connection to a camera is lost.

® Play Sound: Select whether a warning sound should be played. With the HiRes only option, the warn-
ing sound is only played if the related camera is in HiRes mode (see Camera Configuration, p. 222).
B Sound: Select a sound to be played on connection loss.
® Show Warning: Select whether a warning should be displayed or not. With the HiRes only option, the
warning is only displayed if the related camera is in HiRes mode (see Camera Configuration, p. 222).
® Deadtime: Define how long the connection must be interrupted before a warning is triggered.
Action Log: MxMC can log any action, such as starting playback or export actions, activating the sound, etc.
This means that you can log all user actions and thus deliver the entire chain of events for legal purposes.
After enabling this feature, you must restart the application for the activation to take effect. The action log
can be accessed from the menu File > Action Log. The Action Log can e. g. be used for troubleshooting pur-
poses (see Action Log, p. 341).
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B Archive and start new action log every: specify the interval at which the action log is to be archived
and a new log is to be created.

® Backup Path: Optionally specify a backup path to store the action log in PDF and CSV format and as
encrypted MXL format. Leave the path blank to disable backup.

Application Error Report: After an unexpected program termination, a service report is usually created. If
you do not want this, uncheck the Show Dialog checkbox.

Audio

® O Preferences

General Microphone Sensitivity

Network

Software Update

Notifications

Monitoring Adjust the microphone sensitivity to improve the audio quality for hands-free talking.

Data Volume Intercom

Caches .
Snapshots © Hands-free Talking

Live Recorder Push to Talk

Remote Control Activate push to talk to switch to one-way talking and listening.
Joystick PTZ

MxMessageSystem

Customization

Email Notification

Restore Defaults Apply Cancel m

Fig. 131: Audio

Use the slider to set the sensitivity for recording the sound from the camera microphone. The default setting
has been optimized for Intercom connections and should only be touched in very noisy or very quiet door sta-
tion surroundings.

Hands-Free Talking and Push to Talk

The Hands-Free Talking option is activated by default. If the surroundings are very noisy or if intercom prob-
lems persist, you should try to use the Push to Talk option.
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Data Volume

® 0 Preferences

General Maximum Number of Events
Network

Seftware Update 25 B

Notifications

Monitoring Set the maximum number of events to avoid long loading times and to save storage
Audio space when initially loading event information.

Caches Maximum Time Range

Snapshots

Live Recorder 1 Week B

Remote Ceontrol

Joystick PTZ Set the maximum time range for events to avoid long loading times and te save storage
MxMessageSystem space when initially loading event information.

Customization
Email Notification

Restore Defaults Apply Cancel m

Fig. 132: Data Volume

Maximum Number of Events/Maximum Time Range: The number of events and the time range are con-
trolling how far into the past MxMC will look for event information after the next launch of the application.
The settings apply to the event counter in Live View and the event preview images in Events View. This

avoids long loading times and saves storage space when initially loading the event information.
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Caches
® o Preferences
General Playback Cache Sizes for MOBOTIX loT Cameras
Network
Software Update Camera playback: i
Notifications
Monitoring 32 MB 512 MB
Audio
Data Volume Recording path playback: B e ————
Snapshots 128 MB 4096 MB
Live Recorder Increase the cache sizes to improve playback performance. Higher cache sizes reduce
Remote Control available memory for other tasks.
Joystick PTZ
MxMessageSystem Event Images Harddisk Cache
Customization
Email Notification Cache Size: - -
128 MB 4096 MB Clear Cache

Increase the cache size to avoid reloading event images from the camera. Disable the
cache to prevent local storage of event images on your harddisk.

Restore Defaults Apply Cancel m

Fig. 133: Caches

Recording Path Cache Sizes: To improve playback performance, you can set the internal cache sizes for play-
back here. This applies to both playback via the camera and playback from a file server. Please be aware that
the cache size set here will reduce the available RAM for other processes, which in turn can influence the per-
formance of other applications.

Event Images Harddisk Cache: To load event images faster and reduce network load, you can increase the
disk cache for event images. If you do not want the system to save event images to disk, clear the Event

Images Harddisk Cache checkbox.
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Snapshots
® 0 Preferences
General Destination path
MNetwork - ,
Software Update /Usersfsascha.christmann/Pictures v
Notifications et - i R
Monitoring Destination path for hots. If this box is empty, the desktop will be used.
Audio ; Sait
Data Volume [isge Seings
Caches -
fiiL JPEC Cipg) B

Live Recorder
Remote Control Image type that will be used. Note that the quality cannot be better than in the original
Joystick PTZ ege-
MxMessageSystem

Customization
Email Notification

Restore Defaults Apply Cancel m

Fig. 134: Snapshot Images

You can save individual camera images as snapshot files. The settings allow to edit the destination path and

the quality for snapshot images. If you do not specify a folder, the files will be created on the desktop.
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Live Recorder

® O Preferences

General Destination Path
Network - )
Software Update /Users/sascha.christmann/Movies v d
Notifications ) ) '
Monitoring
Audio
Data Volume 4 Automatic Stop
Caches : .
Snapshots Stop recording after: 2 /2 minutes

Set the duration after which the recording will automatically stop.
Remote Control
Joystick PTZ
MxMessageSystem
Customization
Email Notification

Destination folder for the recorded clip. (Leave empty to use the standard location.)

Restore Defaults Apply Cancel m

Fig. 135: Live Recorder

If you observe a suspicious situation that you want to record, you can start a manual recording in Live view as
well as in Grid view. While you keep track of the situation in the live image, the images are recorded and
saved as an MXG file. Here you can configure where the clips are stored and how long they are recorded. If
you do not specify a folder, an MXG file will be created on the desktop.
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Remote Control

® 0 Preferences
General Remote Control
Network
Software Update Secure (SSL-encrypted)
Notifications A
Monitoring Port: 57536 .
s User name: Erling Haaland
Data Volume ser name: Erling Haalan,
Caches PasSWOrd: ssssss
Snapshots :
Live Recorder Set the parameters for the built-in HTTP server, so the application can be remotely
operated from a different machine.
Joystick PTZ
MxMessageSystem

Customization
Email Notification

Restore Defaults Apply Cancel m

Fig. 136: Remote Control

MxMC can be remote-controlled from other programs using HTTP requests. Activate this feature and set a
proper port if you want to use this feature. Click on one of the example links to see a list of executable com-
mands.
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Joystick PTZ

Preferences

General

Network
Software Update
Notifications
Monitoring

Audio

Data Volume
Caches
Snapshots

Live Recorder
Remote Control
MxMessageSystem
Customization
Email Notification

Restore Defaults

Screen PTZ Camera PTZ External PTZ

X Axis

~lInvert

Sensitivity:
Y Axis

Invert

Sensitivity:
Z Axis

[ Invert

Sensitivity: . /

You can adapt the joystick behavior to your personal needs. Select the PTZ type first, then
set the behavior for each axis.

Calibrate Joystick

It is recommended to calibrate the joystick before adapting its behavior.

Apply Cancel m

Fig. 137: Joystick PTZ

You can adapt the joystick behavior to your personal requirements. Start by setting the PTZ type, then set the

behavior for each axis.

PTZ Type

B Screen PTZ: The PTZ actions are taking place in the application. This means that only the visible

image section of the current live image is modified. Any zooming does not influence the recordings of

the current camera image that may be taking place.

® Camera PTZ: Zooming actions are executed on the camera and also influence the recordings unless

you are recording in full-image mode.

® External PTZ: If you are using the camera of a different manufacturer, you can set its joystick behavior

in this dialog.

Axes

® X Axis: Horizontal movement

® Y Axis: Vertical movement

® Z Axis: Zooming

Invert

Use this option to invert the joystick actions for that axis.
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Sensitivity

If the PTZ actions are reacting too slowly, you can increase the sensitivity. If the reactions are too fast, reduce
the sensitivity.

Progression

Click on the /) button to change the progression of the joystick movements. The default setting is linear pro-
gression.

Calibrate Joystick

If you use a external joystick, it must be calibrated with MxMC so that the control functions exactly in the cam-
era image (see Calibrate Joystick, p. 265General usage of joysticks, p. 196).

NOTE! If you use a MOBOTIX PTZ keyboard see MOBOTIX PTZ Keyboard integration into MxMan-
agementCenter, p. 196.

MxMessageSystem

® 0 Preferences
General Enable MxMessageSystem
Network
Softl\taare Update Network Adapter: = en9 (10.0.0.193) B
Notifications
Monitaring Broadcast Port: 19800 |2
Audio ;
Data Volume Passphrase: +esess
Caches
Snapshots

Live Recorder
Remote Control
Joystick PTZ
Customization
Email Notification

Restore Defaults Apply Cancel

Fig. 138: MxMessageSystem
This setting is currently required for the MxThinClient. Since the live camera images are switched to the MxTh-

inClient via the MxMessageSystem, you must first activate the MxMessageSystem here. Make sure that the

same parameters are set as in the MxThinClient.
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Customization

General
Network

Software Update
Notifications Select header color
Monitoring

Audio

Data Volume

Caches Select Font Color
Snapshots

Live Recorder

Remote Control Select logo
Joystick PTZ

MxMessageSystem

Customization

Email Notification

#| Activate Custom

You need to restart the application to apply the new styles.

Restore Defaults Apply Cancel OK

Fig. 139: Customization

This setting enables you to adapt MxMC optically to your needs. You can freely select the primary color of the
headers and the font displayed there. You also can add an individual logo.

Select header color: Click to select an individual header color.
Select font color: Click to select an individual font color.

Select logo: Click to select a graphic file to be displayed as individual logo in the header. Possible file formats
are .JPG, .PNG, .GIF
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Email Notification

® 0 Preferences
General 9 Activate email notifications
Network
Software Update .
Notifications Site: |MxMC Site [ Locat...
Monitoring
Audio Recipient Address |recipient@exampl...
Data Volume
Caches Mail Server
Snapshots
Live Recorder Secure (SSL-encrypted): | Enabled B
Remote Ceontrol S —
Joystick PTZ Address: ‘smtg_example.com
MxMessageSystem - 1
Customization Port: |1 A~ f
G
Authentication: = STARTTLS
Username: ‘.:s.ender@example...‘.
Password: \
Interval: 1h | T

Send test mail

_ Restore Defaults A@Iy . ] Cancel m

Fig. 140: Customization

With the EMail Notification Feature MxMC can send an EMail Message with the Health Check results of all con-
nected MOBOTIX loT cameras.

NOTE! The Background Alarm Feature of the related MOBOTIX loT camera must be activated (see Camera
Configuration).

Activate email notifications: When checked Email notifications will be sent .

Site: Enter a meaningful site name. It is used as the email sender name and in the email itself to identify the

MxMC installation if you are receiving emails from different MxMC installations.
Recipient Address: The email address the messages are sent to

Secure (SSL-encrypted): Enable or disable the message encryption via SMTPS.
Adress: Enter the mail servers address.

Port: The port used by the mail server.

Authentication: The authentication method used when contacting the mail server. This needs to be set to
STARTTLS when “Secure (SSL-encrypted)” is enabled.
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Username: the username of the email account from which the emails are sent, usually the senders email
address.

Password: The password for the users email account.
Interval: the interval in which Health Check data should be sent.

Send test mail: Send a test email to check if the mail server is configured correctly.

NOTE!
® The email’s subject is the summary of the Health Check data, listing how many cameras are in the fol-
lowing states:
B critical: major Health Check issues and communication / connection errors
® warning: Health Check warnings
B ok: everything is in order
B noreply: the camera did not answer the Health Check request within the timeout duration, cur-
rently 10s
® The content of the email is HTML formatted. It begins with the site, then the date of the Health
Check and the number of cameras checked, followed by the summary. The main part of the content

is a table containing the Health Check data for every camera checked.

Calibrate Joystick

If you use a external joystick, it must be calibrated with MxMC so that the control functions exactly in the cam-
era image.
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Calibrate Joystick

.éénera-l

Network
Software Update
Notifications
Monitoring

Audio

Data Volume
Caches
Snapshots

Live Recorder
Remote Control
MxMessageSystem
Customization
Email Notification

Restore Defaults

Preferences

Screen PTZ Camera PTZ

X Axis

Invert

Sensitivity:
Y Axis

Invert

Sensitivity:
Z Axis

Invert

Sensitivity:

You can adapt the joystick behavior to your personal needs. Select the PTZ type first, then set the behavior for

each axis.

' Calibrate Joystick o

It is recommended to calibrate the joystick before adapting its behavior.

MOBOTIX Keyboard detected.

Apply

Fig. 141: Calibrate Joystick

1.
2. Click Calibrate

Joystick. A notification appears.

3. Move all axes of your joystick, then click OK.

Warning

Please move all axes of your joys

calibrate it. Then click 'OK.".

OK

Cancel

Install your joystick according to the manufacturer's instructions.

tick to
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Components Settings

In the Component View, you can manage the following components:

® Cameras which are available in MxMC (see Camera Settings, p. 267).

® File Servers that are used to store video recordings (see File Server Settings, p. 276).

® Smart Data Sources (license required for general sources) from which you can read transaction data,

e.g. from MOBOTIX P7 Apps (no license required), POS systems or license plate recognition systems

(see Smart Data Sources, p. 282).

® MxThinClients, which allow you to display live images from MOBOTIX cameras on a monitor or TV set
with HDMI connection (see MxThinClient Settings, p. 285).

B Softbuttons can be used to switch additional devices or to send HTTP requests (see Softbuttons Set-

tings, p. 288).

Camera Settings

In the Camera section of the Components View cameras can be managed.

Cameras that are available in MxMC should be configured according to their intended use. Therefore open the

Camera Configuration dialog to enter and edit the camera data.

Cameras

[Ch axispiss7 19218102

@ mx10.2-83  10832.83

@ mx10-..2-132 1013.22.132

B
mx10-..8-137 10.13.218.137

mx10..-156  192.1..8100

@ mx10...-149 10.32.75149

0..6-96

@ mx10..05-6  10.32.105.6

@ mx10.6-50  1023.236.50

Smart Data Sources

108.32.83

1013.22.132

1013.218.137

10.32.24.156

10.32.75149

10.32.1056

10.23.236.50

MX-V4.6.0.83

MX-V4.6.0.12

MX-V..5-r1

MX-V7.3.0.53

MX-V7.318

MX-V5.7.0.52

Intern

ThinClients

B B E

B &

Softbuttons
Camera Settings

Name mx10-23-236-50
Connection Prote [Lelzle] M8 =

Serial Number  10.23.236.50
IP Address 10.23.236.50

Remote URL DynDNS
User Name admin

Password

Environment Settings e

Bandwith Settings

Recording Settings

Aarms

Show Live
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Adding a Camera

1. Click the icon ® to add a camera.

2. Configure the camera in the Camera Settings area @ .

NOTE!
For bulk configuration of multiple cameras hold the SHIFT key when selecting the cameras.

Cameras File Servers Smart Data Sources ThinClients Softbuttons

Multi Camera Settings

Name |
Connection Prot [filslz{elfh =

Serial Number

i adaress [

Remote URL DynDNS
User Name

Password |

M
[h axispias7  1921.8102 10000

mx10.2-83 1083283 1083283  MX-V46083

@. @ mx10-..2-132 1013.22.132 1013.22.132 MX-V4.6.012

@ mx10-..8-137 10.13.218.137 10.13.218.137 MX-V.5-r1

Lok mx0.-156  1921.8100 103224186 MX-V7:3053
@ mx10..-149 103275149 103275149  MX-V7.318

2
mx10..6-96 10.32.6.96 10.32.6.96 MX-V7.3.1.42

2 e 8 8 B 8 B &

—
mx10..05-6 10.32.105.6 10.32.105.6 MX-V7.3.1.42

@ mx10..6-50 10:23.236.50 10.23.236.50 MX-V5.7052

=

New C...a #10 100,00

=

Fig. 142: Bulk configuration of multiple cameras

Camera Settings

Camera Settings

Mame mx10-23-236-50
(oG (GLE( MOBOTIX -

Serial Number 10.23.236.50

IP Address
Remote URL
userName  EReT
Password .

Fig. 143: Camera settings
Name: The camera name is displayed automatically. If required, you can enter an individual name for each
camera.

Connection Protocol: In order for MxMC to be able to establish a connection to the camera, a suitable con-

nection protocol must be selected depending on the available interface of the camera manufacturer. If you
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have integrated the camera with the Welcome wizard, the corresponding protocol is used automatically.

When manually adding the camera, select the appropriate protocol. The following protocols are available:

B MOBOTIX: Select this protocol to establish a connection to a MOBOTIX IoT camera.

® MOBOTIX with Pelco-D: The requirements to use Pelco-D protocol are:
® MOBOTIX IoT Camera with MxBus or MxBus Module RS232

® A PT Head with Pelco-D support
B The serial interface must be activated and configured in the camera software (for the parameter
settings see the cameras reference manual the documentation of the pan and tilt head)
® MOBOTIX MOVE: Select this protocol to establish a connection to a MOBOTIX MOVE camera.
B ONVIF-S/G: Select this protocol to connect to an ONVIF-S/G compatible camera.
B Axis PTZ: Select this protocol to connect to a camera with Axis PTZ control.
B MOBOTIX Face Detect: Select this protocol to connect to a MOBOTIX P7 camera MOBOTIX Face Detect
App running.
IP Address: The IP address is either discovered automatically via Bonjour or it has been entered manually.
MxMC supports both the IPv4 and IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name)

when adding it to access the camera from outside the local network.

NOTE! Before you can access the camera from outside of the local network, you need to activate the

Remote option in the Environment Settings, p. 269.

User name, password: Access data that had been entered when adding the camera.

Environment Settings

Environment Settings

IrI ‘:
Environment e

Background Ala .

Remote .

S5L v

Banduwidth <

Fig. 144: Camera network environment settings
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Environment: Shows the current network environment. After starting the program for the first time, it shows
the standard environment. All existing network environments are shown in the blue bar. Click on the envir-
onment you want to use. Next, enter the network settings you want to use for this environment. To define

environments, see Network Environments, p. 215.

Background Alarms: An activated option means that the application maintains an active event stream con-
nection to the camera, regardless of whether or not MxMC is showing the live stream.

Using the event stream connection, the cameras will send event information to MxMC, which will show them
as alarms depending on the settings (see Adding Cameras, p. 75). You can deactivate this option if a per-
manent event stream connection is not required or even unwanted (e.g. due to high system loads on systems
with very many cameras or when using MxMC in low-bandwidth networks).

If this option has been deactivated, the application will only open an event stream connection if necessary,
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms
will only show for this camera, while the connection has been established. This option is deactivated by fact-

ory default.

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.

Remote: Activate this option if you want to access the camera from a remote location (via DynDNS).

SSL: Activate this option if you want to use an encrypted connection to the camera. By default, the con-
nection between MxMC and the camera is not encrypted. Note that HTTPS needs to be activated on the cam-
era (in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature

Overview.

Bandwidth: Select whether you want to get the images from the camera in HiRes or LoRes by default. The
values (frame rate, image size and image quality) used for HiRes and LoRes connections are set in section
Bandwidth Settings for MOBOTIX IoT Cameras and in section Connection Settings for MOBOTIX MOVE cam-

eras.
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Bandwidth Settings (MOBOTIX Cameras)

Bandwith Settings

Bandwidth Settings HiRes

SEINEELE R4l Unchanged =
Resolution Unchanged o

Image Quality Unlimited o

Bandwidth Settings LoRes

Frames per Second S
Resolution SVGA (800x600) =

Image Quality 80% i

Fig. 145: Bandwidth Settings (MOBOTIX Cameras)

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values:

® Frames per Second
® Resolution

® |Image Quality

Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)

CAUTION! In contrast to bandwidth settings of MOBOTIX cameras, changes to the media profiles of
MOBOTIX MOVE / ONVIF-S/G cameras are made directly on the cameras. Therefore, these changes affect all

applications that use these profiles.
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Connection Settings

Authentication Username Token

Protocaol RTP via TCP

Bandwidth Settings

[1+]
w

HiRes Profile

Video Encoder
Video Codec
Frames per Second

Resolution

Ll
e
Eal
e
Eal
W
Eal
L
Eal
W
Eal
W

Image Quality

Bandwidth Settings

LoRes Profile
Video Encoder
Video Codec
Frames per Second

Resolution

L]

Image Quality

Create MxProfiles o Transfer Changes o

Fig. 146: Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)

You can specify:

Authentication method: Select between
B Username Token
B Digest

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values
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® HiRes/LoRes Profile, which is defined as ONVIF-S/G profile on the camera:

® Video Encoder

® Video codec

® Frames per Second

B Resolution

® Image Quality
Click on Create MxProfile® to create a profile, which is optimized for a MOBOTIX environment of the cam-
era. By default, MxManagementCenter creates two profiles named MxHiQuality for HiRes and MxLoQuality

for LoRes.

Click on Transfer changes® to transfer changes on the loaded profiles to the camera.

Recording settings
Saved recordings can be accessed in a variety of ways, depending on the connection protocol.

With MOBOTIX cameras:

® Via camera (MOBOTIX cameras): The camera is handling access to the recordings.

® Local Storage Path: The camera is handling access to the recordings via a previously defined record-
ing path. Local can be defined in the program settings (Mac: MxManagementCenter > Preferences >
Live Recorder; Windows: File > Settings >Live Recorder).

® Local Path: Local path (recordings are accessed on the local computer).

® FileServer:File Servers are selectable when configured in MxMC (see File Server Settings, p. 276).

With MOBOTIX MOVE / ONVIF cameras:

® MOVE Recorder: Access to recordings via a previously defined MOBOTIX NAS. Access data can be
defined in the program settings (Mac: MxManagementCenter > Preferences > Live Recorder; Win-
dows: File > Settings > Live Recorder).

Alarms

NOTE! The alarm feature is not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera
Feature Overview, p. 9).

This section allows selecting the event types that will lead to an alarm if the corresponding event is triggered.
An alarm will be indicated at the following locations:

® Alarm Bar turns red or green (door bell), the alarm images are shown in the Alarm bar.

® Alarm Info Bar turns red or green (door bell) in the live images.

® Alarm Settings allow setting up visual and sound notifications for alerting (Mac:
MxManagementCenter > Settings, Windows: File > Settings).
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1. Click on Alarms.

Alarm Invert Public Holidays

<>

i:;jl MrActivitySensor

@ Video Motion

*

<3

@ Behavioral Detection

@ Shock Detector

By N -
&) Mumination

@ Microphonea

(@ Passive Infrared Detector

<3 o N

<>

(g:l Temperature

—
@: Internal Events

Message Events

<>

<3

@J Meta Events

<>

(S[D Signal Events
@ Time Events
@ Ringing

(@ Mailbox messages
Py

@ ) Droor Station

@ RFID Rejected
@ PIN Rejected

(:> Thermal Events

E@J Other

B O N X o 2

<3

=
-]
]
=
-z
-
-
&
3
*

<>

Fig. 147: Editing Alarm Notifications

2. Select the event types that should trigger an alarm.
3. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as
no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.
® To create new weekly profiles, click on [74. The Weekly Profiles dialog opens. Several predefined pro-
files are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).
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® To add a profile, click on| + |. Enter a description. Highlight the desired active times in the table. You
can resize an active time block by clicking on the time block and then moving the borders accordingly
It is also possible to move a block. Click on the block to select it, then drag the block to the new pos-

ition. To delete a time block, click on 8
® You can change the description of an existing profile. Right-click on the name and overwrite it.
4. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and highlight

the desired profile. The calendar icon turns white.
5. To easily invert the settings of the weekly profile, simply click on the calendar icon. For example, if you
have created a profile with opening hours and would like to activate the alarms for the closing times,

click on the calendar icon (33 to invert the profile. The icon turns red.

Sensor Settings (MOBOTIX Cameras)

NOTE! The sensor settings are available only for MOBOTIX Cameras with multiple optical sensors.

Sensor

Sensor state Mot bonded

Sensor Sensor 1 2
Sensor 1 Name  [EEL(dE]

Show Live

Fig. 148: Sensor Settings (MOBOTIX Cameras)

You can specify how the sensors are to be integrated in MxManagementCenter.

B Select sensor 1or2 @, to edit the sensor name.
B Select "Combined" @ to combine both sensors as one single camera to be integrated into MxMC.

B Click into the Preview field ® to set the recent video frame as preview image for the selected sensor.
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Get P7 Apps

All P7 apps available on a camera can be retrieved. The apps and related data (e. g. events) are then available

as Smart Data Sources (see Smart Data Sources, p. 282).

Get P7 Apps

Fig. 149: Get P7 Apps

NOTE! The feature requires at minimum camera firmware V7.3.1.54.

Camera Discovery

When new cameras are detected in the network they appear here.

Camera Discovery 1
@ Search

Type Mame Connection

-( mx10-32-4-98 10.32.4.98 t 3

Fig. 150: Camera Discovery

File Server Settings

Stored images can be accessed in two ways: Access via the camera or directly to a file server where the
recordings are stored. If access is to be direct, you can create recording paths here that can be assigned to

the cameras. (See Camera Configuration, p. 222).

276 / 346



Management

Components Settings

ThinClients Softbuttons
File Server Settings

Name MOVE Recorder
MxNAS_loT MOBOTIX NAS
HEse . MOBOTIX NAS (ONVIF)
MOVE Recordet MOBOTIX NAS (ONVIF) L

File Server #1 Network Share

T5-231P2 Network Share

[ CEC (O 10.100.100.100 ot (RN 0

Local Storage Path Local 1P address or DNS

User Name

Password

Quick Guides:
«NAS & E/ONVIF - Guide
+ NAS &IoT - Guide
Installation and Configuration
Open Device Finder Configure NAS QVR Pro Settings Recordin
Troubleshooting:
QNap Log Files QVR Pro Log Files

Download links:

« Container App
« QVRPro App

Adding a File Server

1. Click the icon ® and select a File Server type.

2. Configure the file server in the File Server Settings area @ .

Configuring File Servers

Name:
Enter a name for the file server here. Use this name to select the path in the Camera Configuration dialog as
recording path.

Type:

® Local: Contains a local folder on this computer or on a connected network drive. You can either enter
the folder path manually, drag&drop a folder to the text box or select the folder.

® Network Share: The program directly accesses a shared folder on a file server. In this case, you need
to enter the computer, the folder and the access data.

® MOBOTIX NAS: Data is accessed directly on a shared folder on a MOBOTIX NAS.

® MOBOTIX NAS (ONVIF-S/G): The ONVIF-S/G recordings are accessed by the QVR Pro video man-
agement software, which must be installed on a MOBOTIX NAS.
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Local

File Server Settings

Name Local Storage Path

The name of this path is displayed in the camera management
when choosing a recording server.

Local ®

Local: Uses a folder or a connected network drive on this computer.
Network Share: Directly accesses a shared folder on a different computer.
MOBOTIX NAS: Directly accesses a shared folder on a MOBOTIX NAS.
MOBOTIX NAS (ONVIF): Accesses ONVIF recordings on a MOBOTIX NAS.

/storage

Path: select the path that contains the recording folders created by the camera.

Network Share

File Server Settings

Name File Server #1

The name of this path is displayed in the camera management
when choosing a recording server.

Network Share -

Local: Uses a folder or a connected network drive on this computer.
Network Share: Directly accesses a shared folder on a different computer.
MOBOTIX NAS: Directly accesses a shared folder on a MOBOTIX NAS.
MOBOTIX NAS (ONVIF): Accesses ONVIF recordings on a MOBOTIX NAS.

File Server (IP) g XsXoXk|

IP address or DNS name of the computer with the share.
Directory RECORDINGS

Name of the share on the computer.
User Name MRX
Password eses

Access data for the network share.

File Server (IP): IP address or DNS name of the file server with the share.

Directory: Name of the share on the file server.

NOTE! Make sure that the path ends before the folder containing the factory IP address of the camera.

User Name/Password: Access data for the network share.
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MOBOTIX NAS

Data is accessed directly on a shared folder on a MOBOTIX NAS.

File Server Settings

Name

File Server (IP)

Directory

User Name

Password

File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.

MxNAS_loT

The name of this path is displayed in the camera management
when choosing a recording server.

MOBOTIX NAS

Local: Uses a folder or a connected network drive on this computer.
Network Share: Directly accesses a shared folder on a different computer.
MOBOTIX NAS: Directly accesses a shared folder on a MOBOTIX NAS.
MOBOTIX NAS (ONVIF): Accesses ONVIF recordings on a MOBOTIX NAS.

10.100.100.100

IP address or DNS name of the computer with the share.
recordmxiot

Name of the share on the computer.

Access data for the network share.

Directory: Name of the share on the MOBOTIX NAS.

NOTE! Make sure that the path ends before the folder containing the factory IP address of the camera.

User Name/Password: Access data for the MOBOTIX NAS.

MOBOTIX NAS (ONVIF)

The ONVIF-S/G recordings are accessed by the QVR Pro video management software, which must be installed
on a MOBOTIX NAS.
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File Server Settings

Name MOVE Recorder

The name of this path is displayed in the camera management
when choosing a recording server.

MOBOTIX NAS (ONVIF) <

Local: Uses a folder or a connected network drive on this computer.
Network Share: Directly accesses a shared folder on a different computer.
MOBOTIX NAS: Directly accesses a shared folder on a MOBOTIX NAS.
MOBOTIX NAS (ONVIF): Accesses ONVIF recordings on a MOBOTIX NAS.

R (15 10.100.100.100 2 d 8080 B Use SSL

IP address or DNS name of the file server.

User Name

Password e |

Access data for the file server.

User must be a member of the administrator group with full rights of the MOBOTIX NAS!

Use Expert Settings (ONVIF Access)

F1 ST (DB 10.100.100.100 21410260 B Use SSL

IP address or DNS name of the file server.

Access data for the file server.

User Name

Password

Fig. 151: MOBOTIX NAS settings

File Server (IP): IP address or DNS name of the file server.

User Name/Password: Access data for the file server.

Use Expert settings (ONVIF-S/G access): If special access data are required for ONVIF-S/G access, enter
them here.
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MOBOTIX NAS Configuration

MOBOTIX NAS Configuration

Quick Guides:
» NAS & MOVE/ONVIF - Guide
* NAS & loT - Guide

Installation and Configuration

Open Device Finder Configure NAS Qvr Pro Settings Recording Storage

Troubleshooting:

QNap Log Files QVR Pro Log Files

Download links:

« Container App

« QVRPro App

» Device Finder App - macOS

« 2Bay and 4Bay NAS Firmware
« 8Bay NAS Firmware

Fig. 152: MOBOTIX NAS Configuration

The following functions are available for configuring and maintaining a MOBOTIX NAS or MOBOTIX NAS
(ONVIF) system.

Quick Guides

Links to download installation or configuration manuals for MOBOTIX NAS systems

Installation and Configuration

® Open Device Finder: The Device Finder finds MOBOTIX NAS systems in the network, making initial con-
figuration easy.

® Configure NAS: Opens the web interface of the MOBOTIX NAS system with which you can configure the
NAS device.

® QVR Pro Settings: Opens the web interface of the video management software QVR Pro. This software
must be installed on the MOBOTIX NAS system first.

® Recording Storage Space: Opens the web interface of the MOBOTIX NAS system with the interface for
setting up the storage space for video recordings.

® Troubleshooting: Here you can download the log files of the MOBOTIX NAS system or the QVR Pro soft-

ware.
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® Download links: Links to useful resources for installation, configuration and maintenance.
Container App: You need the Container App to install the QVR Pro App on a MOBOTIX NAS system.
QVR Pro App: The software for managing recordings from MOBOTIX MOVE or ONVIF cameras on a
MOBOTIX NAS system.
Device Finder App - macOS: Use the Device Finder App to find MOBOTIX NAS systems in the network.
2Bay and 4Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.
8Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.

Smart Data Sources

With the MOBOTIX Smart Data System, transaction data, for example from POS systems or native MOBOTIX
IOT apps, can be linked to the video recordings of transactions in MxMC. Smart Data can extensively be com-

bined, searched and filtered (see Searching in the Smart Data Search View, p. 167).

NOTE! A license is required to activate the general Smart Data interface from which you can read trans-
action data, e.g. from POS systems or third party license plate recognition systems.

No license is required to use Smart Data from MOBOTIX IOT Apps.

File Servers Smart Data Sources ThinClients Softbuttons

Smart Data o +  Smart Data Settings

Q, Sea
LRGN FFLPRAM. plate

Enter the name of the cash point to be used in MxManagementCenter

De:

LPR Car Reader P7 App Show Results in Search e

P7 APP P7 App Smart Data Bar Settings

FFLPR_MMCR.vehicle P7 App Show in Smart Data Bar ¥

VaxOCRContainer.container P7 App Left Column z

FFLPRAM.plate P7 App right column [

VaxOCRUIC.uic P7 App Gaeas 0
VaxALPRADR.plate P7 App

VaxALPRMMC.vehicle P7 App

MobotixEventData P7 App

VT_Face.face P7 App

VaxALPR.plate P7 App

Fig. 153: Smart Data settings

Adding a Smart Data Source

1. Click the icon ® and select a Smart Data type.

2. Configure the Smart Data Source in the Smart Data Settings area @ .
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Configure Smart Data Sources

NOTE! For external Smart Data Sources (e.g. Cash Points) a license is required.

Edit the general settings and define how Smart Data should be displayed in the Smart Data Bar.
Smart Data Settings

LTy VaxALPRADR.plate

Enter the name of the cash point to be used in MxManagementCenter

Show Results in Search B

Smart Data Bar Settings

Show in Smart Data Bar ¥

Left column - ([T ©

Right oo (I

Fig. 154: Settings for Smart Data sources

283/ 346



Management

Components Settings

NOTE! To use MOBOTIX P7 Apps as Data Sources the minimum firmware version on the MOBOTIX loT Cam-
erais 7.1.2.24.

Follow these steps in the camera user interface to prepare the camera to run properly with the Smart Data
interface of MxMC:

1. Go to Admin Menu > Smart Data Configuration and click Add Smart Data source.
2. Enter the specific identifier for a P7 App - e.g.:

Vaxtor: VaxALPR.plate

FF Group: FFLPR.plate

Visage: VT_Face.face

Click Set.

Store and reboot the camera.

Go to Setup Menu > General Event Settings and enable Arming.

Click Set.

SO

Go to Setup Menu > Recording and select:
Arming = Enabled
Recording (REC) = Continuous Recording, 2 fps
8. Click Set.
9. Go to Setup Menu > Certified App Settings and check "Active"
10. Click "Set" button

General Settings

® Description
Enter a meaningful name for the Smart Data Source here. Under this name, the source can be iden-
tified and selected in the MxMC for research.

® Show Results in Search

Check this option if you want the data to be displayed in the search results (see Searching in the Smart
Data Search View, p. 167).

Smart Data Bar Setting

® Show in Smart Data Bar

Check this option if you want the data to be displayed in the Smart Data Bar.
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B Left Column

Select the data to be displayed in the left column.
® Right Column

Select the data to be displayed in the right column.
® Camera

Select the camera or camera group that provides recordings for the transaction data.

NOTE! The video source and the data source do not have to be identical.

MxThinClient Settings

MxThinClient devices allow displaying live images from MOBOTIX cameras on a monitor or TV set with HDMI
connection.

ThinClients

ThinClient Settings

Na MxThinClient10
ELLEIIT TI 10.7.242.178

1P Address 172.16.22.162

MxThinClient10

User Name admin

Password

Dis; S Live Image |

Camera Display 1

Advanced Settings of your ThinClient

Fig. 155: MxThinClient settings

Adding a MxThinClient

1. Click the icon @ .
2. Configure the MxThinClient in the Thin Client Settings area® .
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MxThinClient Settings

Edit the MxThinClient settings here.
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ThinClient Settings

Name MxThinClient10

Serial Number 10.7.242.178

IP Address 172.16.22.162
User Name

Password

Display Resolutic -
Camera Display v

Message system is deactivated.
Please enter a valid file server IP to access the settir

Advanced Settings of your ThinClient

ThinClient Discovery
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Fig. 156: MxThinClient settings

Name

Enter the name for the MxThinClient (no spaces).

URL

Enter the URL or IP address of the MxThinClient.

User Name

Enter the user name of the MxThinClient user here.

Password

Enter the password of the ThinClient user here.

Display resolution

Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.
Camera display

Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After

the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).

Softbuttons Settings

Softbuttons can be used to send HTTP requests to camera or other external devices. When editing Soft-
buttons, you can select an individual button icon for the hyperlink or set one button from which to run all

hyperlinks.

N MOBOTIX
il L ERER hittp://www.mobotix.com
F testhelp ATl Static Link T

w  MOBOTIX

:fr;—i Signal Output

Light Toggle amera Group ¥ All groups

¥ All cameras

¥ Intern

Fig. 157: Softbuttons settings
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Adding a Softbutton

1. Click the icon @ .
2. Configure the Smart Data Source in the Softbutton Settings area @ .

Configure Softbuttons

Edit Softbuttons here.

Softbutton Settings

Name PTZ Move Right
LRG0T ELT B fcontrol ?action=moveright

i Static Link

SSL ¥

R CE RN ETL T https://[2001:db8:10::1a]:16090
userName RO N
Password foeee |

Camera Group @ All groups

B All cameras
@ Intern

Show result L
Separate Button [ |

W Xp @ H B

Fig. 158: Settings for Softbuttons

® Name: Enter a meaningful name for the Softbutton.
® HTTP Command: Enter here the HTTP command to be sent to an external device or to a group of
devices.

289 / 346



Management

Components Settings

B Type: Select the type of HTTP Command. Available types are:
B Static Link: A full URL is required here, e. g. "https://www.mobotix.com")

® Camera Command: The HTTP Command is sent only to the selected camera.
B Group Command: The HTTP Command is sent to the selected camera group.
B SSL: Activate to use a secure connection.
® Host Name: The IP address of the network device to be connected. MxMC supports both the IPv4 and
IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

B User Name: This field is available only if Type "Static Link" is selected. If required enter a user name.

B Password: This field is available only if Type "Static Link" is selected. If required enter a password.

® Camera Group: Select the camera groups in which the Softbutton should be displayed.

® Show result: Check if the result of the HTTP request should be displayed in a separate browser win-
dow by clicking the Softbutton.

B Seperate Button: Check if the Softbutton is to be shown in the Toolbar instead of the Softbutton
menu.

B |con: Select an icon to be displayed with the Softbutton.

Predefined Commands

Predefined Commands are a collection of Softbutton functions with predefined names and HTTP Commands.
Predefined Commands

Mame

Show alarm falarm?text=
Play sound [sound
Maximiz... window  ffullscreen?
Maximize...controls [fullsize?
Maximize...d layout ffullview?

Show Camera

Show Image

Fig. 159: Settings for Softbuttons

To add a Predefined Command click on then configure the button (see Configure Softbuttons).
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Wizards & Tools

MxMC provides cross-system maintenance and security features, such as creating backup copies of current

camera configurations or checking and improving system security. This section provides an overview of the
currently available system functions.

NOTE! The system functions described below are not supported by MOBOTIX MOVE cameras and third-

party cameras that provide an ONVIF-S/G-compatible interface. For an overview of how the camera func-
tions differ, see Camera Feature Overview.

MxManagemeniCenter

Intern - mx10-32-6-96

O @D ) &

Reboot Devices Restore Devices Update Devices

@ © A

Initialize Door Station SSL Certificates

Camera Group

IXThinClient Devices

Clips & Recordings
{19k 7-16

Fig. 160: Wizards & Tools
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1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar and select
Wizards & Tools.

[ K ) MxManagementCenter

Live - mx10-10-38-40

...........................................

--------------------------------------

View SE\DC[;OI’\

Grid

Graphic

Live

E Playback

Grid Playback
Research

Smart Data Search

...........................................................................................

E Components

Ej Configuration

Fig. 161: Opening Wizard & Tools View

Select the related camera or camera group in the Device bar or the Camera/Group bar.
Select the desired function:

Maintenance Functions

Reboot Devices

When it is required to reboot a device, for example to fix network issues. Click Reboot Devices to do so. You

can determine which cameras are rebooted from the current selection of cameras or camera groups.

Back Up Devices
The current configuration of cameras or the cameras of one group are saved when you click Backup Devices.
You can enter a name for each backup. The name should be meaningful enough enabling you to quickly

select the desired configuration when you want to restore a configuration later on.

Restore Devices

The configurations you save when using Backup Devices can be used to restore a configuration, for example,
if a camera is no longer operational due to a problem with a configuration. Click on Restore Devices and
select the desired configuration.
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Update Devices

You can apply a software version to a larger number of cameras at one time. Download the desired software
version from the MOBOTIX download directory: www.mobotix.com > Support > Download Center > Mar-
keting & Documentation. Next, click Update Devices and open the *.mpl file. The new software will be
uploaded to the cameras. The cameras will automatically reboot when the update is complete.

CAUTION! The software you select to install must be compatible with all cameras in the group. Otherwise,
the update cannot be performed.

Reset Devices
Click Reset Devices in order to reset one or more cameras to the factory settings. In the process, you can
select whether or not security settings (user names and passwords) and network settings should be reset, as

well. The cameras will then automatically reboot.

NOTE! Project data will not be automatically updated when you reset the camera(s) to factory settings. You

will need to update them manually.

Security Functions

Secure System

This feature helps administrators when securing camera systems. It shows them exposed points of attack and

prevents unauthorized or unencrypted access to cameras.

To check system security and secure the system, see Checking System Security, p. 294.

Health Check

A MOBOTIX camera independently checks its system status permanently. The results of this check are avail-
able in the Wizards & Tools view by using the Health Check function.

Also see Health Check, p. 296.

SSL Certificates

SSL is the standard technology for securing an Internet connection by encrypting the data sent between a
website and a browser (or between two servers). This function allows an administrator to upload or create a

SSL certificate to the selected cameras.

Also see Managing SSL Certificates, p. 298.

Initialize Door Station

The door station wizard will guide you through the basic configuration steps of the selected door station.

Also see Door Station Wizard, p. 312.
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Checking System Security

After completing the basic configuration of the system, you can check its security. The Wizards & Tools, p.
291 view offers the Secure System wizard. It analyzes the security of the cameras and assesses their status
based on common best practices. If test criteria are not met, possible measures to protect the cameras are
provided.

NOTE!
The system security check feature is not available for MOBOTIX MOVE cameras and third-party cameras
that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see

Camera Feature Overview, p. 9.

Verifying Settings for System Security

1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the

Wizards & Extras view.

0@ MxManagementCenter

Live - mx10-10-38-40
..........................................................................................................
| | . |
[T TR AT N (XTI N

B023C516FF31 Sensor 1 @993C516FF31 Sensor 2

-----------------------------------------------------------------------------------------------------------

Ml [5] ereyback
Grid Playback
; Research
b & st Dsta Search

................................................................................

E Components

{ Configuration

--------------------------------------------

2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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MxManagementCenter

®
O Wizards & Tools - MOBOTIX MOVE

s 3 | " |
RN i [ITTT

9.192.9.173 m“ L mx19-10-38-40 @003(516FF31 Sensor 1 B083C516FF31 Sensor 2

I O T O T R O C TN R R

wices Update Devices Reset Devices

Haalth Check Secure Systam Initializa Door Station

& MOBOTIX MOVE

MxThinClient Devices
Clips & Re

3. Click Secure System. The following criteria are checked:
B Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is
easy for cyber attackers to guess the standard "meinsm" password.

® Enabled Public Access: If Public Access is enabled, a number of different camera functions can be
used without a password.

B Activated HTTP web server: It is possible for data, including user data such as passwords and images,
to be transmitted via the network without encryption when HTTP is used.

The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in
which cameras were not checked due to a connection error, for example.

Status Explanation
® Notsecured  There was at least one criterion that was listed as not secure.

7 Softwaretoo  Please check the camera software and update it, if necessary.
old

© Connection Check your network connection to the camera and perform the security check again.
error

@ Not supported The camera (s) cannot be analyzed or secured using the wizard.

@ Secured Camera is secure; no further action is necessary.
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Secure System

4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed
together with whichever of the three criteria that were fulfilled as well as the measures that need to be

taken to properly secure the cameras:

Criterion Explanation

Password  Changes the password of all user accounts on the cameras that use the standard “meinsm”
password. It also include ONVIF users whose passwords have never been changed.
Enter a new password and confirm it. A suitable password has at least eight characters. It can
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a
password that does not meet these criteria, a red frame appears around the text field. The
frame turns green once you have entered a valid password.
The new password is automatically entered in the MxMC project data.

SSL encryp- Disables camera connections via unencrypted HTTP and configures the cameras to accept

tion HTTPs connections only.
The TCP port and the SSL setting will be automatically updated in the MxMC project data, if

necessary.
The TCP port will not be updated for cameras that are connected via a remote URL. For

remote URL connections, you may need to change port forwarding in the router to the appro-

priate setting.
Please note that different services, such as network messaging etc., will no longer work when

you disable HTTP.

Public Disables access that does not require password entry to the web interface and the APIs of the

Access cameras.

5. Click on OK in the dialog box. The selected security measures will be performed. The security status for
the selected camera or camera group will be analyzed once again and the result for each camera is dis-

played.

Health Check

A MOBOTIX camera independently checks its system status permanently. The results of the health check are

available in the Wizards & Tools, p. 291 view.
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‘ene® MxManagementCenter

Assistenten & Extras - Treppenhaus 7 C @

T
< Health Check

Obersicnt 2 @ @

25-173
% % Aligemein: System Message
495 mx10-38-112 @ mx10-38-112 10.38.112 Aligemein: System Message
f| csemor General: System Message

0-12-22 2
mx10-12-225 1012225 General: System Message

Details - mx10-38-112 @
v 88 1.06

@Er mx10-10-49-30 g Umgebung Zustand der Umgebung.

Kameragruppen
» H8 Alle Kameras

» B8 2.06 » Aligemein Zustand des Basis-Betriebssystems.

Bildverarbeitung Zustand der Subsysteme fiir Bildgenerierung und -verarbeitung.

MxThinClient-Geréite k Netzwerk Zustand des Netzwerk-Subsystems

= ot
= NaciinClent Bildaufzeichnung  Zustand des Bildaufzeichnungs-Subsystems

Zustand der angeschiossenen Gerlte.

Clips & Aufzeichnungen
* B Gate

B4 Treppenhaus

........................................................................................................................................

Fig. 162: Health Check

1. Click on Health Check.
2. The camera-internal checking data is now queried and listed in tabular form.

The Health Check dialog provides a overview of the proper operation or functional status of your MOBOTIX
cameras. The Health Check is divided into two areas:

Area Explanation

Overview Summary of the examined areas of the polled cameras by means of a color-coded system status
report:
Red = error
at least one functional area signals an error condition.
Orange = Warning
one or more functional areas signal a warning.
Green = OK
all functional areas are working properly.
The overview area shows how many of the polled cameras are in an error state or warning state
@ . The table lines indicate the system health for each camera, including a summary of the error

messages and warnings for each scanned area @ .

Details Detailed listing of the system state of the camera in the checked areas, which is displayed by

clicking on the Camera bar in the overview area ® .
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NOTE! The Health Check is a background process. It can only collect data from cameras that are currently
connected, therefore the background Alarm Feature of the according MOBOTIX loT cameras must be activ-
ated (see Camera Configuration).

Managing SSL Certificates

SSL is the standard technology for securing an Internet connection by encrypting the data sent between a
website and a browser (or between any two computers). This function allows an administrator to upload or
create an SSL certificate to the selected cameras.

Upload an SSL certificate to a camera

1. Open the Wizards & Tools view, right-click on the navigation key in the Command bar.

[ K ) MxManagementCenter

Live - mx10-10-38-40

.....................................

i 3 ] y |
| Lo i5 L (TR
0.192.9.173 MOBOTIX MOVE ©003(516FF31 Sensor 1

-------------------------------------------------------------------------------------------------------

View Selection

Grid

Graphic

[& Live
E Playback

Grid Playback

......................................................................

------------------------------------------------------------------------------------------------------

17.06.19 16:17:18

2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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3. Click SSL Certificates. The SSL Certificate Wizard appears:

SSL Certificate

You have chosen the following camera to update the SSL certificate.
Click "Mext" to choose the SSL Certificate.

Status | Type Name Description

“® mx10-32-6-96 OK

4, If the status of the camera is OK click Next.

5. Click Upload to upload an existing SSL Root Certificate including the private key.

Do you want to upload or create a certificate authority?

Create
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6. Select an existing certificate, the private key and enter the certificate password.

Upload Certificate Authority

Select Certificate

nerkstatt/S5L-Certificates/testRootCertificate.0 ‘:' o

Select Private Key

ywerkstatt/SSL-Certificates/testPrivateKey.pem ‘:'

Enter Password

Verify data

7. Click Verify Data. If data verification was successful click Next.

NOTE!
If data verification fails check your certificate.
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8. Click Upload. A summary of successful uploads or errors appears and the camera will be rebooted. See

Summary about successful uploads and errors, p. 308.

Upload Camera Certificate

Are you sure you want to upload
the certificate to the selected
device? The camera will be
rebooted afterwards.
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Generate a SSL certificate

1. Open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the
Wizards & Extras view.

[ @ MxManagementCenter

Live - mx10-10-38-40 ?7C 0

R eeeaees

BORRER R R

1 & i - 2 L | TTTNTE
MOVE-10.192.0.173 MOBOTIX MOVE o - 0923(516FF31 Sensor 1 0003(516FF31 Sensor 2

L. a8
O o o O o

B v

mx10-23-236-50

View SEYCC(;GID

Grid

Graphic

Live

[D] piayback

Grid Playback
Research

Smart Data Search

E Components

-’@ Configuration

38-4@ Mo, 22.01.18 16

17.06.19 16:17:18

2. Select the desired camera or camera group in the Device bar or the Camera/Group bar.
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3. Click SSL Certificates. The SSL Certificate Wizard appears:

SSL Certificate

You have chosen the following camera to update the SSL certificate.
Click "Mext" to choose the SSL Certificate.

Status | Type Name Description

“® mx10-32-6-96 OK

4, If the status of the camera is OK click Next.

5. Click Create to create a new SSL Root Certificate including private key.

Do you want to upload or create a certificate authority?

Create
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6. Enter a Key Name and a Key Password for the private key and click Create and Save.

Create Private Key

Key Name

TestSSLkey

Set Key Password

Confirm Password

Create and save

7. After saving the private key click Next. The dialog Create Certificate Authority appears.
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8. Fill out at least the mandatory fields and click Generate Cert.
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Create Certificate Authority

Common Name® testRootCertificate

Country

(2 letter code) DE

State RLP

Locality Langmeil
Organization MOBOTIX AG

Unit Team Technical Docu

Email-Adress testemail@mobotix.com

Validity Duration* **

{in days) JGo0

* : Field is mandatory!

** : Validity Duration has to be equal or greater than 397 days.

ATTENTION

If there are other MxMCs in your project, save the certificate
now and distribute it!

Generate Cert Backup Cert
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9. Optionally you can create a backup of the SSL certificate. When clicking on Backup Cert, you can select a

directory to save the certificate file.

NOTE!
A backup of your certificate is recommended, e.g., if you need to distribute it on other

MxManagementCenter installations within your project.

10. Click Next.
11. Enter the certificate password you defined in Enter a Key Name and a Key Password for the private key

and click Create and Save., p. 304.

Upload Certificate Authority

Select Certificate

nerkstatt/S5L-CertificatesftestRootCertificate.0 "’ o

Select Private Key

ywerkstatt/SSL-Certificates/testPrivateKey.pem "’

Enter Password

Verify data

12. Click Verify Data. If data verification was successful click Next.

NOTE!
If data verification fails check your certificate.
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13. Click Upload. A summary of successful uploads or errors appears and the camera will be rebooted. See
Summary about successful uploads and errors, p. 308.

Upload Camera Certificate

Are you sure you want to upload
the certificate to the selected
device? The camera will be
rebooted afterwards.

Summary about successful uploads and errors

The certificate could not be verified

There is no matching root certificate in the MxMC “Certificates” folder.

Security Alert

You are accessing a device that uses a certificate signed by an unknown
autharity.

Trust this certificate when connecting to "10.32. 19,2297

View certificate information

Trust this time Always trust Don't trust
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The certificate hostname does not match the camera hostname

This can happen if the camera still has the MOBOTIX factory certificate but is connected using a different host-

name than the factory-supplied one.

Security Prompt

851 certificate verified but the certificate hostname does not match the camera
hostriame.

Trust this camera when connecting to "10.32. 24, 13177

View certificate information

Trust this time Always trust Don't trust

Four or more cameras report SSL errors.

When four or more camera connections report SSL errors at the same time a list of untrusted cameras is

shown.
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Security Alert
The following devices are using certificates that should not be trusted.

Type Mame URL Info

T wmis10-14-28-43 10742843 ()

Yo M26.10-22-68-36 10.2

'|"|E'.E.| M73_10-32-19-237 10.32.19.

Sl

2-10-129 10.22.10.129
570 10-23-9-171 10.23.9.071

Select camera to view certificate information.

Trust these certificates when connecting?

Trust this time Always trust Don't trust

Display the SSL certificate information

If an SSL error occurs it is now possible to display detailed certificate information.
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Certificate information

Field Yalue

Hostname(s) 10.22.10
Common Name mx10-22-10-30
Country DE

Issuer Mame MX-Produktion5ubCA-1
Locality

Organisation MOBOTIX AG
Organisation Unit MX-PK]

State Rheinland-Pfalz
Email-Adress

Valid from

Valid to

Duration 7300 days

SSL error on one camera

1. Click View certificate information.
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List of multiple cameras with SSL errors

1. Select a camera in the camera list.
2. Click on the exclamation mark icon on the right @ . The related certificate information appears.

Door Station Wizard

The Door Station wizard will guide you through the basic configuration of a selected door station.
Also see:

® Door Station Settings, p. 209
B QOperate Door Stations, p. 140

Basic requirements
B Make sure that the devices run the latest software otherwise the configuration could fail.
B Additional door stations (including S1x, S2x cameras) to be configured must be listed in the Device

Bar.
B Apply the default password "meinsm" to all door stations. To do so, you can use the Secure System

Wizard.
B Apply the default password "meinsm" to MxDisplay devices to be configured.
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Step by step

1. To open the Wizards & Tools view, right-click on the navigation key in the Command bar. Select the
Wizards & Extras view.

[ ] [ ] MxManagementCenter

Live - mx10-10-38-40 ? G @

L O L L LN ERE LR R TR

1 1 ] ]
I Il
0003C516FF31 Sensor 1 8003CS16FF31 Sensor 2
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& 0003C516FF31
Camera Groups

View Selection
Grid
Graphic
Live
[G] Praypack
Grid Playback
Research
" Smart Data Search

.....

E Components

"j Configuration

------------------------------------------------------------------------------------------------------------

17.06.19 16:17:18

2. Select the related door station (camera) Device bar or the Camera/Group bar and click Initialize Door
Station. The Door Station Wizard starts up.
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3. Read the introduction text and make sure you meet the basic requirements for the further configuration.

Click Continue.

[ XX ) #A Initialize Door Station

MxManagementCenter

Introduction

Lorem ipsum dolor sit amet, consectetur adl ing elit. Nullam semper nec nulla non feugiat. Ut viverra eros ante, eget faucibus purus placerat ut.
Proin pellentesque non metus id mollis. Vivamus pulvinar in massa et faucibus. Maecenas posuere viverra erat ac pellentesque. Ut ornare, lacus quis
dapibus lobortis, tortor tellus rutrum massa, id bibendum erat tellus quis dui. Morbi laoreet aliguam ipsum ac tempor.

Mauris posuere, metus at ultrices interdum, neque quam congue erat, quis iaculis tellus neque eu est. Aliquam tristique scelerisque diam, non
elementum elit tincidunt id. Maecenas id consectetur turpis. Ut convallis nulla enim, nec consectetur erat fringilla rhoncus. Nunc risus dui, pharetra
nec lobortis nec, rhoncus a ante. Sed eros nulla, tincidunt vitae semper quis, gravida sit amet nunc. Aliquam erat volutpat. Phasellus at porta est, ac
efficitur lectus. Etiam laoreet sapien vitae efficitur ultrices. Maecenas porttitor metus id justo commodo, vel suscipit velit mollis. Praesent feugiat est
vel orci tincidunt, sed tincidunt elit cursus. Nulla nec nulla consequat, bibendum diam at, dictum tellus. Cras ac bibendum nisl. Ut ipsum neque,
pharetra et urna ut, hendrerit porta erat. Vestibulum id mi lorem. Nam ultricies leo id dignissim rutrum.

Step1of6

Mobotix « Kaiserstrasse D-67722 Langmeil « info@mobotix.com « www.mobotix.com
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4. Select the devices you want to configure and click Continue. The Selected devices will be configured.

5.

This can take while.

NOTE! :

Only devices with suitable software can be selected. The Master door station cannot be deselected.

Device Selection

#A Initialize Door Station

MxManagementCenter

Please select the devices to include in the following configuration process.

Model

£Ha

Step3of 6

Check the summary of the configured devices and click Continue.

Summary

Name Host

mx10-8-115-5 10.8.115.5

mx10-22-11-106 10.22.11.108

mx10-23-146-230 10.23.146.230

MxDisplay10-7-5-50 10.7.5.50

Master Status

v oK
oK
oK

0K

Mobotix « Kalsarstrasse D-67722 Langmail « info@maobatix.com « www.mobotix.com

#4 Initialize Door Station

MxManagementCenter

Short explanation of the summary page

Model

g
Bs

Step S of &

Name Host

mMx10-8-115-5 10.8.116.6

mx10-22-11-106 10.22.11.108

MxDisplay10-7-5-50 10.7.5.50

Mobotix « Kalsarstrasse D-67722 Langmail

Master Status
v oK
oK

0K

+ info@maobatix.com « www.mobotix.com
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6. Follow the next remaining configuration steps and click Finish.
B |nitialization of door station RFID module

B Add MxBell as remote Station

® Define all relationships between addresses and remote stations
B Configure I/O wiring

® Final configuration of all door station (cameras)

B Setup MxDisplay

[ XX ] #A Initialize Door Station

MxManagementCenter

Further Actions

Explain the further neccessary actions to the user

StepBof 6

Mobotix « Kaiserstrasse D-67722 Langmeil « info@mobotix.com « www.mobotix.com

Licensing

Activation or purchase of a license is required to use certain features. This includes licenses for the following

features:

B Smart Data: industry-specific solutions and special features, such as integration with POS systems.

® H.264 De-/Encoder: for displaying and exporting videos in H.264 format.

B Cameras from third-party manufacturers: Integrate cameras from other manufacturers than

MOBOTIX.

® Advanced Config: Collection of functions for simplified configuration of cameras.
For license activation see MxMC Licensing, p. 317.
For camera models from the MOBOTIX P7 series there is the possibility to use apps. Apps, for example, offer
extended functions for image analysis which may be supported by algorithms of artificial intelligence. Various
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apps are pre-installed on the camera and must be activated for use with a valid license key (see Camera App
Licensing, p. 319).

MxMC Licensing

Activate licenses

After purchasing and receiving the activation IDs, enable them in MxMC as follows:

1. Open the License Management (Window > Licenses menu item) and click on Activate Licenses.

MxManagementCenter

Lizenzen

Produky

< Lizenzen aktivieren
Mit Aktivierungs-1D

Activate license

Enter a valid activation ID and establish the number of licenses that will be installed on this computer.

3. Clickon if you want to license an additional product. Enter the corresponding activation ID in the new
line and enter the number of desired licenses.

4. Clickon  to delete aline.
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5. When you are finished entering all activation IDs, click on Activate. MxMC connects to the license server
for activation. It needs to establish an Internet connection.

00 Lizenzen

MxManagementCenter

< Lizenzen aktivieren
Mit Aktivierungs-1D

Geben Sie Ihre Aktivierungs-IDs und die jeweils auf diesem Computer zu verwendende Anzahl von Lizenzen ein.

544c-de12-se3d-232w-1342-fred-2d3d-4nb5 [l 1

878-60c3-6454-3456-9db2-3eds-edbe-0daw [ 1 )

Mit Funktionalitdtsantwort-Datei

Wenn Sie bereits eine Funktionalititsantwort (<Gerite-ID>.bin) erhalten haben, kénnen Sie diese hier laden.

Funktionalitdtsantwort-Datei laden...

Mobotix » Kaiserstrasse D-67722 Langmell « info@mobotix.com s www.mobotix.com

Fig. 163: Entering license key
B Successful activation
If the activation was successful, you will need to sign in again to apply the changes. Alternatively, you

can also return to License Management

B Activation failed (no Internet connection)
MxMC connects to the license server for activation. It needs to establish an Internet connection. An
error message appears if there is no Internet connection. It will then save an offline request file (*.lic).
This file enables the partner/installer from whom you purchased the licenses to generate a func-
tionality response (.bin file) on the license server. If you have received such a response, open the Activ-
ate Licenses window (Window > Licenses > Activate Licenses menu). Click on Load Functionality
Response File.
Once you have loaded the functionality response file, you will need to log back in to apply the

changes. Alternatively, you can also return to License Management
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Managing Licenses

08 Lizenzen

MxManagementCenter B 7

Lizenzen
Produkt Ablaufdatum

MxMC Advanced Maintenance And Service Sa. Apr. 13 2019 Unlimited

MxMC Demo VM Mi. Sep. 12 2018 Unlimited

MxMC POS Cash Register Permanent 3

Aktualisieren | | Lizenzen aktivieren

Mabotix « Kaisarstrasse D-67722 Langmeil « info@mobatix.com « www.mobotix com

Fig. 164: Managing licenses

You can view a list of all licenses that have been activated on this computer in License management. To open
the License Management, click on Window > Licenses in the Menu bar.

Designation Explanation
Product Name of the licensed function.

Expiration  This column indicates whether the license is temporary and when the licensing period may

date end.
Number Number of licenses that were purchased for a product.

Device ID Unique identifier that is determined by MxMC for the used device. Note the device ID and keep
it accessible if you should run into any problems during licensing.

Synchronizing licenses with the server

When launching the program, it does not automatically compare the licenses on the computer with the
license server. For this reason, you need to click on Update to reload the licenses from the server.
Updating licenses

To update temporary licenses, click on Activate Licenses. The dialog box used for updating/activating

licenses is shown.

NOTE! You need administrator rights to synchronize and update licenses.

Camera App Licensing

For camera models from the MOBOTIX P7 series there is the possibility to use apps. Apps, for example, offer

extended functions for image analysis which may be supported by algorithms of artificial intelligence. Various
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apps are pre-installed on the camera and must be activated for use with a valid license key.

There are two ways to activate Camera Apps:

® Online Activation, p. 320 is recommended if the camera is connected to the Internet.

B Use Offline Activation, p. 322 if the camera is not connected to the Internet.

Online Activation

NOTE! For online activation, the camera must be connected to the Internet and the license server must be
reachable. Alternatively, you have the option to activate the camera offline (see Offline Activation, p. 322).

After receiving the activation IDs, activate them in MxMC as follows:

1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.

-
| NN ) Camera App Licenses

MxManagementCenter

Cameras

mx10-32-24-156 [2001:db8:10::1al:16090 10.32.24.156

Mobotix - Kalserstrasse D-67722 Langmell - Info@mobotix.com - www.mobotix.com
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3. An overview of the licenses installed on the camera may be displayed. Click Activate License.
[ =X ) Camera Licenses

MxManagementCenter

< Camera License Status: mx10-251-1-235

Expiration

Serial Number: 10.23.9.171

MxWheelDetector Permanent Unlimited
iot_plugin_a Permanent Unlimited
iot_plugin_b Permanent Unlimited
iot_plugin_c Permanent Unlimited
iot_plugin_d Permanent Unlimited
fot_plugin_e Permanent Unlimited
fot_plugin_f Permanent Unlimited
iot_plugin_g Permanent Unlimited
fot_plugin_h Permanent Unlimited

ot_plugin_i Permanent Unlimited

Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

NOTE! If necessary, correct the time set on the camera.

4. Enter a valid Activation ID and specify the number of licenses to install on this computer.

5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID
and the number of licenses you want.

6. If necessary, click to remove a line.

7. When you have entered all Activation IDs, click Activate License Online. During activation, MxMC con-
nects to the license server. This requires an Internet connection.

MxManagementCenter

< Activate Camera Licenses: M73 10-32-0-62

Sarial Number: 10.32.0.62

via Activation ID

Please enter your Activation IDs and for each Activation ID the corresponding quantity of licenses that you want to use

we23-4chf-as23-4bf2-bB72-0cB4-2935-78de +
ec90-4c5f-cfd0-4bf2-b872-9c84-2935-6120 W}

Download Capability Request File Activate License Online

Via Capability Response File

If you have already created or received a capability response file (<DevicelD=.bin), you can load it here.

Load Capability Response File...

Mobotlx « Kalserstrasse D-67722 Langmell « info@mobaotix.com « www.mobotlx.com
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Successful activation
After successful activation, a new log in is required to apply the changes. Alternatively, you can return to

license management .

Offline Activation

NOTE! If the camera is connected to the internet Online Activation, p. 320 is recommended.

For offline activation, the partner/installer from whom you purchased the licenses can generate a capability

response (bin file) on the license server to activate their licenses.

1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.

-
[ N | Camera App Licenses

MxManagementCenter

Cameras

mx10-32-24-156 [2001:db8:10::1al:16090 10.32.24.156

Mobotix « Kalserstrasse D-67722 Langmeill - Info@mobotix.com « www.mobotix.com

3. An overview of the licenses installed on the camera may be displayed. Click Activate License.
L= Camera Licenses

MxManagementCenter
< Camera License Status: mx10-251-1-235 Serisl Number; 1023001

MxWheelDetector Permanent Unlimited
iot_plugin.a Permanent Unlimited
iot_plugin_b Permanent Unlimited
lot_plugin_c Permanent Unlimited
iot_plugin_d Permanent Unlimited
fot_plugin_e Permanent Unlimited
iot_plugin_f Permanent Unlimited
iat_plugin_g Permanent Unlimited
iat_plugin_h Permanent Unlimited

fot_plugin_j Permanent Unlimited

| ) Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

NOTE! If necessary, correct the time set on the camera.
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4. Enter a valid Activation ID and specify the number of licenses to install on this computer.

5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID
and the number of licenses you want.

6. If necessary, click to remove a line.

7. When you have entered all Activation IDs, click Download Capability Request File (.lic). and send it to

your partner/installer. This file allows the partner/installer from whom you purchased the licenses to gen-
erate a capability response file (.bin ) on the license server.

MxManagementCenter

< Activate Camera Licenses: M73 10-32-0-62

Serial Number: 10.32.0.62

via Activation ID
Please enter your Activation IDs and for each Activation ID the corresponding quantity of licenses that you want to use

we23-4c5f-as23-4bf2-b872-0c84-2935-78de +

c90-4c5f-¢fd0-4bf2-b872-9c84-2935-6120 (]

Download Capability Request File Activate License Online

Via Capability Response File

If you have already created or received a capability response file (<DevicelD>.bin), you can load it here.

Load Capability Response File...

Mobotix » Kaiserstrasse D-67722 Langmell » info@mobotix.com « www.mobotix.com

8. Click Load Capability Response File and follow the instructions.

Successful activation

After successful activation, a new login is required to apply the changes. Alternatively, you can return to

license management .

Manage licenses

In the license management screen, you get a tabular overview of all licenses that have been activated for a
camera.
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1. Select from the menu Window > Camera App Licenses.
2. Select the camera on which you want to license apps and click Select.

-
2] o Camera App Licenses

MxManagementCenter

Cameras

mx10-32-24-156 [2001:db8:10::1al:16090  10.32.24.156

Mobotix « Kalserstrasse D-67722 Langmeill - Info@mobotix.com « www.mobotix.com

3. An overview of the licenses installed on the camera may be displayed.
L =X ) Camera Licenses

MxManagementCenter
< Camera License Status: mx10-251-1-235 Serial Number: 10.23.0.171

MxWheelDetector Permanent Unlimited
iot_plugin_a Permanent Unlimited
iot_plugin_b Permanent Unlimited
lot_plugin_c Permanent Unlimited
iot_plugin_d Permanent Unlimited
fot_plugin_e Permanent Unlimited
iot_plugin_f Permanent Unlimited
iat_plugin_g Permanent Unlimited
jot_plugin_h Parmanent Unlimited

fot_plugin_j Permanent Unlimited

' ) Camera time is incorrect. Please reset your camera time before activating Licenses

Activate License

serstwasse D-67722 Langmell » INfO@MOBOLIX,COM » WWW.MGBORX.com

Field name Explanation

Name Name of the licensed app.

Product The feature of the licensed app

Expiration the time limit of the license

Quantity Number of licenses purchased for a product.

Serial num- Unique identification determined by MxMC for the device used. If problems occur during licens-
ber ing, please have the device ID ready.
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Synchronize licenses with server

When the program starts, there is no automatic comparison of licenses between the computer and the

license server. Therefore, click on Update to reload the licenses from the server.

Update licenses

to update temporary licenses, click Activate Licenses. The dialog for updating/activating licenses opens.

NOTE! You need administrator rights to synchronize and update licenses.

Integrating MOBOTIX Storage Devices

With MxManagementCenter, you can access a MOBOTIX storage device connected to the USB port with record-
ings in MxFFS format (see Adding Devices and Sources). To do this, MxManagementCenter must be started

with administrator rights. Without administrator rights, the storage medium will not be recognized.

NOTE! To remove an SD card from a MOBOTIX camera, refer to the camera manual.

MAC

The following procedure assumes that the logged on user is allowed to manage the computer or has the

required administrator privileges. Otherwise, contact your system administrator.

1. Connect the MOBOTIX storage device with a USB port to your MAC.
2. Start the Terminal App (e.g. via the spotlight search with CMD+space key).

Q Terminal.app =l

TORTREFFER

1 Terminal.app [
ANDERE

B terminal-server.htm-1300521747v....

M terminal-server.htm-1554267005V....

B Terminology.jsx
MAIL & NACHRICHTEN

[ Demo Lizenzen

[ Termin fiir FortbildungsmaBnahme Termin Ell. app
[ Termin "Allgem. Sales Themen" Version: 2.8.2
-] Antwort Termineinladung (Akzeptie...

[Confluence] PM Requirements >...

WEBSITES Art  Programm
ﬂ gamestar.de GréBe 9,7 MB
Erstellt 06.01.18
B youtube.com Gedndert 06.01.18
ENTWICKLER Zul. gedffnet 22.10.19

Fig. 165: Starting the Terminal App
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3. Enter the following command line: sudo "/Ap-
plications/MxManagementCenter.app/Contents/MacOS/MxManagementCenter". Confirm with

ENTER.
4. Enter the password for the current user. Confirm with ENTER.

@0 e © sascha.christmann — MxManagementCent - sudo — 82x24

Last login: Tue Oct 22 16:58:46 on ttys@QeR _!:
[mc-sachi:~ sascha.christmann$ sudo "/Applications/MxManagementCenter.app/Contents/
MacOS5/MxManagementCenter"

|Password:

QML debugging is enabled. Only use this in a safe environment.

Terminal

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new

installation.

4. Start a new project.

Q [ +

Gerate hinzufiigen Prajekt affnen Meues F'ru:uj-_h.‘t starten

4 [4 [4

C importieren MxEasy importieren MXU importieren

MxMC in administrator profile

5. Open the editing mode by clicking on  at the bottom of the device bar.
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6. Click .The Add and Import menu opens.

F k|

Hinzufligen )

Suchen
Manuell

E Clip-fAufzeichnungsgruppe

E MxThinClient

Fig. 166: Add / Import menu

7. Click MXFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS

format.

NOTE! This process can take several minutes for data carriers with large storage volumes.

Windows

The following procedure assumes that the logged on user is allowed to manage the computer or has the

required administrator privileges. Otherwise, contact your system administrator.
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1. Connect the MOBOTIX storage device with a USB port to your MAC.
2. Right-click the executable file or a shortcut of the MxManagementCenter.

MNeu erstellen

Donnerstag

Grobe andern

'.’_'h ) Mehr

)
Paint 3D

Von "5tart” l6sen

]ﬁ[ Deinstallieren

e O

Microsoft Edge  Skype

B 2

L2 Zur Suche Text hier eingeben

Fig. 167: Windows start menu

L Als Administrator ausfih renk

D Dateispeicherort &ffnen
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3. If necessary, activate the User Account Control query with Yes.

Benutzerkontensteuerung >

Mochten Sie zulassen, dass durch diese App
von einem unbekannten Herausgeber
Anderungen an lhrem Gerat vorgenommen
werden?

MxManagementCenter.exe

Herausgeber: Unbekannt
Dateiursprung: Netzwerklaufwerk

Weitere Details anzeigen

la Nein

Fig. 168: Windows User Account control

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new
installation.

4. Start a new project.

O R +

Gerate hinzufiigen Projekt affnen Meues F'rn:njn_.kt starten

4 4 [4

MxCC importieren MxEasy importieren MXU importieren

MxMC in administrator profile

5. Open the editing mode by clickingon  at the bottom of the device bar.
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6. Click .The Add and Import menu opens.

F k|

Hinzufligen )

28Y Suchen

2l Manuell

E Clip-fAufzeichnungsgruppe

E MxThinClient

Add / Import menu

7. Click MxFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS

format.

NOTE! This process can take several minutes for data carriers with large storage volumes.
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MxManagementCenter allows you to configure MOBOTIX cameras directly. This section

addresses administrators and system installers. It provides an overview of the operation

of the Configuration view and the Configuration bar and provides information on how to

operate the graphical elements.

Topics

Configuration: Over-

view, p. 332

Graphical Operation,
p. 340

Explanation

Overview of the structure and working with the Configuration view

and the Configuration bar

Explanations of how to operate the graphical configuration ele-

ments.
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Configuration: Overview

The Configuration view you to directly access and make settings for MOBOTIX cameras. In general, the view is
divided into a Basic Settings section and an Advanced Configuration section containing Configuration
Groups.

The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.

The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the

camera or the camera group.

NOTE! The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Cam-

era Feature Overview, p. 9.

Structure of the camera configuration view

LN ) MxManagementCentar

Configuration - mx10-0-38-9

Q

Notification & Transfer

Clips & Recordings & v
& 20190312-070910

A

Fig. 169: Structure of the camera configuration view
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Basic Settings

The Basic Settings @ contain basic configuration settings that are important for the setup of cameras and
camera system. The Basic Settings include the following areas:

B General Settings,

® Network,

® Time,

® |mage Settings,

®  MxActivitySensor and Recording.
The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 92.

< Basic Settings

General MNetwork Time Image & Exposure MxActivitySensor

Arming Enabled >
Frequency of Power Supply No artificial light 5
Disabled v

Fig. 170: Basic settings

Advanced Configuration

The available configuration parameters are thematically grouped in tiles @ . Clicking on a tile opens the topic
area and tabs for the associated sub-topics.
Some of the topics contain graphical configuration items, such as those for defining exposure windows or

detection areas. For more information on how to operate these configuration items see Graphical Operation,
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p. 340.

Extensive information on the setting options and parameters of the individual subject areas are currently
available only via the help pages of the camera. You can access the camera help table of contents directly
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).

® 5%

Overview Network Hardware

=] @) &

Q %

Recording Notification & Transfer VolP Telephony

O Ht

User & Groups Analytics

Fig. 171: Advanced Configuration
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@ [ ] MxManagementCenter [Beta]

Configuration - mx10-23-236-50

O R R R R N R RN R RN b= O R RN LR R e

Cameras B v

© mx10-23-236-50 Public Access Rights Admin Group User & Groups e
Ty MOVE-10.182.0.173 =

< Users & Groups

B mx10-0-38-8 mx10-23-236-50
Public

Configuration| Views MxMC & VMS Function:

" 8 8 B B B B B B ¥

@ mx10-23-236-50

% MOVE-10.192.0.173
o - Disable all

&. mx10-0-38-9

--------------------------------------------------------------------------------------------------------------------------------

Advanced Configuration - Users and Groups

Configuring Advanced Settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!

1. Click on the respective tab to open the corresponding topic area.

2. Make your settings as required by topic.

NOTE! Clicking on the relevant topic area in the table opens an information page for the individual

topic areas of the Advanced Configuration settings.
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@ [ ] MxManagementCenter

Configuration - mx10-23-236-50

pieriees PR e

s N v < Users & Groups

& mx10-23-236-50 Public Access Rights Admin Group Guest Image
% MO 182.0173 o

& mx10-0-38-9 mx10-23-238-50

Configuration Views 1 Functions

Clips & Recordings & v
& 20120312-070910

> v

O O

R o)

Fig. 172: Advanced Configuration - Users and Groups

Applying and saving changed settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!
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e0e MxManagementCenter

Konfiguration - mx10-12-225

Kamerakonfiguration

Grundeinstellungen

@ 5%

Obersicht Hardware

=] @) Ch

Scharfschaltung Aufzeichnung

Benachrichtigung &
Ubertragung

Hi

Analytics

Fig. 173: Applying and saving changed settings
You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-

meter values to factory settings, among other things:

Resetting To Factory Settings

Click on to reset all parameters for the current camera tab to the factory settings.

Undo/Redo Last Change

Click on to undo the last change. Click on to redo the change you previously undid.

Apply Changes

You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.

When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not

been implemented yet. Click . to make this change.

Saving Configurations

If parameter values are changed, the Store Configuration . icon turns red in the Command bar. Initially,

changes are always temporarily stored in the camera. To ensure that the current settings are also used after
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the next restart, the changes must be saved permanently.

1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on
Store.
2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last

permanently saved overall configuration.

Expert Settings

Various sections of the configuration provide additional settings that can be used to change parameters that

are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-

tings in the different sections. Click on to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration
Bar

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete

or move user or passwords you do not know!

You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to
check which parameter values are available for the other cameras in the group. There you can also change
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-
era group.

Checking parameter values of other cameras in the group

‘00 ® MxManagementCenter

Konfiguration - mx10-31-11-117 ?2CO

K=z, & Tinztel

Allgemein Netzwerk

mx10-10-49-30
v M

mx10-10-38-40

€ 21.21- s g m10-31-11-117
[ mao-ar-n-nz Gl Vom Master |5

& mx0-15-12-115 Netzfrequenz i3 mx10-21-21-191

kamersgruppen & v M 3 ioquere

» i Alle Kameras
» B Tirstationen

MxThinClient-Gerite v
3 MxThinClient

Clips & Aufzeichnung 3 v
» P9 Toreinfahrt

||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||
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Fig. 174: Checking parameter values of other cameras in the group

Example: Check arming for multiple cameras

1. Click on the relevant parameter name @ .
2. It turns yellow and the Configuration bar shows all values associated with this parameter that were

defined for cameras in this group @ .

Changing a value for one camera or for multiple cameras

LR ] MxManagementCenter

Konfiguration - mx10-31-11-117

0 Allgemein
mx10-10-49-30
mx10-22-1-170
mx10-11-30-19
& mx10-21-21-191 Sc altung
[ mao-ar-n-nz

& mx10-15-12-115

Netzfrequenz [&

Kameragruppen 3 v [} Audioquelle [ Deaktiviert L]

» i Alle Kameras

MxThinClient-Geriite b
&3 MxThinClient

Clips & Aufzeichnung 3 v

» P9 Toreinfahrt

|||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||

Fig. 175: Changing a value for one camera or for multiple cameras

Example: Change a value using the Configuration bar

1. Click the appropriate parameter name in the Configuration view @ . It turns yellow and the Configuration
bar shows all values associated with this parameter for this group @ . The cameras for which this value is
set are assigned to the individual values.

2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area
turns yellow.

3. If the same value is set for several cameras and you want to change this value, click on the parameter
selection field in the Configuration bar ® . Then select the desired value.
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Graphical Operation

Graphical window definition

In the configuration, graphical elements such as exposure windows and detection areas can now be easily

edited with the mouse. The processing of these graphic elements is subject to a uniform operating concept,

which is explained in the following table.

Action

Create expos-
ure/detection win-

dow

Move the exposure
window/detection
area

Change the expos-
ure win-

dow/detection area

Rotate the exposure
window/detection
area

Change the shape of
the exposure win-

dow/detection area

Delete expos-
ure/detection win-
dow

Exclude area from

Explanation

Draw a window using the mouse pointer.

Left-click on the exposure window / detection area and move it to the desired pos-
ition.

Move the mouse pointer over one of the white "handles" until the t icon is dis-

played. Left-click with the mouse and drag the window making it larger or smaller.

Click on ® and, while holding the mouse button down, rotate the green area clock-

wise or counterclockwise.

Switch to polygon mode by clicking on @ You will see white corner points on the

corners. Drag the corner points to the desired position. You can insert new corner
points by right-clicking on the white line or in the green area. Right-click on a dot to
delete a corner point. Then click on

Click on @

Pull open a window of the appropriate size at the position that should be excluded

analysis from the analysis. Click in the window and keep the mouse button depressed until
two icons appear. Click on to determine the exclusion window. The window turns
red.

NOTE!

The processing status of graphical window elements is indicated by a yellow or a green window color. If a
window is yellow, it cannot be edited. An example of this are predefined exposure windows. On the other

hand, green windows, such as custom exposure windows, can be graphically edited.
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Troubleshooting

This section provides approaches to solutions, e.g. in dealing with the Action Log.

Action Log

All user actions in MxMC are stored chronologically in the Action Log. It is saved as an encrypted XML stream

as “MxManagementCenter.xml“. The target directory can be set in the Preferences under Monitoring, p. 254 >

Action Log. It can be exported as CSV and PDF file. The following actions are logged in the Action Log.

Name

GoodbyelLogEntry

WelcomeLogEntry

LoginLogEntry

UserPasswordChangeEntry

LogoutLogEntry

SwitchPagelLogEntry

SwitchViewLogEntry

SwitchCameralLogEntry

SwitchGroupLogEntry

AutoLogoutEntry

SupervisorOnEntry

Id

GdBy

Helo

Lgin

Uspc

Lgot

Page

View

Came

Grou

AulLo

Svon

LogCategory Used in

elcSystem Application
elcSystem Application
elcAccess ProjectUser
elcAccess ProjectUser
elcAccess ProjectUser
elcViewing HomeWindow
elcViewing HomeWindow
elcViewing HomeWindow
elcViewing HomeWindow
elcAccess Application
elcAccess SecurityManager

Text

Leaving

MxManagementCenter.

Launching

MxManagementCenter

<TYPE> Login Successful for
<USER> (<USERROLE>).

Password for user <USER>
changed.

Logged out <USER>
(<USERROLE>).

Switching to view <VIEW>.

Switching to camera
<CAMERA>.

Switching to camera
<CAMERA>.

Switching to
group<GROUP>.

User logged out due to
<MINUTES> minutes

without activity.

Supervisor mode activated.
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Name id LogCategory Used in Text

SupervisorOffEntry Svof  elcAccess SecurityManager Supervisor mode deac-
tivated.

ExportRangeEntry ExRa elcExport ExportSettingCategory Recording on <CAMNAME>
will be exported from
<STARTDATE> to
<ENDDATE>.

AudioEntry Audi  elcAudio SceneStream <SOURCE> for <CAMNAME>
(<CAMURL>) was switched
to <STATUS>.

TriggerEntry Trig  elcSoftbutton Cam- <CAMNAME> (<CAMURL>):

eraActionController <TARGET> triggered.

SoftbuttonEntry Sotr  elcSoftbutton Cam- Softbutton <SOFTBUTTON_

eraActionController NAME> pressed.
<SOFTBUTTON_URL>)

InstantPlaybackEntry IPla  elcPlayback EventPlayerController Playback on camera
<CAMNAME> started at:
<TIMESTAMP>.

UserCreatedEntry Uscr  elcAccess ProjectUser <USER> (<USERROLE>) cre-
ated.

UserRemovedEntry Usre elcAccess ProjectUser <USER> (<USERROLE>)
deleted.

SingleAlarmConfirmation SCfm  elcAlarm EventTableView Camera alarm confirmed:
<CAMNAME>, <DATE>,
<ALARMTYPE>,
<COMMENT>.

AllAlarmsConfirmation ACfm elcAlarm EventTableView Camera alarms confirmed:
<CAMNAME>,
<STARTDATE>...<STOPDAT-
E>, <COMMENT>.

AlarmTypeConfirmation TCfm elcAlarm EventTableView Camera alarms confirmed:

<CAMNAME>,
<STARTDATE>...<STOPDAT-
E>, <ALARMTYPE>,
<COMMENT>.
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Name

ThinClientTrigger

ThinClientStop

LiveRecorderStarted

LiveRecorderStopped

LiveRecorderChanged

LicenseUpdateLogEntry

LicenseFileWroteLogEntry

LicenseFileReadLogEntry

FlashConfigLogEntry

DeviceDirtyLogEntry

SecureSystemCheck

SystemSecured

ActionLogContextSwitchEntry

ActionLogReadingFail

TCSw

TCSt

LRSa

LRSo

LRCh

LiUp

LiWr

LiRe

Flsh

Dirt

SeCh

SySe

AlLog

Aler

LogCategory

elcViewing

elcViewing

elcExport

elcExport

elcExport

elcAccess

elcAccess

elcAccess

elcSystem

elcSystem

elcSystem

elcSystem

elcGeneral

elcGeneral

Used in

Cam-

eraActionController

Cam-

eraActionController

LiveRecorder

LiveRecorder

LiveRecorder

LicenseHandler

LicenseHandler

LicenseHandler

ConfigViewWidget

KuratorViewWidget

SecureSystemManager

SecureSystemManager

ActionLog

ActionLog

Text

MxThinClient
<THINCLIENTNAME>: switch-
ing to camera
"<CAMNAME>".

MxThinClient
<THINCLIENTNAME>: resum-

ing normal operation.

Live recording for
<CAMNAME> started.

Live recording for
<CAMNAME> stopped.

Live recording switched to
<CAMNAME>.

Licenses have been updated

with License Server.
Capability Request file writ-
ten to disk.

Capability Response file
read from disk.

Configuration of
"<CAMNAME>" stored.

Configuration of
<CAMNAME> changed.

Performing security check
on device <CAMNAME>.

System secured for device
<CAMNAME>.

Switched logging from
<LOGNAME1> to
<LOGNAME2>.

File is corrupt or missing;

creating a new file.
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Troubleshooting

Action Log
Name [ LogCategory Used in Text
InvalidPasswordLogEntry Cred elcAccess StartupDialog Invalid password entered
for <USER> (<USERROLE>).
Super- Svpw elcAccess ProjectUser Password for supervisor
visorPasswordChangeEntry changed.
CameraPlaybackEntry CPla elcPlayback PlayerViewWidget Playback on camera
"<CAMNAME>" started.
GroupPlaybackEntry GPla elcPlayback PlayerViewWidget Playback on group
"<GROUPNAME>" started.
ActionLogReconnectEntry, ReCo elcSystem Application Action Log Backup Path
Reconnection. Path was not
available from
<STARTDATE> to
<ENDDATE>.
ActionLogDisconnectEntry Disc  elcSystem Application Action Log Backup path not
available since <DATE>.
IdentifyLogEntry WSID elcSystem Application Action Log created by work-
station = <MACHINENAME>.
ChangeALPathLogEntry Chan elcSystem PreferencesDialog Action Log path changed to
<NEW= PATH>.
PathNotFoundLogEntry PaNA elcActionLog ActionLogFileWriter Path <PATH> not found.
Could not write Action Logs.
DefaultPathUsedLogEntry PaNa elcActionLog ActionLogFileWriter Path <PATH> not found;
default path
<DEFAULTPATH> used.
AutomaticAlarmConfirmation ~ AtCm elcAlarm EventTableModel Camera alarm confirmed: "
<CAMNAME>, <TIMESTAMP>,
<TYPE>.
EmailAdapterMailSent MSen elcActionLog EmailAdapter Email has been sent to:
<ADDRESS>, Subject:
<SUBJECT>.
SnapshotLogEntry Snap elcSystem HomeViewWidget Snapshot saved.
SnapshotErrorLogEntry SErr  elcSystem HomeViewWidget Failed to save snapshot.
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Troubleshooting
Action Log

Name

SnapshotAutomaticLogEntry

ParseXMLLogEntry

ExportReasonEntry

ResearchViewReasonEntry

Saut

XmlP

ExCo

SwCo

LogCategory

elcSystem

elcError

elcExport

elcViewing

Used in

HomeViewWidget

LogEntry

ExportManager

HomeWindow

Text

Automatic snapshot gen-
eration (for non-event-

stream streams).

Error '%1' reading action
log '=%2"in line '%3',

column '%4'.
Comment for Export: %1

Comment for switch to

research view: %1
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